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Course introduction

This training guide introduces the basic features in QuickBooks, QuickBooks Pro, 
QuickBooks Premier and QuickBooks Premier Accountant, Intuit’s accounting systems 
for small businesses. We’ll talk about the types of information you need to track in 
your business and you’ll see how to enter that information and track it in QuickBooks. 
By the time you complete the course, you’ll have a good idea of all that QuickBooks 
offers, you’ll be familiar with the most common tasks through lots of hands-on 
practice, and you’ll know where to find out about more advanced features. 

The guide contains eighteen lessons. Lessons 1 to 13 cover features available in 
QuickBooks, QuickBooks Pro and QuickBooks Accountant. Lessons 14 to 18 cover 
features available only in QuickBooks Pro and QuickBooks Accountant.

Objectives

After completing the QuickBooks Training Guide, you should be able to:

� Create a new QuickBooks company.

� Modify the preset chart of accounts to suit your needs.

� Add to or edit information in company lists.

� Open and use registers for QuickBooks balance sheet accounts.

� Reconcile a QuickBooks bank account.

� Track credit card transactions.

� Invoice customers.

� Receive payments from customers and make bank deposits.

� Write QuickBooks cheques and assign amounts to specific expense accounts.

� Work with asset and liability accounts.

� Enter and pay bills in QuickBooks accounts payable.

� Create and customise QuickBooks reports and graphs.

� Export a QuickBooks report to Microsoft Excel.

� Set up stock, use units of measure and stock assemblies.

� Track and pay Value Added Tax.

� Set up and do payroll, including SSP, SMP and SPP.

� Customise a QuickBooks sales form.

� Write a letter in Microsoft Word using QuickBooks data.

� Create estimates, sales orders, purchase orders and progress invoices.

� Use multiple currencies.

� Do time tracking and pay non-employees for time worked.
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� Track vehicle mileage and invoice a customer for billable mileage.

Specific objectives for each lesson are shown at the beginning of the lesson.

About the lesson file

To complete each lesson in this guide, you’ll create a new lesson file from the master 
lesson file supplied with QuickBooks. 

Installing the lesson file

The lesson file is installed on your computer’s hard disk as follows:

To install the lesson file on your hard disk:
1 From the Windows Start menu, choose Run.

2 Type Explorer, and then click OK.

3 From Windows Explorer, select your hard drive (usually C:).

4 From the File menu, choose New, then choose Folder.

5 Type qbtrain and press Enter.

6 Open QuickBooks.

7 From the File menu, choose Restore.

QuickBooks displays the Restore Company Backup window.

8 In the “Get Company Backup From” section, click Browse and select the 
qblesson.qbb file in the folder 
C:\Program Files\Intuit\QuickBooks\Backup 
(this may differ if QuickBooks is installed in a different location), and then click 
Open.

9 In the “Restore Company Backup To” section, type qblesson.qbw in the Name 
field.

10 Click Browse and select your c:\qbtrain folder.

11 Click Restore.

If a window appears asking you if you want to update the company file to work 
with the current version of QuickBooks, type YES, then click OK. In the Update 
Company information box, click Yes. When QuickBooks has finished updating 
the file, click OK.

12 Click Restore.

13 Click OK in the information box when the restore finishes, to open the master 
lesson file.

14 From the File menu, choose Back Up.

15 Leave the filename as qblesson.qbb. Click Browse and select your c:\qbtrain 
folder, then click Save. 
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16 Click OK.

The master lesson file qblesson.qbb is now installed in the qbtrain directory on 
your hard drive.
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Using the lesson file

For lessons 1 to 18, you’ll restore a new copy of the lesson file qblesson.qbb from the 
qbtrain folder on your hard drive and use that file to complete the lesson. The 
qblesson.qbb file is a QuickBooks backup file, so you’ll be restoring a new file at the 
start of each lesson. Instructions on restoring the file are given at the start of each 
lesson. 

� If you want to repeat a lesson, first delete the lesson file created the first time, then 
follow the instructions to recreate it. (e.g., before repeating lesson 6, first delete the 
restored lesson file lesson6.qbw from the qbtrain folder, then restore a new
lesson 6.qbw).

� If you need to replace the original lesson file at any time, repeat the entire 
procedure “Installing the lesson file”.

� When you open the lesson file, the current date is set to 15 December 2007 (some 
screen illustrations may show a different date). This does not apply to your 
company file, which will use the current date. Because the data in the file contains 
transactions up to March 2003, there are places in the instructions where it is 
recommended that you use 31/03/2003 when entering transactions, and the 
month of March 2003 or the year 2002/3 for reports.

� The instructions and screen illustrations in this guide were created with 
QuickBooks in Windows 2000. Your screens (and some procedures) may differ if 
you are using a different version of QuickBooks or Windows. 

Now keep QuickBooks open and continue with lesson 1.



xii

I n t r o d u c t i o n



                                                                                                

1–1

• • • • • • • • • •

LESSON 1

1

Lesson objectives 1–2

To start this lesson 1–2

Introducing QuickBooks 1–2
Using forms 1–3

Using lists 1–3

Using registers 1–4

Getting around in QuickBooks 1–5
Finding information to help you get started 1–5

Managing your open windows 1–6

Using the menu bar 1–6

Using the Icon Bar 1–6

Using the Shortcut list 1–7

Making navigators your starting point 1–8

All the accounting you need to know 1–9
A business’s chart of accounts 1–9

About assets, liabilities, and equity 1–10

Assets 1–10
Liabilities 1–10
Equity 1–10

Cash versus accrual bookkeeping 1–11

Cash basis 1–11
Accrual basis 1–11
How your bookkeeping method affects QuickBooks 1–11

Measuring business profitability 1–12

The balance sheet 1–12
The profit and loss statement 1–12
The statement of cash flows 1–12

Exiting QuickBooks 1–13

Moving between company files 1–13

Getting started



1–2 

G e t t i n g  s t a r t e d

Lesson objectives
� To know how QuickBooks works and how you can get around in QuickBooks

� To introduce common business terms used by QuickBooks

� To learn how to exit QuickBooks

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 1.qbw in 
the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Introducing QuickBooks

Although most small business owners are worried about revenue, running a business 
involves many other tasks. Depending on the type of business, you need to invoice 
customers and record their payments, record and pay your bills from outside suppliers, 
manage stock, and analyse your business’s financial data to see where you need to 
focus your next efforts. QuickBooks is a tool you can use to automate the tasks you’re 
already performing as a business owner. When you’re working in QuickBooks, you’ll 
spend most of your time using a form, a list, or a register. Since these are so basic, we’re 
going to spend a few minutes introducing them.
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Using forms

You record most of your daily business transactions on a QuickBooks form, which 
looks just like a paper form. Here’s an example of the form you use when you want to 
record a bill from and write a cheque to one of your suppliers:

The form is intuitive—you already know how to fill in a form. But after you provide 
the information on a QuickBooks form, QuickBooks does the accounting for you in 
the background. For example, when you record a bill in the Enter Bills window, then 
write a cheque to pay for it in the Pay Bills window, QuickBooks enters transactions 
in your accounts payable register to show the expense you incurred and the payment 
you made (“accounts payable” tracks the money owed by your business to suppliers). 
It also records the cheque in your current account, keeping your records up to date, 
and providing a running balance of what you owe at any time.

Using lists

The list is another basic QuickBooks feature. You fill in most QuickBooks forms by 
selecting entries from a list.

QuickBooks has lists where you can store information about customers, suppliers, 
employees, items or services you sell, and so on. Lists save you time and help you enter 
information consistently and correctly.

When you’re filling in an invoice form, and you select a customer name from the 
Customer:Job list, QuickBooks not only fills in the name but also fills in the address, 
payment terms and VAT. 

Here’s an example of the Customer:Job list:
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QuickBooks lets you complete a variety of activities from lists, using the menu buttons 
located at the bottom of each list. For example, if you want to fill in an invoice for a 
customer, you can first select the customer from the Customer:Job list, and then 
choose Create Invoices from the Activities menu button.

Using registers

In addition to forms and lists, you’ll also work with registers in QuickBooks. Just as 
you use your paper chequebook register to see a record of all the transactions in your 
current account—cheques you’ve written, other withdrawals you’ve made from your 
account, and deposits—a QuickBooks register contains a record of all the activity in 
one account. Almost every QuickBooks account has its own register. 

Here’s an example of the register for an Accounts Receivable account:
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The register shows information about invoices written to customers—the date of the 
invoice, the date it’s due, the name of the customer, and the amount. It also shows 
payments you’ve received against your invoices. The right column of the register gives 
you a running balance of all your accounts receivable, so you always know how much 
you’re owed.

Getting around in QuickBooks

QuickBooks maximises your work space and gives you quick access to the features and 
reports that you use most. In this section you’ll learn how to do the following:

� Find information to help you get started using QuickBooks

� Manage your open windows

� Compare windows side by side

� Customise navigation features

Finding information to help you get started

If you’re new to QuickBooks, the Getting Started window displays when you open a 
company file. This window guides you through the steps you need to complete after 
you’ve set up your company file. To display the Getting Started window, choose 
Getting Started from the Help menu.

If you’re upgrading from a previous version, QuickBooks displays the New Features 
window. This window contains information about new features and explains how to 
find what you need to start working with the latest version. To display the New 
Features window, choose New Features from the Help menu.

As you are working, the Follow-Me Help automatically displays help about the 
window you are working with. For example, if you are currently using the 
Customer:Job list, the Follow-Me Help displays topics about the list and related 
subjects.
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Managing your open windows

To give you more room to work, QuickBooks displays one window at a time. When 
you open a window, it appears in front of other windows that you previously opened.

The Open Window list keeps track of the windows you are using. Use the Open 
Window list to switch between windows while you work. To switch to another open 
window, just click the title of the window that you want to display.

To show or hide the Open Window list:
� From the View menu, choose Open Window List.

If the list is currently displayed, a tick appears to the left of the menu item.

You may wish to display more than one window at a time. You can easily switch 
between viewing one window and viewing multiple windows. When you choose 
Multiple Windows, QuickBooks tiles the windows in the main area. You can then 
move and resize the windows as needed.

To view multiple windows:
� From the View menu, choose Multiple Windows.

Using the menu bar

You can find all of the QuickBooks commands in the menus on the menu bar.

Many commands available from the menu bar can be added to the Icon Bar. 

Using the Icon Bar

Another feature that makes it easy to get around in QuickBooks is the Icon Bar. It 
comes preset with shortcuts to several windows, such as Create Invoices and Enter 
Bills. You can add other features and reports you use often.

In addition to deciding which features to add to the Icon Bar, you can add or remove 
icons, change the order in which the icons display, insert spaces between icons, and 
edit icons by changing the icon text, graphic, or tooltip. 

For instructions on how to customise the Icon Bar, refer to the onscreen Help.
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Using the Shortcut list

The QuickBooks Shortcut list groups together related lists and forms in an 
easy-to-follow format that helps you work more efficiently. The Shortcut list displays 
vertically and is an alternative to the Icon Bar:

QuickBooks is preset to display the Icon Bar, but you can display the Shortcut list 
instead of, or in addition to, the Icon Bar. 

To show or hide the Shortcut list:
� From the View menu, choose Shortcut List.

Like the Icon Bar, the Shortcut list can be customised, so you can add the forms, lists, 
and registers that you use frequently, rename shortcuts or remove those that you don’t 
use.

For instructions on how to customise the Shortcut list, refer to the onscreen Help.
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Making navigators your starting point

QuickBooks navigators provide a graphical representation of the workflow for a 
particular area. For example, the Customers Navigator window has icons for 
important activities involved in working with customers and making sales (such as 
creating invoices, receiving payments, and making deposits). It looks like this:

The navigators let you access features, reports, and solutions for the major areas of 
QuickBooks.

� Flow charts guide you in performing tasks in the correct order.

� Related Activities and Memorised Reports let you analyse your data 
and take action.

� Customer Solutions help you find features and services that you can use to 
manage your business.

To display a navigator, select its name from the Navigators list:
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All the accounting you need to know

QuickBooks doesn’t require you to learn or understand accounting jargon. However, 
it does use some common business terms.

A business’s chart of accounts

When you keep books for a company, you want to track where your income comes 
from, where you put it, what your expenses are for, and what you use to pay them. 
You track this flow of money through a list of accounts called the chart of accounts.

You can display the QuickBooks chart of accounts by choosing it from the Company 
menu or by clicking Chart of Accounts on the navigation bar. We’ll use the Company 
menu.

To display the chart of accounts:
1 From the Lists menu, choose Chart of Accounts.

The chart of accounts for Grangeworth Kitchens Ltd. is displayed:

2 Scroll through the Grangeworth Kitchens chart of accounts. Notice that the list 
displays balance sheet accounts first, followed by income accounts and expense 
accounts.
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About assets, liabilities, and equity

Assets

Assets include both what you have and what other people owe you. The money people 
owe you is called your accounts receivable, or A/R for short. QuickBooks uses an 
accounts receivable account to track the money owed you. The rest of your company’s 
assets may include current accounts, savings accounts, petty cash, fixed assets (such as 
equipment or trucks), stock, and undeposited funds (money you’ve received from 
customers but haven’t yet deposited in the bank).

When setting up your company file in QuickBooks, please note that even though 
current, savings, and petty cash accounts are all company assets, you’ll set them up as 
“bank” type accounts in QuickBooks.

Liabilities

Liabilities are what your company owes to other people. The money you owe for 
unpaid bills is your accounts payable, or A/P for short. QuickBooks uses an accounts 
payable account to track the money you owe different people for bills. A liability can 
be a formal loan, an unpaid bill, or taxes you owe to the government.

When setting up your company file in QuickBooks, note that even though unpaid 
bills are liabilities, you’ll set them up as “accounts payable” type accounts.

Equity

Equity is the difference between what you have (your assets) and what you owe (your 
liabilities):

Equity = Assets – Liabilities

If you sold all your assets today, and you paid off your liabilities using the money 
received from the sale of your assets, the money you’d have left would be your equity. 
Your equity reflects the health of your business, since it is the amount of money left 
after you satisfy all your debts. Equity comes from three sources:

� Money invested in the company by its owners

� Net profit from operating the business during the current accounting period

� Retained earnings – net profits from earlier periods that haven’t been distributed 
to the owners

Of course, you as the owner can also take money out of the business. Such 
withdrawals, called owner’s drawings, reduce the business equity. 

If you have a sole proprietorship (where the existence of the business depends solely 
on your efforts), you can check the value of your owner’s equity by creating a 
QuickBooks balance sheet.
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Cash versus accrual bookkeeping

When you begin your business, you should decide which bookkeeping method to use. 
The bookkeeping method determines how you report income and expenses on your 
tax forms. Check with your tax advisor or the Inland Revenue before choosing a 
bookkeeping method for tax purposes.

Important: When you create reports in QuickBooks, you can switch between cash
and accrual reports at any time, regardless of which bookkeeping
method you have chosen for tax purposes.

Cash basis

Many small businesses record income when they receive the money and expenses 
when they pay the bills. This method is known as bookkeeping on a cash basis. If 
you’ve been recording deposits of your customers’ payments but have not been 
including the money customers owe you as part of your income, you’ve been using 
cash basis. Similarly, if you’ve been tracking expenses at the time you pay them, rather 
than at the time you first receive the bills, you’ve been using cash basis.

Accrual basis

In accrual-basis bookkeeping, you record income at the time of the sale, not at the 
time you receive the payment. Similarly, you enter expenses when you receive the bill, 
not when you pay it.

Most accountants feel that the accrual method gives you a truer picture of your 
business’s finances.

How your bookkeeping method affects QuickBooks

Whether you use the cash or accrual method, you enter transactions the same way in 
QuickBooks.

QuickBooks is set up to do your reports on an accrual basis. For example, it shows 
income on a profit and loss statement for invoices as soon as you record them, even 
if you haven’t yet received payment. It shows expenses as soon as you record bills, 
even if they are unpaid.

You can see any report (except transaction reports) on a cash basis by changing the 
reporting preference. (From the Edit menu, Choose Preferences. In the Preferences 
window, click Reports & Graphs, and then click the Company Preferences tab.)
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Measuring business profitability

Two of the most important reports for measuring the profitability of your business are 
the balance sheet and the profit and loss statement (also called an income statement). 
These are the reports most often requested by accountants and financial advisors. (For 
example, banks request both documents when you apply for a loan.)

The balance sheet

A balance sheet is a financial snapshot of your company on one date. It shows:

� What you have (assets).

� What people owe you (accounts receivable).

� What your business owes to other people (liabilities and accounts payable).

� The net worth of your business (equity).

To see an example of a balance sheet:
1 From the Reports menu, choose Company & Financial.

2 From the submenu, choose Balance Sheet Standard.

The profit and loss statement

A profit and loss statement, also called an income statement, shows your income, 
expenses, and net profit or loss (equal to income minus expenses). The QuickBooks 
profit and loss statement summarises the revenue and expenses of your business by 
category (first income, then expenses).

To see a profit and loss report:
1 From the Reports menu, choose Report Finder.

2 From the Select a type of report drop-down list, choose Company & Financial.

3 In the Select a report list, click Profit & Loss Standard.

4 Click Display.

5 Scroll the report window as needed to see all parts of the report.

The statement of cash flows

Another report that your accountant may be interested in is the statement of cash 
flows report. A statement of cash flows shows your receipts and payments during a 
specific accounting period.

To see a sample statement of cash flows report:
� From the Reports menu, choose choose Company & Financial, then Statement of 

Cash Flows.



                                                                                                

1–13

L E S S O N  1

Exiting QuickBooks

Unlike most other Windows programs, QuickBooks does not require you to save your 
data before exiting. It does an automatic save while you’re working with QuickBooks 
and every time you leave the program.

To exit QuickBooks:
� From the File menu, choose Exit.

If no other applications are open, QuickBooks returns you to the Windows desktop.

To prevent or minimise data loss, you should make regular backup copies of your 
QuickBooks company data. In the event of a data loss you can restore your data from 
the backup copy. To make a backup copy, from the File menu, choose Back Up.

For more information about the recommended backup routine, see the QuickBooks 
User Guide.

Moving between company files

If you work with several companies, you’ll be working with multiple QuickBooks 
company files. You can change from one company file to another at any time, but you 
can have only file open at a time.

QuickBooks provides an easy way to find and open a company file that you’ve worked 
with before.

To open a previously opened file:
1 From the File menu, choose Open Previous Company.

2 From the submenu, choose the company file you want to open.

You can increase the number of company files that QuickBooks will display in the 
submenu.

To increase the number of company files displayed:
1 From the File menu, choose Open Previous Company.

2 Choose “Set number of previous companies.”

3 Enter the number of company files you want QuickBooks to display (up to 20).

4 Click OK.

Note: Leave the lesson file open in QuickBooks and proceed to lesson 2.
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Lesson objectives
� To discuss some of the decisions you need to make before using QuickBooks, such 

as your QuickBooks start date and the number of QuickBooks companies you 
should create

� To create a new QuickBooks company using the EasyStep Interview

� To set up QuickBooks preferences in the Interview

� To set up opening balances for a current account

� To practice using the QuickBooks Help tools

Creating a QuickBooks company

A QuickBooks company contains all the financial records for a single business. Before 
you can use QuickBooks, you need to tell QuickBooks about your company so that it 
can set up your company file.

Quicken or If you’ve been using Quicken or an older version of QuickBooks to keep 
your company’s financial records, you don’t need to create a new company; 
QuickBooks can convert your data for you. However, in this lesson, you’ll see how to 
create a new QuickBooks company.

How many companies should you set up?

If you operate a business, the Inland Revenue expects you to clearly show all sources 
of income and to document any business expenses you claim as deductions. If you 
operate more than one business, therefore, it’s usually best to set up a separate 
QuickBooks company for each.

About the EasyStep Interview

The EasyStep Interview walks you through the process of setting up your entire 
business on QuickBooks. The Interview is broken down into sections. You must 
complete the required General section first. If you are not sure how to answer a 
question, you can always go back and change your answer later. A few questions ask 
you to make a decision that’s not easily reversed. When this is the case, you’ll see this 
symbol on the screen:
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The EasyStep Interview has six sections:

� General—Lets you enter company information, choose a chart of accounts appro-
priate for your business, decide on QuickBooks preferences, and specify a business 
start date.

� Income & Expenses—Lets you review the income and expense accounts on your 
business’s chart of accounts, and lets you enter new accounts.

� Income Details—Lets you specify whether your business income is from services 
and/or products you sell. Based on the information provided, QuickBooks deter-
mines which income and accounts receivable features you will be using.

� Opening Balances—Lets you enter information about the customers who owe 
you money as of your start date, suppliers to whom you owe money as of your start 
date, and balances in your balance sheet accounts as of your start date.

� Payroll—Lets you enter basic payroll information, specify pay frequency, create 
payroll items, enter information about employees and record year-to-date payroll 
amounts.

� What’s Next—This section describes some common tasks in QuickBooks that you 
may want to complete after you’ve gone through the other sections of the 
Interview.

Each section of the Interview is divided into topics that are displayed as tabs at the top 
of the EasyStep Interview window. After you complete a topic or section, QuickBooks 
displays a tick mark on that tab.

Navigating through the Interview
� Click Next to display the next window in the Interview.

� Click Prev to display the previous window in the Interview.

� When a window has a More button (in the lower right corner), click it to see more 
detailed information about the question being asked in the Interview. After you 
read the detailed information, you can click OK to return to the Interview.

� Click Leave to leave the Interview and return to QuickBooks. You can return to the 
Interview later by opening your company file and then choosing EasyStep 
Interview from the File menu. QuickBooks remembers the information you have 
already entered.
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Starting the EasyStep Interview

To begin adding a new company:
1 Start QuickBooks.

If this is the first time you have started QuickBooks, or if you have closed an 
existing company, you’ll see this dialog box:

2 Select “Create a new company” and click OK.

3 If you don’t see this dialog box, choose New Company from the File menu.

QuickBooks displays the EasyStep Interview screen.

Entering company information

When you use the EasyStep Interview to create a new QuickBooks company, 
QuickBooks asks you questions about the type of business you own and uses your 
answers to set up the appropriate accounts and lists. In this lesson, you’ll create a new 
QuickBooks company for a business named Lockhart Design. Margaret Lockhart is the 
sole proprietor of this interior design firm. Most of her income comes from consulting 
services, but she also sells products such as fabrics and room accessories to clients.
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To create a new QuickBooks company file:
1 On the EasyStep Interview Welcome page, click Next to begin.

Since you are creating a new QuickBooks company in this lesson—not upgrading 
from a previous version—click Next to continue the Interview.

2 Keep clicking Next, reading the information presented on the Welcome pages, 
until you have completed that section.

When you finish the section, QuickBooks places a tick mark on the Welcome tab 
and displays the Company tab.

3 Click Next to display the Your Company Name page.

4 In the Company Name field, type Lockhart Design and press Tab. 

When you press Tab, QuickBooks automatically enters the same name you typed 
into the Legal Name field. QuickBooks uses the company name on all reports.

5 Click Next.

6 On the Your Company Information page, type in the relevant fields:

9 Park Avenue
Pinner
TW6 2KK
and select UK. QuickBooks prints this company address on cheques, invoices and 
other forms.

7 Click Next.

8 On the Other company information page, make sure that January is selected for 
the first month of the financial year. Then click Next.

QuickBooks uses the financial year you choose to create year-to-date reports.

9 In the Your company income tax form page, select Self-Assessment Tax Return 
from the drop-down list.

10 Click Next to display the next page, where you can choose a chart of accounts for 
your business.
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Using a preset chart of accounts

As you learned in Lesson 1, the chart of accounts lists balance sheet accounts, income 
accounts, and expense accounts. When you create a new QuickBooks company, you 
can select a company type that most closely matches your type of business, and 
QuickBooks sets up a chart of accounts for you. It also sets up other lists that are 
appropriate for your type of company, such as payment methods, customer and 
supplier types, and payment terms.

The next screen in the Interview displays a list of industries. Even if you own a type of 
company that isn’t specifically listed, you should select the one that’s closest and get 
a head start on creating your own chart of accounts. Once QuickBooks creates a chart 
of accounts for you, you can modify it as you wish.

To create a chart of accounts:
1 On the Select Your Type of Business page, scroll down the Industry list, and select 

Product Sales/Retail.

Although Lockhart Design receives most of its income from consulting, not from 
retail sales, this company type will give us most of the accounts we need. We’ll 
need to modify the chart of accounts later to include an income account for 
Consulting Income.

2 Click Next three more times.

3 On the Save As page, click Save to accept the default filename of “Lockhart Design” 
(be sure to save the file in the Qbtrain folder you set up earlier).

QuickBooks creates the company file and then displays a list of the income and 
expense accounts available in the preset chart of accounts for retail businesses:

4 Scroll through the preset income and expense accounts to get an idea of what is 
included, and then select Yes (that you want to use these accounts). 

5 Click Next to go to the next page.
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6 On the Accessing your company page, leave the number of people who need to 
have access to the QuickBooks files at 0 and click Next.

Margaret Lockhart is the only one who needs access to the company file.

7 Click Next, and type admin as the password. (If you were setting up your own 
company file, you should choose a more obscure password for security reasons.)

8 Click Next until you move from the Company section to the Preferences section.

Setting up QuickBooks preferences

The Preferences section of the EasyStep Interview is where you indicate which 
QuickBooks features you want to use:

� Stock

� Multicurrency (QuickBooks Pro/Accountant only)

� Invoice format

� Payroll 

� Estimates (QuickBooks Pro/Accountant only)

� Progress invoicing (QuickBooks Pro/Accountant only)

� Time tracking (QuickBooks Pro/Accountant only)

� Classes

� Bill entry mode (by entering cheques directly or bills first and then payments)

� Reminders

Enabling Stock

The first page in the Preferences section asks whether you keep stock. Margaret 
Lockhart typically keeps stock, so we’ll turn on stock in her company file.

Turning on Stock from the EasyStep Interview is not available for all industries. When 
this is the case for the industry you selected, you can turn it on from the Preferences 
screen. (From the Edit menu, choose Preferences. Click Purchases & Suppliers, then 
click the Company Preferences tab, and then click the “Stock and purchase orders are 
active” tick box.)

To set up QuickBooks to track stock:
1 On the second Preferences page, click Yes to the question, “Does your company 

maintain stock?” Then click Next.

2 Click Yes to enable the QuickBooks Stock feature.

3 Click Next to move to Enabling Stock page.

4 Select Yes for the question, “Do you want to use the Stock feature?”.

5 Click Next to move to Enable Units of Measure page. (Pro/Accountant only)
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6 Since Margaret Lockhart will resell stock items in different units of measure, select 
Yes to the question, “Do you want to enable units of measure?”.

7 Click Next to move to the next page.

Enabling Multicurrency (Pro/Accountant only)

If you do business in currencies other than sterling, you can enable the QuickBooks 
Multicurrency facility. This lets you set up all the bank, credit card, receivables and 
payables accounts needed for transactions with foreign customers and suppliers. 
QuickBooks integrates multicurrency dealings with the rest of your accounts, tracking 
foreign-exchange gains and losses.

Note: The Multicurrency page appears only if you are using QuickBooks Pro or 
Accountant. Once you turn on Multicurrency, it cannot be turned off again 
and you cannot return to this part of the EasyStep Interview.

Since Margaret plans to purchase stock from France, we’ll enable multicurrency.

To enable Multicurrency:
1 On the Enabling Multicurrency page, click Yes to the question, “Do you want to 

enable Multicurrency?”.

2 Click Next to move to the next page.

3 Ensure United Kingdom Pound is the selected Home Currency.

4 Click Next to move to the next page.

Choosing an invoice format

QuickBooks offers four different formats for invoices: Product, Professional, Service, 
and Custom. The type you choose affects the look of your invoices.

� Product is for businesses that sell parts or products and need fields relevant for 
shipping (for example, a retail store).

� Professional is for businesses that sell services and need a lot of room for descrip-
tions of their services (for example, a public relations consultant).

� Service is for businesses that primarily provide services, but that also sell some 
goods (for example, an interior design firm).

� Custom is for businesses that want to create their own invoice format.

You can customise any of these formats to suit your needs. You’ll see how to do this 
in Lesson 13 of this guide. For Lockhart Design, which primarily sells consulting 
services, but also sells the occasional product, we’ll choose the Service invoice format.

To select the invoice format for Lockhart Design:
1 In the Your invoice format screen, select Service.

2 Click Next to continue.
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Choosing remaining preferences

The rest of the Preferences section is a series of simple questions. Select the desired 
option, then click Next to continue. For Lockhart Design, complete as follows:

This completes the Preferences portion of the EasyStep Interview. 

Entering VAT information

In this section of the Interview, you enter the information QuickBooks uses to track 
Value Added Tax. If you are registered for VAT, you should enter Yes on the first page 
and complete this section. If you enter No, you will skip this section. For Lockhart 
Design, we’ll turn on VAT tracking with the standard options.

To turn on VAT tracking:
1 On the first Value Added Tax page, click Next.

2 On the VAT page, click Yes, then click Next.

3 On the General VAT Information page, click Next again.

For this item... Do this...

Employees Type 1

Payroll Click Yes.

Estimates (Pro/Accountant only) Click No.

Progress invoicing (Pro/Accountant only) Click No.

Time tracking (Pro/Accountant only) Click No.

Reimbursable expenses Click No.

Classifying transactions Click Yes.

Bills and payments Select “Enter the bills first and then 
enter the payments later”

Reminders list Select “At start up”
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4 Fill in the VAT Information page as shown below:

5 Click Next.

6 On the VAT reporting basis page, accept Accrual basis, and click Next.

7 On the Entering your sales figures page, accept Net, and click Next.

8 Click Next to complete the VAT section of the Interview.

If you report VAT on a cash basis, or prefer to enter your sales figures gross rather than 
net, you can change the defaults on these pages.

Choosing a start date

Before you start entering your company’s financial data, you need to choose a 
QuickBooks start date. This is the starting point you want to use for all your 
QuickBooks accounts, the date for which you give QuickBooks a financial snapshot of 
your company assets and liabilities.

Once you decide on a start date, you enter all your company’s transactions since that 
date. That’s why you should choose a start date that’s not too far back in the past. 
Many business owners like to use the last day of a financial period as their start date, 
such as the end of last financial year, last quarter, or last month. You need to enter all 
historical transactions from the day after your start date up to today. For example, if 
you decided on a start date of 31 December, you would enter your historical 
transactions from 1 January until today.

To set the company start date:
1 Continue clicking Next to move through the Start Date section of the Interview. 

2 When you get to the Choose your QuickBooks start date page, select “I want to 
start entering detailed transactions as of” and enter 1/1/2005.

3 Click Next twice more to complete this section.
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Setting up income and expense accounts

Because you chose an industry from the list earlier in the Interview, QuickBooks has 
already created income and expense accounts for your company. The Income & 
Expenses section of the EasyStep Interview lets you view the preset income and 
expense accounts and add new income or expense accounts from within the 
Interview.

To streamline the Interview process, you won’t add income or expense accounts in 
this lesson. You’ll see how to add new accounts to the chart of accounts in Lesson 3, 
"Working with lists."

For now, move through this portion of the Interview by clicking No to these 
questions:

� “Do you want to add an income account now?”

� “Would you like a more detailed explanation of expense accounts and 
subaccounts?”

� “Do you want to add an expense account now?”

Providing details about your income

The Income Details section of the EasyStep Interview is where you specify whether you 
track accounts receivable, set up QuickBooks items to track the services you provide or 
products you sell, and set up stock items if you plan to track stock in QuickBooks.

You should complete the Introduction tab of the Income Details section because that 
tells QuickBooks whether you need the accounts receivable feature and whether you 
need statement charges (for businesses that send regular monthly statements showing 
past due, current balance, and so on).

To complete the Income Details section:
1 In the Income Details Introduction page, click Next.

2 For the question, “Do you receive full payment at the time (or before) you provide 
a service or sell a product?” select Sometimes, and then click Next until you reach 
the Service Items page.

3 In the Items section, click No on the next three pages when asked if you want to 
set up service items, non-stock part items, or other charge items.

You’ll see how to set up a new service item in Lesson 6, "Entering sales and 
invoices."

4 Click Next until you reach the Adding a Stock Item page.

5 Click No, then Next, to complete the Stock page.
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Entering opening balances

The Opening Balances section of the EasyStep Interview is where you enter the 
amounts currently owed you by customers and owed to suppliers, as well as the 
balances in your balance sheet accounts, as of your start date. We recommend that you 
provide the opening balances from within the Interview; this makes it easier when 
you’re ready to use QuickBooks for your daily business transactions.

The balance sheet accounts in the QuickBooks chart of accounts start with an opening 
balance of zero. Before you begin working in QuickBooks, you need to enter an 
opening balance for each balance sheet account as of your start date.

The opening balance is important because QuickBooks can’t give you an accurate 
balance sheet (what your company owns and what it owes) without it. An accurate 
balance sheet gives you a true picture of your company’s finances. Also, if you start 
with an accurate balance as of a specific date, you can reconcile your QuickBooks bank 
accounts with your bank statements, and your QuickBooks bank accounts will show 
the actual amount of money you have in the bank.

The easiest way to determine an account’s opening balance is to work from an accurate 
balance sheet. If you have a balance sheet as of your start date, you can take the 
opening balance from there.

Let’s assume Margaret Lockhart wants to enter an opening balance for her current 
account. The opening balance for a QuickBooks bank account is the amount you have 
in the bank on your start date. You can use either the ending balance on the last bank 
statement on or just before your start date or the bank account balance from a balance 
sheet prepared by your accountant. Margaret has a recent bank statement for this 
account, so she’ll use that method.

To enter the current account opening balance:
1 Click the Accounts tab in the Opening Balances section and click Next.

2 Click No, then Next, when QuickBooks asks if you want to set up a credit card 
account, and again for a loan account.

3 For “Would you like to set up a bank account?”, click Yes. Then click Next.

4 Type Current as the name of the account and then click Next. If you see a message 
about preprinted cheques, click No.

5 For Statement Ending Date, enter Lockhart Design’s start date.

6 In the Statement Ending Balance field, type 8359.00 and then click Next.

7 When QuickBooks shows you the bank account you have set up and asks if you 
want to add another bank account, click No, then click Next.

The rest of the Opening Balances section lets you add asset and equity accounts. In the 
interest of time, we won’t be adding any other accounts from within the Interview.
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Setting up payroll

If you plan to use QuickBooks for payroll, the Payroll section of the EasyStep Interview 
is where you specify the frequency of your pay periods, payroll items you want to 
create, information about employees, and year-to-date payroll amounts. (An annual 
subscription is required to use the Payroll functions.)

Providing basic payroll information

The Introduction pages are where you specify Tax District, how often you pay your 
employees and what method you use. Suppose Margaret Lockhart has a student she 
wants to hire part-time to help in the shop. She wants to use QuickBooks to create 
payroll cheques.

To enter payment frequency and method:
1 From the first Payroll page, click Next until you see the Tax District page. Leave 

these fields blank.

2 Click Next to display the Pay Frequency page.

3 Select Weekly for the principal pay frequency.

4 Click Next.

5 Select Cheque for the principal payment method.

6 Click Next.

This completes the Introduction section of the Payroll tab. The next step is to set up 
your company’s payroll items. Click Next to move to the Payroll Items section.

Creating payroll items

QuickBooks uses payroll items to track everything that affects the amount on a payroll 
payment, and for every company expense related to payroll. QuickBooks adds some 
of the items for you automatically (it stores them on the Payroll Items list), and you 
add others as you need them. 

To create payroll items:
1 Click the Payroll Items tab, and then click Next until you see the Remuneration 

page.

2 Select “Employees can be paid hourly.” Then click Next. 

3 Click Next on the remaining Payroll Items pages without making any entries. 

The remaining pages in the Payroll Items section do not apply to Lockhart Design 
(they let you specify further additions and deductions on payroll payments). When 
you see the Payroll Item Setup Completed page, you are finished with the section. 
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Setting up employee payroll information

Margaret Lockhart has one employee she wants to hire on a part-time basis. She has 
not issued any payroll payments for this person yet, so in the EasyStep Interview, she 
simply needs to add the employee data. She does not need to add any year-to-date 
payroll information.

To add employee data
1 Click the Employees tab, and click Next

2 In the Sick Time page, click No, and then click Next.

3 In the Holiday Time page, click No, and then click Next.

4 Click Next until you see the Adding an Employee page.

5 Click Add Employee. 

QuickBooks displays the New Employee window. Because Margaret Lockhart already 
knows the person she wants to hire, she should enter the information for him while 
in the EasyStep Interview.

To enter a new employee
1 On the the Address Info tab of the New Employee screen, make sure Personal Info 

is selected, and fill in the employee information as shown below:
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2 Change tabs by selecting Payroll and Compensation Info, and fill in the Payroll 
Info form as shown below:

3 Click the Tax/NI Details button, then enter the tax code 438L and NI code A, both 
effective from 05/04/2003.

4 Click OK, then click OK at the message that you have changed the Income Tax and 
NI setup.

5 Click OK on the Payroll Info form.

6 When QuickBooks asks whether you want to set up other payroll information, 
click the Leave As Is button. 

7 Click Next to finish. 

You don’t need to do the YTD Amts tab of the Payroll section because Margaret 
Lockhart has not yet done payroll for her company.
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Finishing the Interview

The final section in the EasyStep Interview is What’s Next. We will not cover it in this 
lesson, but we recommend that you read through the What’s Next pages when you set 
up your own company for advice on how to proceed. 

To leave the EasyStep Interview:
� Click Leave. QuickBooks saves your changes and opens your new company file.

Completing the company setup process

When you are setting up your own company in QuickBooks, you may want to use the 
Getting Started screen to help you finish setting up your own company file. The 
information provided there will guide you through the rest of the setup process and 
help you get started using QuickBooks.

To display the Getting Started screen:
� From the Help menu, choose Getting Started.

After you have completed the EasyStep Interview, Intuit recommends that you not use 
the Interview to make changes to your company file. Instead, use the information on 
the Getting Started screen and the help options described in the next section to help 
you make adjustments. If you have upgraded from an earlier version of QuickBooks, 
choose What’s New from the Getting Started screen, or see the New features section 
in the Introduction chapter.

Getting help while using QuickBooks

When you have questions, QuickBooks provides extensive help in various formats:

� Follow-Me Help, which is displayed automatically and provides information 
relevant to where you are in the program.

� Step-by-step instructions, available from the Help and How Do I? menus and the 
Ask fields.

� Explanations of how to apply QuickBooks to your business, available from the 
Help menu.

Finding a topic in the onscreen Help Index

Suppose you want to find out how to add a customer. You can type what you’re 
looking for in the Help index, and QuickBooks displays a list of topics.
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To find a topic in onscreen Help using the index:
1 Cick the Index button in the Follow-Me-Help panel 

Alternatively, from the Help menu, choose Help Index.

The Find panel displays the index.

2 In the Find panel, type customers.

QuickBooks displays topics indexed by the keyword “customers”. You can see 
there is a topic for “adding new”:

3 Click “adding new”.

QuickBooks displays the topic in the lower Follow-Me Help pane:

At the end of Step 1 of the Help topic, this button appears:

This means that you can click on the button to launch the function or screen 
described (in this case, the Customer:Job list).

Notice the Back button , which you can use to return to the previous topic.
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Finding answers from the How Do I? menu

Many windows throughout QuickBooks have a drop-down How Do I? menu. 

This menu provides quick access to information and instructions for the current 
window.

To use the How Do I? menu:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window.

Notice that the Follow-Me Help has changed to display a list of topics relating to 
invoices. You could select the topic from here, but for this exercise you will use the 
How Do I? menu.

2 From the How Do I menu, choose “Reformat and print invoices.” Then choose 
“Add my logo.”

The Follow-Me Help panel displays a Help topic on how to add a company logo to 
an invoice:

3 Close the invoice.
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Using the Ask fields

You can look for help in QuickBooks using the Search option in the Find panel:

If this option is not displayed, click the Search button in the Follow-Me-Help panel:

You will also find an Ask field alongside the How Do I? menu in the title bar on many 
windows:

To ask a help question:
1 Highlight the words “Ask a help question” in the Ask field, or click in the box 

below Search in the Find panel.

2 Type How do I add a customer?

3 Click Ask.

The QuickBooks Find panel displays search results.
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4 Click on the topic “Adding customer”.

The topic is displayed in the Follow-Me Help pane:

Note that this is the same topic as we retrieved from the Help index above.

Tip: You can print any Help topic by clicking the Printer icon: 

Finding further information

If you need further information, you can search QuickBooks’ eXceed Support online 
knowledge base. This also contains new or late-breaking information.

To do this, you need to be connected to the Internet.

To find information online:
1 In the Find panel, click Look Online.

2 In the box, type customise invoices.

3 Click Search.

A browser window opens, with a list and summary of search results.

4 Select the topics that interest you.
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Lesson objectives
� To edit the company chart of accounts

� To add a new customer to the Customer:Job list

� To add a new employee to the Employee list

� To add a new supplier to the Supplier list

� To learn about custom fields, and to practice adding custom fields

� To see how to manage lists in QuickBooks

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section, click Browse and select your 
c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section, type lesson 3.qbw in the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Using QuickBooks lists

QuickBooks lists organise a wide variety of information, including data on customers, 
suppliers, stock items, and more. Lists save you time by helping you enter information 
consistently and correctly. When you store information on a list, you enter it once and 
never need to retype it. Think about how many names, addresses and other 
information you use more than once in your business:

� Customers who purchase from you on a regular basis

� Suppliers from whom you purchase your supplies

� Products or services you sell again and again
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Simply enter repetitive information into a list once, and then use it over and over on 
cheques, on invoice forms, and in other daily transactions. You don’t have to enter all 
the information for your company lists before you begin working with QuickBooks. 
You can add information to lists as you go along.

Editing the chart of accounts

The chart of accounts is your most important list, because it shows how much your 
business has, how much it owes, how much money you have coming in, and how 
much you’re spending. When you set up your own company in QuickBooks, the 
EasyStep Interview lets you choose a chart of accounts designed especially for your 
type of business. However, not every business has the same needs; you’ll want to make 
a few changes to the list.

To display the chart of accounts:
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts for Grangeworth Kitchens:

2 Scroll through the list. The chart of accounts displays balance sheet accounts first, 
followed by income and expense accounts.
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Editing an account

If any of the accounts don’t suit your needs, you can edit them. In this exercise, you’ll 
edit Grangeworth Kitchens’s Master Savings Account to provide the account number.

To edit an account:
1 In the chart of accounts, select Master Bank Savings.

2 Click the Account menu button (at the bottom of the window) and select Edit.

QuickBooks displays the Edit Account window.

3 In the Description field, type Master Bank High Interest.

4 In the Bank Acct. field, type 5533-2222.

Your screen should look like this:

5 Click OK.

Adding subaccounts

The Telephone expense account has two subaccounts called Fax and Mobile. 
Grangeworth Kitchens wants to add a third subaccount called Phone.

To add a subaccount:
1 In the chart of accounts, click the Account menu button and then choose New.

QuickBooks displays the New Account window.

2 In the Type field, select Expense from the drop-down list.

3 In the Name field, type Phone.

4 Select the “Subaccount of” tick box, and then select Telephone from the drop-
down list.



                                                                                                

3–5

L E S S O N  3

5 In the Description field, type Main phone line.

6 In the Usual VAT Code field select S from the drop-down list. 

Your screen should look like this:

7 Click OK.

QuickBooks displays the new subaccount in the chart of accounts list.

8 Close the chart of accounts.

Working with the Customer:Job list

The Customer:Job list stores names, addresses, and other information about your 
customers. It also holds information about the jobs or projects you may want to track 
for each customer.

Adding a new customer

In this exercise, you’ll add a new customer to the Customer:Job list.

To add a new customer:
1 From the Customers menu, choose Customer:Job List.
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QuickBooks displays the Customer:Job list.

The Customer:Job list lets you add, edit, and get reports on your customers. Each 
customer in the list can have multiple jobs (you may call them projects or 
accounts). Notice that this Customer:Job list already has quite a few entries.

2 Click the Customer:Job menu buttonat the bottom of the list window.

QuickBooks displays the menu.

3 Choose New.

QuickBooks displays the New Customer window.

The New Customer window is where you enter all the information regarding a 
new customer, including billing and shipping addresses, contacts, credit limit, and 
payment terms. QuickBooks uses the information you enter to complete invoices, 
bills and receipts.
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4 In the Customer field, type Walker Homestyle.

This is the name QuickBooks displays in the Customer:Job list. By default, 
QuickBooks sorts the list alphabetically. 

Tip: If you enter individual names in last name, first name order, your 
Customer:Job list displays the names with the last name first.

5 In the Opening Balance field, type 546.00.

6 Press Tab to move to the Company Name field.

7 In the Company Name field, type Walker Homestyle (Preston) Ltd.

8 Press Tab several times to move to the Bill To field.

Notice that QuickBooks has entered the company name in the first line of the Bill 
To field.

9 In the Bill To field, click the line below the company name. Type 9 Lower Ivory 
Street, and then press Enter.

Notice that you press Tab to move between fields, but you press Enter to move 
from one line to the next within a field.

10 On the next line of the Bill To field, type Preston PR2 1JN.

Note: If you will need to display individual address fields in reports, click the 
Address Details button to make sure you enter details in the correct fields.

11 Click Copy to have QuickBooks copy the billing address to the Ship To field.

12 In the Contact field, type Mary Miller.

13 In the Phone field, type 01772-559841.

14 In the FAX field, type 01772-550012.

15 In the Alt. Contact field, type John Firmin.

Your screen should now look like this:
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Providing additional customer information

You’ve just completed the Address Info tab for a new customer. The Additional Info 
tab is where you can enter other important information, such as customer type (if you 
want to categorise your customers in some way), payment terms, credit limit, VAT 
registration number, and the customer’s opening balance

To add additional information to a customer record:
1 Click the Additional Info tab.

QuickBooks displays the Additional Info tab in the New Customer window.

2 Press Tab to move to the Type field.

The Type field lets you track customers in any way that is meaningful for your 
business. For example, if you run television, radio and print adverts, and you want 
to know which advertising method brings you the most customers, you can assign 
customers a “type” (TV, Radio, or Print) and run reports that tell you which referral 
source is most effective. Grangeworth Kitchens uses the Type field to categorise 
customers by type of business.

3 Type Repeat non-commercial and press Tab.

QuickBooks tells you that Repeat non-commercial is not currently on the 
Customer Type list and asks if you wish to add it.

4 Click the Quick Add button to add this customer type to the list.

5 In the Terms field, choose Net 30 from the drop-down list.
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6 Click the ‘Use customer tax code’ tickbox, because Grangeworth Kitchens wants 
to use a default customer VAT code for this customer. 

7 Leave the VAT code as S (standard rate). If this were a different type of customer, 
for example a charity, you could choose a different default VAT rate

Your screen should look like this:

Providing customer payment information

The Payment Info tab is where you enter customer account numbers and credit limits. 
QuickBooks remembers each customer’s credit limit and warns you when a customer 
is about to exceed it. You can also record information about each customer’s preferred 
payment method. For customers who pay by credit card, you can enter credit card 
numbers and expiry dates.

To add payment and credit information to a customer record:
1 Click on the Payment Info tab.

2 In the Credit Limit field, type 2000.

3 In the Preferred Payment Method drop-down list, choose Cheque.
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When you finish, your window should look like this:

4 Click OK to add the customer and close the New Customer window.

QuickBooks displays the Customer:Job list with Walker Homestyle added.

5 Close the Customer:Job list.

Working with the Employee list

The Employee list stores information about your employees such as name, address and 
National Insurance number. If you are using QuickBooks for payroll, it also stores 
information needed to calculate pay cheques. You’ll learn how to enter employee 
payroll information later in this course. For now, enter only the basic information.

Adding a new employee

Suppose that Grangeworth Kitchens has hired a new employee and you want to add 
her information to the Employee list.

1 From the Employees menu, choose Employee List.

QuickBooks displays the Employee list.

You can add a new employee to the Employee list, edit information for an existing 
employee, or delete an employee name (as long as you have not used the 
employee name in any transactions).
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2 Click the Employee menu button and choose New.

QuickBooks displays the Address Info section of the Personal Info tab in the New 
Employee window:

3 In the First Name field, type Marlene.

4 In the Last Name field, type Duncalf.

5 In the Address field, type 73 St. Bernards Drive.

6 For the City field, type Slough.

7 For the Post Code field, type SL2 7YS.

8 In the Phone field, type 01753 876645.

9 For the National Insurance number, type TY 61 91 01 C.

10 For the DOB field, type 10/10/72.

11 Click Female.

12 For Marital Status, select Divorced from the drop-down list.

When you finish, your window should look like this:
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13 Click OK.

14 When QuickBooks asks if you want to set up payroll information, click Leave As Is.

QuickBooks displays the Employee list with the new employee’s name added:

15 Close the Employee list.

Working with the Supplier list

The Supplier list is where you record information about the companies or people from 
whom you buy goods or services. QuickBooks uses the data in the Supplier list to fill 
in purchase orders, receipts, bills and cheques as you receive and pay for goods and 
services.

Adding a new supplier

In this exercise, you’ll add a new supplier to the Supplier list. Suppose Grangeworth 
Kitchens is working with a new subcontractor, and it needs to add information about 
the new supplier to its QuickBooks Supplier list.

1 From the Suppliers menu, choose Supplier List.

QuickBooks displays the Supplier list.
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2 Click the Supplier menu button, and then choose New from the menu.

QuickBooks displays the New Supplier window.

The New Supplier window is where you enter all of the information regarding a 
new supplier, such as name, phone, contact, address, and opening balance. Just as 
when you add a new customer or employee, you start by providing basic 
information on the Address Info tab.

3 In the Supplier field, type Heathcote A.

This is the name QuickBooks displays for this supplier in the Supplier list. If the 
supplier is an individual, you may wish to enter the surname first, then the first 
name.

4 In the Opening Balance field, type 105.90. Leave the date as is.

5 In the Company Name field, type Heathcote A.

6 Click in the Address field, below the company name displayed on the first line.

Notice that QuickBooks displays the company name on the first line of the 
Address field.

7 On the second line of the Address field, type 6 Fountain Rd.

8 Press Enter to move to the next line.

9 Type Leicester.

10 Press Enter to move to the next line.

11 Type LE1 2US.

Note: If you will need to display individual address fields in reports, click the 
Address Details button to make sure you enter details in the correct fields.

12 In the Contact field, type A Heathcote.

13 In the Phone field, type 0116 789400.

14 In the FAX field, type 0116 789500.
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When you finish, your window should look like this:

Providing additional supplier information

The Additional Info tab in the New Supplier window is where you can enter a supplier 
type (if you want to categorise your suppliers), payment terms, credit limit, the 
supplier’s VAT registration number, and your opening balance. You’ll add this 
information now for A Heathcote.

To add information to a supplier record:
1 Click Additional Info.

QuickBooks displays the Additional Info tab in the New Supplier window.

2 In the Account field, type 123-445.
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3 In the Type field, type Contractor.

Notice that as you type Cont, QuickBooks fills in the rest.

4 In the Terms field, choose 2% 10 Net 30 from the drop-down list.

5 In the Credit Limit field, type 2000.

Your New Supplier window should resemble this one:

6 Click OK.

QuickBooks displays the updated Supplier list:

Notice that Heathcote A. has been added.

7 Close the Supplier list.

Adding custom fields

QuickBooks lets you add custom fields to your Customer:Job, Supplier, Employee, and 
Item lists. Custom fields give you a way to track additional information specific to 
your business. For example, you can add a field for pager numbers to your Supplier 
and Employee lists, a field for customers’ birthdays to your Customer:Job list, and 
fields for colour and finish to your Item list. 

After you add custom fields, you can use them on invoices, credit memos, cash sales 
receipts, estimates (QuickBooks Pro/Accountant only) and purchase orders. When you 
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add the custom fields to your sales forms or purchase orders, the fields are prefilled 
with the information for that specific customer, employee, supplier, or item (if you 
specified a value for the custom field when you added the customer, for example). You 
don’t have to add the custom fields to your forms, however; you can also use custom 
fields as a way to record information just for your use, such as a credit rating for each 
customer. QuickBooks remembers the information you entered in the custom fields 
when you import and export data and when you memorise transactions.

For each customer, supplier, and employee, you can add up to seven custom fields, 
including fields that overlap. For example, if you add a custom birthday field for 
customers, suppliers and employees, QuickBooks counts it as one field used for each. 
You can add up to five custom fields for each item your company sells.

Adding custom fields for customers, suppliers, and employees

You can enter information in the custom fields only through the New or Edit windows 
(for example, New Customer or Edit Customer). Information from the custom fields 
can be displayed only on a form. You can also add custom fields to reports.

First, look at the custom fields that Grangeworth Kitchens has already added to its 
Customer:Job, Supplier, and Employee lists. Then, you’ll add two new custom fields.

To add custom fields:
1 From the Customers menu, choose Customer:Job List.

QuickBooks displays the Customer:Job list.

2 In the Customer:Job list, select Walker Homestyle.

3 Click the Customer:Job, menu buttonand then choose Edit from the menu.

QuickBooks displays the Edit Customer window:

4 Click the Additional Info tab.

QuickBooks displays the Additional Info tab in the Edit Customer window.
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5 Click Define Fields.

QuickBooks displays the Define Fields window.

Notice that Grangeworth Kitchens has already set up some custom fields: in the 
Customer:Job list for mobile, website, and sales region; in the Supplier list for 
mobile and website; in the Employee list for last pay review and next of kin.

Now, you’ll add a custom field for alternative email address to the Customer:Job 
and Supplier lists. You’ll also add a custom field to the Employee list that tracks 
the date of each employee’s last review.

6 In the first blank Label field, type Alt. email.

7 Select the Customers:Jobs tick box.

A tick mark appears in the box.

8 Select the Suppliers tick box.

9 In the next blank Label field, type Date of last review.
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10 Select the Employees tick box.

Your Define Fields window should now look like this:

11 Click OK.

12 If you see an informational message about using the custom fields in transactions 
by turning them on in your custom templates, click OK.

QuickBooks has added the Alt. email field to the Edit Customer window.

13 Click OK to close the Edit Customer window.

14 Close the Customer:Job list.
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Adding custom fields for items

Now suppose that Grangeworth Kitchens wants to add a custom field to its Item list. 
The company purchases several types of sink. The Item list already has a custom field 
for Colour, but now Grangeworth wants to add a field for Finish.

To add custom fields for items:
1 From the Lists menu, choose Item List.

QuickBooks displays the Item list, as shown below.

2 In the Item list, select Butler’s sink.

3 Click the Item menu button, and then choose Edit.

QuickBooks displays the Edit Item window.
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4 Click the Custom Fields button.

QuickBooks displays the custom fields already defined for this item:

5 Click Define Fields.

QuickBooks displays the Define Custom Fields for Items window.

6 Under Use, click the first blank tick box to select it. Then type Finish in the Label 
field.

7 Click OK to close the window.

8 If you see an informational message about using the custom fields in transactions 
by turning them on in your custom templates, click OK.

9 In the Custom Fields for Butler’s sink window, type White in the Colour field and 
Porcelain in the Finish field.

10 Click OK to close the Custom Fields for Butler’s sink window, and then click OK 
to close the Edit Item window.

11 Close the Item list.
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Managing lists

Lists are easy to manage in QuickBooks. You can sort lists, combine (merge) list items, 
rename list items, delete list items, make list items inactive, and print lists.

Sorting lists

You can sort many QuickBooks lists manually or alphabetically. To sort a list 
manually, simply use the mouse to drag a list item to its new location. Lists that you 
can sort this way are the Chart of Accounts, Customer:Job, Class, Customer Type, 
Supplier Type, Job Type, and Memorised Transaction lists.

If you have changed the order of a list by dragging items and then decide you’d rather 
have an alphabetically sorted list, QuickBooks has a Re-sort List command. In the 
chart of accounts, the Re-sort List command sorts alphabetically within account type; 
in the Item list, the Re-sort List command sorts alphabetically within item type.

Sorting a list manually

In this exercise, you’ll sort a list manually, and then re-sort it to put it back in 
alphabetical order.

To sort a list manually:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts for Grangeworth Kitchens.

2 Click the diamond to the left of the Plumbing subaccount of the Labour account.

The mouse pointer becomes a four-directional arrow.

3 Click and hold the mouse button, and drag the pointer upward until you see a 
dotted line directly below Labour.
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4 Release the mouse button to drop the account in the new position.

The Plumbing account is now directly under the Labour account.

Now you can use the Re-sort List command to return the list to alphabetical order.

5 To re-sort the list alphabetically, click the Account menu button and select Re-sort 
List.

QuickBooks asks you to confirm that you want to return the list to its original 
order.

6 Click OK.

QuickBooks re-sorts the chart of accounts alphabetically by account type.

7 Close the chart of accounts.

Note: If you sort a list manually, you must keep list items, accounts, etc., of the 
same type together.

Sorting a list in ascending or descending order

Depending on the type of business you have, you may want to order your list entries 
in a certain way. For example, perhaps you’d like to see people who owe you money 
at the top of your Customer:Job list. In this exercise, you’ll learn how to sort the 
Customer:Job list in descending order by customer balance.

To sort a list in descending order:
1 From the Lists menu, choose Customer:Job List.

2 Click the Balance column heading.

Notice that an arrow pointing up appears on the heading and the list is sorted in 
ascending order by customer balance.
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3 Click the column heading again.

Notice that the arrow now points down and the list is sorted in descending order 
with the customers with the highest balances at the top of the list.

4 To return to the order you started with, click the large diamond in the column 
title.

5 Close the Customer:Job list.

Merging list items

In most lists, you can combine two list items into one. For example, you may find that 
you’ve been using two customers (because of different spellings) when you really need 
only one on your Customer:Job list. You can merge list items in the Chart of Accounts, 
Item, Customer:Job, Supplier, Employee, and Other Names lists.

Important: After you merge list items, you cannot separate them. When working
in your own company file, we recommend that you back up your data
before merging list items.

Suppose you want to merge Heathcote A (the supplier you added earlier in the lesson) 
with Arthur Heathcote. To merge them, you can edit the incorrect name to match the 
spelling of the correct name.
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To merge items on a list:
1 From the Suppliers menu, choose Supplier List.

QuickBooks displays the Supplier list.

2 Select Heathcote A.

3 Click the Supplier menu button, and then choose Edit.

QuickBooks displays the Edit Supplier window.

4 In the Supplier Name field, type Arthur Heathcote (the name of the supplier you 
want to merge with).

5 Click OK.

QuickBooks asks if you would like to merge the names.

6 Click Yes.

QuickBooks merges the two names and you now have only Arthur Heathcote in 
the Supplier list.

7 Close the Supplier list.
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Renaming list items

You can rename any list item. When you make the change, QuickBooks automatically 
modifies all existing transactions containing the item.

Tip: If you don’t want to change existing transactions, add a new name or item 
instead.

To rename a list item in the chart of accounts:
1 From the Lists menu, choose Chart of Accounts to display the chart of accounts 

for Grangeworth Kitchens.

2 In the chart of accounts, select Fitting.

3 Click the Account menu button, and choose Edit.

QuickBooks displays the Edit Account window.

4 In the Name field, type Installation.

5 Click OK.
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QuickBooks changes the name in the chart of accounts.

6 Close the chart of accounts.

Deleting items and making list items inactive

You can delete list items only if you have not used them in any transactions. If you 
try to delete a list item that is used in a transaction, QuickBooks displays a warning 
that the item can’t be deleted. If you don’t want to use a list item but you can’t delete 
it, you can make it inactive.

To make a list item inactive:
1 From the Customers menu, choose Customer:Job List.

QuickBooks displays the Customer:Job list as shown below:

2 Select Martina Freeman in the list.

3 Click the Customer:Job menu button, and choose Make Inactive.

Notice that Martina Freeman no longer appears on the Customer:Job list. The 
customer:job item is only removed from the list—transactions associated with this 
customer:job will still appear in reports.
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4 To see inactive list items, tick the Show All box in the list window.

QuickBooks displays all the list items again, but the Xs signify that this customer 
is still inactive (you make the customer active again by choosing Make Active from 
the Customer:Job menu button).

5 Leave the Customer:Job list open; you will print it in the next exercise.

Printing a list

You can print a QuickBooks list for reference, or you may print a list to a file to use in 
your word processor or spreadsheet.

To print a list of customers:
1 Click the Customer:Job menu button, and then choose Print List.

QuickBooks displays a message telling you that you can also print list information 
from the Reports menu.

2 Click OK to bypass the List Reports message.

QuickBooks displays the Print Lists window, which displays the name of your 
printer and printer port.

You can select to print to a printer or to a file.

3 Click Print.

QuickBooks displays a message as it sends the print job to your printer, then 
redisplays the Customer:Job list.

4 Close the Customer:Job list.
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Lesson objectives
� To learn how to work with the registers for QuickBooks bank accounts

� To demonstrate how to open a register

� To learn the features common to all registers

� To learn when and how to make entries directly in the register

� To demonstrate how to reconcile a QuickBooks bank account

� To learn how to track credit card transactions in QuickBooks

� To reconcile a credit card account

� To see how to make a credit card payment

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 4.qbw in 
the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Writing a QuickBooks cheque

You can enter cheques directly into the cheque register by using the QuickBooks Write 
Cheques window. When you enter a cheque at the Write Cheques window, you can 
see the address information and easily allocate the cheque between multiple accounts.

Suppose that you need to write a cheque to pay Grangeworth Kitchens’s water bill.
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To write a cheque:
1 From the Banking menu, choose Write Cheques.

QuickBooks displays the Write Cheques window.

The Bank Account field shows which account you are using for this cheque. The 
Date field displays the current date. You can change either if you wish, but they 
are fine for our example.

2 Select the “To be printed” tick box.

QuickBooks displays a tick mark in the box.

3 In the Pay to the Order of field, type Sout.

QuickBooks fills in Southeast Water in the field.

4 Press Tab to move to the Amount field.

Tip: The QuickBooks AutoRecall feature fills in the amount from the last trans-
action with a payee. This is convenient when you have recurring payments 
of the same amount. You can turn on AutoRecall by choosing Preferences 
from the Edit menu. Click General in the left scroll bar, and then click on 
“Automatically recall last transaction for this name.”

5 Type 56.91 (the amount of the water bill), and then press Tab.

Notice that QuickBooks spells out the amount of the cheque for you on the line 
below the payee.
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6 Click in the Account column on the Expenses tab, and then choose Utilities:Water 
from the drop-down list.

Your screen should resemble this one:

The Expenses tab is where you assign the amount of the cheque to one of the 
expense accounts on your chart of accounts. In this case, Grangeworth Kitchens 
assigns the cheque to its Utilities account and the Water subaccount. You use the 
Items tab only when purchasing items you plan to stock.

7 Click Save & Close.

Using bank account registers

When you work in QuickBooks, you often use forms, such as a cheque or an invoice, 
to enter information. Behind the scenes, QuickBooks records your entries in the 
appropriate account register. Each balance sheet account on the chart of accounts has 
a register (except for Retained Earnings).

Opening a register

When you have a QuickBooks form displayed on your screen, you can view its account 
register by choosing Use Register from the Banking menu, or by double-clicking the 
account name in the chart of accounts.
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To open a register from the Banking menu
1 From the Banking menu, choose Use Register

Grangeworth Kitchens has more than one type of bank account, so QuickBooks 
displays the Use Register dialog box so you can specify the account you want:

2 Click OK.

QuickBooks opens the Master Bank Current account register:

Notice that the cheque you just wrote is listed as “To print”.

3 Close the Master Bank Current account register.

To open a register from the Chart of Accounts:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the Chart of Accounts window.

2 In the chart of accounts, double-click on the Master Bank Savings account.
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QuickBooks opens the Master Bank Savings account register for Grangeworth 
Kitchens:

Common features of QuickBooks registers

All QuickBooks registers work the same way, regardless of the accounts with which 
they are associated. Here are some common features of all QuickBooks registers:

� The register lists every transaction affecting the account balance in chronological 
order (though you can change the order by choosing a different option from the 
Sort by drop-down list). For example, in a current account, the register shows 
cheques you’ve written (either in QuickBooks or by hand), deposits to the 
account, and other withdrawals from the account.

� The columns in the register show information about the transaction. The first 
column is the date. The second column is for a reference number (a cheque 
number or a supplier’s P.O. number) and type (whether the transaction represents 
a cheque or a bill payment, for example). The next column lists the payee, the 
account to which you’ve assigned the transaction, and any descriptive memo. The 
final columns for a bank account show the transaction amount (either in the 
Payment or Deposit column) and whether the transaction has cleared the bank 
(indicated by a tick in the column).

� On every transaction line, QuickBooks shows the account’s running balance. The 
bottom of the register window shows the account’s ending balance—the balance 
includes all transactions entered in the register, including cheques not yet printed.

To complete the exercise:
1 Close the Master Bank Savings account register window.

2 Close the Chart of Accounts window.
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Entering a handwritten cheque

Sometimes you need to write a cheque on the spot for items you did not plan to 
purchase. QuickBooks lets you write the cheque, then enter it later in the current 
account register or on the cheque form.

Suppose that one day, while picking up stationery at Newton Office Supply, you find 
a new office chair on sale for £99.95. The sale ends today, so you write a cheque on 
the spot. You’ll have to enter it in QuickBooks later.

To enter a handwritten cheque in the current account register:
1 From the Banking menu, choose Use Register.

QuickBooks displays the Use Register dialog box:

2 Click OK to accept Master Bank Current Account.

QuickBooks displays the account register:

3 Click the Number field in the blank transaction at the bottom of the register.

4 Type 1204, and then press Tab.

5 In the Payee field, type Newton Office Supplies, and then press Tab.

QuickBooks displays a message that Newton Office Supplies is not on the Name 
list.

6 Click Quick Add.
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QuickBooks displays the Select Name Type dialog box:

Newton Office Supplies is a supplier, so you can accept the displayed choice.

7 Click OK.

QuickBooks adds the new supplier to the Supplier list.

8 In the Payment field, type 99.95, and then press Tab.

9 In the Account field, type Of, and then press Tab.

QuickBooks fills in Office Furniture.

10 In the Memo field, type Office chair.

The current account register on your screen should resemble this one:

11 Click Record.

12 Close the Master Bank Current Account register.
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Transferring money between accounts

You can easily move money between accounts using the QuickBooks Transfer Money 
Between Accounts form. Grangeworth Kitchens needs to transfer £2,000.00 from the 
savings account to the current account, to cover a quarterly VAT payment.

To transfer money:
1 From the Banking menu, choose Transfer Money.

QuickBooks displays the Transfer Money Between Accounts window.

2 In the Transfer Money From field, select Master Bank Savings (if not shown):

Notice that QuickBooks displays the current balance for the Master Bank Savings 
account.

3 In the Transfer Money To field, select Master Bank Current from the drop-down 
list. 

The balance of this account is also displayed.

4 In the Transfer Amt field, type 2000.00.

Tip: If you prefer,, you can set QuickBooks to insert the decimal point automat-
ically, like an adding machine. To enable this feature, choose Preferences 
from the Edit menu, click General and tick “Automatically place decimal 
point” on the My Preferences tab.

5 In the Memo field, type Money Transfer if not already shown.



4–10

W o r k i n g  w i t h  b a n k  a n d  c r e d i t  c a r d  a c c o u n t s

Your screen should now resemble this one:

6 Click Save & Close.

QuickBooks decreases the balance in the savings account by £2,000 and increases the 
balance in the Master Current Account by £2,000.

Reconciling bank accounts

Reconciling is the process of making sure that your bank account record matches the 
bank’s record. When you keep your records with QuickBooks, you don’t have to worry 
about addition or subtraction errors as you do when you’re using a paper cheque 
register. Even so, it is important to get in the habit of reconciling your QuickBooks 
bank accounts on a monthly basis to make sure that your QuickBooks records and 
bank statement agree. This helps you avoid overdraft charges for bad cheques, spot 
possible bank errors and keep more accurate financial records.

Your bank sends you a statement for each of your accounts each month. The 
statement shows all the activity in your account since the previous statement:

� The opening balance (amount in your account as of the previous statement)

� The ending balance (amount in your account as of the closing date for this 
statement)

� The amount of interest, if any, you’ve received for this statement period

� Any service charges assessed by the bank for this statement period

� Cheques that have cleared the bank

� Deposits you’ve made to the account

� Any other transactions that affect the balance of your account (for example, auto-
matic payments or deposits or cash dispenser withdrawals or deposits)

When you receive a statement from your bank or from a credit card company, you 
need to reconcile the statement with your QuickBooks records. You can reconcile any 
QuickBooks bank account, including accounts for savings and money market funds.
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Note: If you have an Internet connection, you can set up online banking, which 
allows you to download online bank statements directly into QuickBooks 
so you can use them to reconcile your bank account in QuickBooks.For 
details, search in the Help for online banking.

Marking cleared transactions

To begin reconciling an account, you need to tell QuickBooks the account you want 
to reconcile. Then you can provide information from your bank statement.

To reconcile your account:
1 From the Banking menu, choose Reconcile.

QuickBooks displays the Begin Reconciliation window:

2 In the Account To Reconcile field, choose Master Bank Current from the drop-
down list if not shown.

3 In the Ending Balance field, type 9926.99.

4 In the Service Charge field, type 14.00 and select Bank Service Charges from the 
drop-down list in the Account field.

5 Click Continue to display the Reconcile window:
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6 Click Columns to Display.

QuickBooks displays the Customize Columns window.

7 Under Cheques and Payments, select Memo, then click OK.

QuickBooks adds the extra column.

You can resize the Reconcile window to display the columns more clearly, or to 
display more transactions at once.

8 Under Deposits and Other Credits, select the 28/02/2003 deposit for 3683.63.

QuickBooks places a tick in front of it.

9 Under Cheques and Payments, select the payment dated 03/03/2003 to Firth & 
Co. for 2602.63.

10 Under Cheques and Payments, select the payment dated 15/03/2003 to Inland 
Revenue for 1965.34.

Your screen should now resemble this one:
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If you need to make a correction to a transaction, select the transaction, then click 
the Go To button. When you have corrected the transaction in the register you can 
then return to the Reconcile window where you left off. 

11 Click Reconcile Now.

QuickBooks displays the Select Reconciliation Report dialog box:

12 Make sure Both is selected, then click Display.

13 Click OK at the message.

QuickBooks displays both the Reconciliation Summary and Reconciliation Detail 
reports. 

It’s a good idea to save each reconciliation report, but for the purposes of this 
lesson it is sufficient to view the reports.

Because Regular and Pro overwrite the previous reconciliation report with data 
from the latest reconciliation, you may want to print a copy of the report, print 
the report to a file, export to an Excel file (or in Pro/Accountant you can also save 
the report in PDF format) in case you need to reference it again. (To save a report 
in PDF format, with the report displayed, choose Save as PDF from the File menu.) 
If you’re using QuickBooks Accountant, you can print the reconciliation reports 
for all previous reconciliations.

14 Close both report windows.
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Now you know that the balance in the QuickBooks Master Bank Current account 
register is accurate as of the latest bank statement. The next time you look at the 
cheque register, you’ll see a tick mark in the Clr (Cleared) column next to each 
reconciled transaction. You’ll see this column in certain reports, too.

Viewing cleared transactions in the register

Next, open the Master Current Account register to see the cleared transactions.

To view cleared transactions:
1 From the Banking menu, choose Use Register.

2 If QuickBooks displays the Use Register window, select Master Bank Current 
Account and click OK.

QuickBooks displays the Master Bank Current Account register.

3 Scroll the register to view the cleared items.

Your register should look like this:

Notice that QuickBooks displays a tick mark next to all cleared items.

In order to illustrate how QuickBooks makes it easy to find discrepancies, you are 
now going to make a change to one of the reconciled transactions.

4 Select the Bank Service Charge transaction.

5 From the Edit menu, choose Delete Cheque.

6 When QuickBooks asks you to confirm, click OK.

7 Close the Master Current Account register.
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Locating reconciliation discrepancies
In addition to the summary and detail reports (which you can view as PDF files), 
there is an additional report option: the Reconcile Discrepancy report. The 
Reconcile Discrepancy report shows changes and deletions made to previously 
reconciled transactions, making it easier to find discrepancies. This report is useful 
when the beginning balance that QuickBooks shows is different from the ending 
balance from the bank statement for the previous period. 

In this exercise, you’ll see the discrepancy caused by your having deleted a 
reconciled transaction.

To find discrepancies in the last reconciliation:
1 From the Banking menu, choose Reconcile f.

2 Click Locate Discrepancies.

QuickBooks displays the Locate Discrepancies window.

3 Click Discrepancy Report.

QuickBooks displays the Discrepancy Report. In this case, it shows that the Bank 
Service Charge of £14.00 was deleted.
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If the last reconciliation was in error, you can click Undo Previous Reconciliation 
in the Locate Discrepancies window. This undoes the reconciliation without your 
having to identify and manually clear each affected transaction.

Note: If you need to take this action, you are recommended to make a backup of 
your company file first.

Tracking credit card transactions

In your business, you sometimes pay for expenses with a credit card rather than a 
cheque. For travel expenses especially, a credit card is invaluable because the 
statement gives a detailed listing of each charge. You can track your credit card 
transactions in QuickBooks just as easily as you track expenses you pay for by cheque.

You should set up a QuickBooks credit card account for each credit card you use in 
your business. Like any QuickBooks account, a credit card account has its own register, 
listing all the charges and credits you’ve recorded and payments you’ve made. The 
way you open and scroll through a credit card register is the same as for any 
QuickBooks account register.

Setting up a credit card account

There are two steps to setting up a credit card account: to record the credit card 
transactions, you need to create the new account itself; to record payments to the card 
issuer, you must set up the card issuer as a supplier.

To create the credit card account:
1 From the Lists menu, choose Chart of Accounts.

The Chart of Accounts window is displayed.

2 Click the Account menu button, then choose New.

Quick Books displays the New Account dialog box:
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3 In the Type field, select Credit Card from the drop-down list.

4 In the Name field, type Master Bank VISA.

5 In the Card No. field, type 4929 4123 4567 8910.

Your screen should look like this:

6 Click OK.

Master Bank VISA now appears in the Chart of Accounts.
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To set up the card issuer:
1 From the Suppliers menu, select Supplier List.

The Supplier List window is displayed.

2 Click the Supplier menu button, then select New.

Quick Books displays the New Supplier dialog box:

3 In the Supplier Name field, type Master Bank VISA.

4 In the Company Name field, type Master Bank VISA.

5 In the Address field, type PO Box 1000, London EC1A 2YR.

Your screen should look like this:

6 Click OK.

Master Bank VISA now appears in the Supplier List.
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Entering credit card charges

QuickBooks lets you choose when you enter your credit card charges, either when you 
charge an item or when you receive the bill. Your choice depends on whether you like 
to enter information into QuickBooks incrementally or all at once. The advantage to 
entering charges when you charge an item is that you can keep close track of how 
much you owe. In addition, if the charge is for a particular job, you can keep track of 
how much you’re spending on that job.

Suppose you have a £30 office supplies charge you want to enter into QuickBooks. The 
form you use is the Enter Credit Card Charges form.

To enter a credit card charge:
1 From the Banking menu, choose Enter Credit Card Charges.

QuickBooks displays the Enter Credit Card Charges window. 

This is the window where you enter your charges. Notice that the form at the top 
of the window looks like a credit card charge slip.

2 In the Credit Card field, make sure QuickBooks has Master Bank VISA listed as the 
credit card.

3 In the Purchased From field, select Sava Cash & Carry from the drop-down list.

The next field is called Ref No. Most credit card receipts have some sort of trans-
action number near the top, for identification and tracking. Entering this number 
from a credit card receipt gives you additional information for the credit card 
charge, but you don’t have to use it. You don’t need to enter one for this example.

4 Double-click in the Amount field to select the entire amount.

5 Type 30.00 and then press Tab.

6 Click the Expenses tab.
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7 In the Account field, select the Office Supplies account, as shown below:

8 Click Save & Close to record the transaction and close the window.

After you record this credit card charge, QuickBooks adds a £30 transaction to the 
credit card account register (increasing the liability by £30). It also adds £25.53 to 
the Office Supplies account and £4.47 to the VAT Control liability account. You 
will see the increases when you create reports on these accounts.

Reconciling and paying a credit card bill

As with a bank account, you should reconcile your credit card receipts with your credit 
card statement. Reconciling a credit card account is almost identical to reconciling a 
bank account (as in a previous exercise).

To reconcile a credit card statement:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 Click Master Bank VISA in the list to select it.
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3 Click the Activities menu button, then choose Reconcile Credit Card.

QuickBooks displays the Begin Reconciliation window.

In the Opening Balance field, QuickBooks displays the balance of all cleared trans-
actions in the credit card register.

4 In the Ending Balance field, type 30.00, and click Continue.

The Reconcile Credit Card window shows all the transactions for the credit card 
account that have not yet cleared.

5 In the Payments and Credits section of the window, select the payment for 30.00.

QuickBooks places a tick in the column to the left of the transaction. 
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Your Reconcile Credit Card window should look like this:

6 Click Reconcile Now.

QuickBooks displays the Make Payment dialog box:

7 Click OK.

QuickBooks displays the Select Reconciliation Report dialog box:

8 Normally, you’d click either Display or Print. For now, click Cancel.
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QuickBooks displays the Write Cheques window:

Notice that QuickBooks has already filled in the amount of the payment and 
assigned the expense to the Visa account. (If you decide you only want to make a 
partial payment, you can change the amount here.)

9 Make sure Master Bank Current is shown as the bank account.

10 Make sure Master Bank VISA is shown as the payee in the Pay to the Order of field.

11 Click in the “To be printed” tick box.

The transaction should now look like this:

12 Click Save & Close to record the transaction.

QuickBooks subtracts £30.00 from the current and credit card accounts.
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Other reconciliations

If you are signed up to the QuickBooks Card Solutions, a new option would be 
available on the Banking menu: Reconcile Merchant Account Service. This would take 
you to the merchant card service page, where you would log on to get the statement. 
This is in the form of an IIF file, which will be downloaded for you to reconcile.
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Lesson objectives
� To introduce the other account types available in QuickBooks

� To discuss the different types of asset and liability accounts you can create and see 
how to track assets and liabilities in QuickBooks

� To introduce the subject of equity and QuickBooks equity accounts

� To see how to make journal entries

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 5.qbw in 
the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Other account types in QuickBooks

In this lesson, you’ll learn about these types of QuickBooks accounts:

� Asset accounts—Used to track both current assets (those you’re likely to convert 
to cash or use up within one year, such as stock on hand) and fixed assets (long-
term notes receivable and depreciable assets that aren’t liquid, such as equipment, 
furniture, or buildings).

� Liability accounts—Used to track both current liabilities (those liabilities 
scheduled to be paid within one year, such as VAT, payroll taxes, and short-term 
loans) and long-term liabilities (such as loans or mortgages scheduled to be paid 
over longer terms).
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� Equity accounts—Used to track owner’s equity, including capital investment, 
drawings, and retained earnings.

Working with asset accounts

QuickBooks has two account types for tracking the value of your assets:

� Other Current Asset accounts track assets with a life of less than a year. If you buy 
and sell stock, the value of all your stock on hand is usually shown in an Other 
Current Asset account called something like “Stock Asset”. Other current assets 
might include certificates of deposit, prepaid expenses (amounts already paid for 
services yet to be received), prepaid deposits (to be returned at a later date), reim-
bursable expenses, and notes receivable (if due within one year).

� Fixed Asset accounts track assets your business owns that are not likely to be 
realised within a year. A fixed asset is usually something necessary for the oper-
ation of your business, like a van, cash register, computer or photocopier.

Setting up an Other Current Asset account

Suppose you need an Other Current Asset account to track a prepaid expense for rent. 
(The landlord requires a six-month advance payment.)

1 Display the chart of accounts.

2 Click the Account menu button, and then choose New.

QuickBooks displays the New Account window.

3 For the Type, choose Other Current Asset from the drop-down list.

4 In the Name field, type Prepaid Rent.

5 For the opening balance, type 6000.00.

The window should look like this:
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6 Click OK.

QuickBooks displays the new account in the chart of accounts.

As each month goes by and you use part of that prepaid expense, you can enter each 
month’s rent as a decrease in the value of the current asset and assign it to the rent 
expense account. You would enter those transactions directly in the register for the 
Prepaid Rent asset account.

Setting up asset accounts to track depreciation

Fixed assets are equipment or property your business owns that are not for sale. Since 
they last a long time, you don’t completely charge their cost to the year in which you 
buy them. Instead, you spread their cost over several years. But because fixed assets 
wear out or become obsolete, their value declines constantly from the day you 
purchase them. The amount of this decline in value is called depreciation.

To determine the estimated value of a fixed asset at any time, you need to subtract its 
accumulated depreciation (total amount of depreciation since the asset’s purchase) 
from its original cost.

Usually, you’ll want your balance sheet to show the original cost of an asset (plus any 
subsequent improvements) on one line, with the accumulated depreciation subtracted 
from the original cost on a second line, and the current value (net) on a third line. 

The method you’ll learn in this lesson lets you see each asset’s cost and its 
accumulated depreciation separately on your balance sheet. You set up a separate fixed 
asset account for each asset, and two subaccounts under each fixed asset account: one 
for cost and one for accumulated depreciation. The asset in this case is a new trailer 
purchased by Grangeworth Kitchens.

To set up asset accounts to track depreciation:
1 In the Chart of Accounts window, click the Account menu button, then choose 

New.

QuickBooks displays the New Account window.

2 In the Type field, choose Fixed Asset from the drop-down list.

3 In the Name field, type Trailer.
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Your window should look like this:

4 Leave the opening balance blank, and click OK.

QuickBooks displays the new fixed asset account in the chart of accounts.

Now you need to add two subaccounts—one for the asset’s cost, and the other for 
depreciation.

To add subaccounts:
1 In the Chart of Accounts window, click the Account menu button, and then 

choose New.

2 In the Type field, choose Fixed Asset from the drop-down list.

3 In the Name field, type Cost.

4 Select the “Subaccount of” tick box, and then select Trailer as the parent account.

5 Leave the opening balance blank.
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Your screen should resemble this one:

Tip: The opening balance is the original cost of the asset, if you purchased the 
asset before your QuickBooks start date. If you’re buying the asset now, as is 
Grangeworth Kitchens, you leave the opening balance for the Cost account 
blank. When you enter information about the loan Grangeworth Kitchens takes 
out to pay for the trailer (later in this lesson), you’ll update the Cost account 
with the trailer’s original cost.

6 Click OK.

7 Repeat steps 1–6 to add a second subaccount to the Trailer fixed asset account. Call 
this subaccount “Depreciation” and leave the opening balance blank.

When you complete these steps, your chart of accounts should look like this:

Note: The amount you enter as the opening balance depends on whether you 
acquired the asset after or before your QuickBooks start date. If after your 
QuickBooks start date, you leave the opening balance blank. If before, you 
enter—as a negative number—the accumulated depreciation of the asset as of 
the start date.
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Entering a depreciation transaction

When it’s time to enter depreciation for an asset, you can use the register for the asset’s 
accumulated depreciation account.

To enter a transaction for depreciation:
1 In the chart of accounts, select the Depreciation subaccount for Trailer.

2 Click the Activities menu button, and then select Use Register.

QuickBooks displays the register for the Trailer:Depreciation asset account.

3 In the Decrease column, type 1300.00 (the depreciation amount) and press Tab. 

4 In the Account field, select Depreciation Expense from the drop-down list. Your 
register should resemble this one:

5 Click Record.

QuickBooks subtracts the depreciation amount from the current value of the 
corresponding fixed asset account and adds the same amount to your company’s 
depreciation expense account.

6 Close the register window.

Note: With QuickBooks Pro/Accountant, you can track fixed asset items (Lesson 
16).

Working with liability accounts

QuickBooks has two account types for tracking values of liabilities:

� Long-term Liability accounts track debts that your business is not likely to pay off 
within a year. The most common long-term liabilities are loans that you expect to 
pay off in more than one year.
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� Other Current Liability accounts track liabilities that your company expects to 
pay within a year. Other current liabilities might include short-term loans.

Tracking a loan with a long-term liability account

You’ve already added an asset account to track the value of the new trailer. Because 
the trailer loan is not going to be paid off within a year, you need to add a long-term 
liability account.

To add a long-term liability account:
1 In the chart of accounts, click the Account menu button, and then choose New.

QuickBooks displays the New Account window.

2 For the account type, choose Long Term Liability from the drop-down list.

3 In the Name field, type Trailer Loan.

4 For the Opening Balance, type 0.00.

Your screen should resemble this one:

5 Click OK.

QuickBooks displays the new liability account in the chart of accounts.

Since this is a new loan, you are either receiving money to deposit in your bank 
account or receiving a new asset. In this example, you received an asset (the new 
trailer), so you need to show an increase in the asset’s cost account.
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To record an increase in the asset’s cost account:
1 In the chart of accounts, double-click the Trailer:Cost subaccount.

QuickBooks displays the Trailer:Cost register:

2 In the Increase field, type 15000.00.

3 In the Account field, select the Trailer Loan liability account from the drop-down 
list.

Make sure that you select the Trailer Loan long-term liability account, not the 
Trailer fixed asset account.

Your screen should resemble this one:

4 Click Record.

5 Close the register window.

6 Close the chart of accounts.
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When you complete these steps, QuickBooks increases the value of your asset cost 
account to 15,000. It also enters a liability of 15,000 in the liability account you use to 
track the loan. This effectively sets the opening balances for both accounts.

Tracking Fixed Assets

If you’re using QuickBooks Pro or higher, you can enter a fixed asset onto the Fixed 
Asset Item list. This enables you to record such information about an asset as purchase 
date and price, whether the asset was new or used when you bought it, and the asset’s 
sale price if you decide to sell it. You can also generate customisable reports listing all 
your fixed assets.

The information you enter in the Fixed Asset Item list does not transfer to the chart of 
accounts. If you want to track depreciation, refer to lesson 5.

To create a fixed asset item:
1 From the Lists menu, choose Fixed Asset Item List.

QuickBooks displays the Fixed Asset Item list.

2 Click the Item menu button, and choose New.

QuickBooks displays the New Item window, with the item preset to Fixed Asset.

3 In the Asset Name/Number field, type Van.
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4 Enter the following information to complete the Purchase Information section:

� Item is – new

� Purchase Description – Ford Transit Van

� Date – 31/03/2003

� Cost – 15,000

� Supplier/Payee – A1 Motors

5 Enter the following information to complete the Asset Information section:

� Asset Description – White van with company logo

� Serial Number – 123456789

� Warranty Expires – 30/03/2006

6 From the Asset Account drop-down list, choose Van:Cost.

The New Item window should look like the following illustration:

7 Click OK.

8 Close the Fixed Asset Item list.
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Recording a payment on a loan

When it's time to make a payment on a loan, use the Write Cheques window to record 
a cheque to your lender. You’ll want to assign part of the payment to loan interest 
expense and the remainder to loan principal.

To record a payment on a loan:
1 From the Banking menu, choose Write Cheques.

QuickBooks displays the Write Cheques window.

2 In the “Pay to the Order of” field, type Master Building Society and press Tab.

QuickBooks prompts you to add this supplier.

3 Click Quick Add, then select Supplier and click OK.

4 For the amount of the cheque, type 500.00.

5 On the Expenses tab, click in the Account field and choose the Interest 
Expense:Loan Interest expense account from the drop-down list.

6 In the Net Amt column, type 225.00.

7 Assign the remainder of the expense (275.00) to the Trailer Loan long-term 
liability account.

8 Click To be printed.

Your screen should look like this:

9 Click Save & Close to record the payment.
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When you record the transaction, QuickBooks automatically updates the accounts 
affected by this transaction:

� In the current account, QuickBooks subtracts the amount of the cheque from your 
balance.

� In the expense account that tracks interest, QuickBooks enters the interest amount 
as an increase to your company's interest expense.

� In the Trailer Loan liability account, QuickBooks subtracts the principal amount 
from the current value of the liability (reducing the amount of the debt).

Understanding equity accounts

Equity is the difference between what you have (your assets) and what you owe (your 
liabilities). If you sold all your assets today and paid off your liabilities using the 
money received from the sale of your assets, the money you’d have left would be your 
equity.

A balance sheet shows your company assets, liabilities, and equity on a particular date. 
Because equity is the difference between total assets and total liabilities, it’s also true 
that total assets equal the sum of total liabilities and equity.

As you enter the opening balances of your assets and liabilities, QuickBooks calculates 
the amount of equity and records it in an equity account called Opening Bal Equity.

In addition to the Opening Bal Equity account, QuickBooks sets up another type of 
equity account for you called Retained Earnings. This account tracks your company's 
net income from previous financial years. QuickBooks automatically transfers your 
profit (or loss) to Retained Earnings at the end of each financial year.

If your company is a sole proprietorship (an unincorporated company with only one 
owner), you don’t have to add any more equity accounts to your chart of accounts. All 
the equity belongs to the company’s sole owner.

You can get as involved in tracking equity as you wish. Some people like to track 
owner investments, owner’s drawings, and retained earnings prior to their 
QuickBooks start date by putting them in separate equity accounts. If your business is 
a partnership, you’ll probably want to set up separate equity accounts for each partner.

To learn more about equity and to learn how to set up equity accounts for your 
business, search the onscreen Help index for equity
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Working with journal entries

QuickBooks helps you to make general journal entries by:

� Auto-numbering journal entries

� Repeating a memo on every line of a journal entry

� Producing a Journal Entries Today report

Making journal entries

To see how these functions work, you’ll make a series of journal entries for some new 
computer equipment purchased by Grangeworth Kitchens.

Tip: Normally, QuickBooks numbers journal entries automatically. If this 
feature happens to be turned off, here’s how to turn it on. From the Edit 
menu, choose Preferences. Select Accounting in the left-hand panel and 
click the Company tab. Click the “Automatically assign general journal 
entry number” tickbox and click OK.

To create multiple journal entries:
1 From the Banking menu, choose Make Journal Entry. If QuickBooks displays a 

message about automaatic numbering, click OK.

QuickBooks displays the General Journal Entry window:

2 Click on the first line in the Account column, select Computer Equipment:Cost 
from the drop-down list and press Tab twice.

3 Type 250.00 in the Credit column and press Tab three times.

4 Type Scanner in the Memo column.
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5 Now click on the second line in the Account column.

QuickBooks fills in the amount in the Debit column.

6 Select the Computer Equipment:Depreciation account from the drop-down list 
and press Tab.

7 Type Scanner in the Memo field on the second line. 

Your window should look like this:

8 Click Save & New.

QuickBooks clears the window, ready for the next entry. The Entry No. is now 2.

9 Repeat steps 3 to 8 for entry 2, this time typing 500.00 for the Credit amount and 
LCD monitor for Memo.

10 Repeat steps 3 to 8 for entry 3, this time typing 795.00 for the Credit amount and 
Printer for Memo.
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Producing a journal entries report

When you have made a number of journal entries in a session, it can be helpful to 
produce a report listing them.

To produce the report:
1 From the Reports menu, select Memorised Reports, then Accountant, then Journal 

Entries Entered/Modified Today.

QuickBooks displays the report.

2 Scroll to the right.

The report shows all the entries you’ve just made:

3 Close the report.

.
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Lesson objectives
� To demonstrate the different formats available for sales forms

� To practice creating a new invoice

� To discuss the purpose and use of the QuickBooks Item list

� To see how QuickBooks records the information you enter on sales forms

� To memorise an invoice transaction for reuse

� To add a new item to the Item list

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 6.qbw in 
the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Using sales forms in QuickBooks

Any time you make a sale in your business, you record it in QuickBooks on a sales 
form. A sales form can be an invoice (when you expect payment later), a cash sales 
receipt (when you receive payment at the time you make the sale), or a credit memo.
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When to use different types of sales forms

The type of sales form you use depends on whether you expect payment in the future 
or at the time of the sale.

For payment in the future

If you expect to receive payment at some future date, you enter an invoice. The 
invoice lists the customer’s name and address and itemises what that customer owes.

To display a completed invoice form in QuickBooks:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window.

2 Click the Previous button to display the previously created invoice.

Grangeworth Kitchens charges customers for both products and services (such as 
labour). A business selling mainly services, such as a consulting firm, would want 
a different type of sales form. QuickBooks lets you choose from three different 
preset formats for your sales forms, or you can create your own.

3 Close the Create Invoices window.
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For payment at the time of sale

If you receive payment at the time you make a sale—either by cash, cheque, or credit 
card—you fill in a cash sales receipt instead of an invoice. Like the invoice, the 
QuickBooks cash sales receipt includes information about the items or services 
purchased, but it also includes information about how payment was made.

To display a completed cash sales receipt in QuickBooks:
1 From the Customers menu, choose Enter Sales Receipts.

QuickBooks displays the Enter Sales Receipts window.

2 Click the Previous button to view the previously entered cash sale.

Because payment is made at the time of sale, the sales receipt lets you enter deposit 
information at the bottom of the window.

Note: If you are signed up to QuickBooks Card Solutions and the payment 
method was by credit or debit card, an additional option is displayed at the 
bottom of the Enter Sales Receipts window to process online when saving:

When you saved the cash sales receipt, you could then have processed the 
credit or debit card immediately. Once the card had been processed, the 
completed sales receipt would indicate this:

3 Close the Enter Sales Receipts window.
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Choosing a format for sales forms

QuickBooks has four different formats for sales forms: 

� Use the Service format if you primarily sell services but occasionally sell goods.

� Use the Professional format if you sell services and need a lot of room for descrip-
tions of your services.

� Use the Product format if you sell parts or products and need fields relevant to 
shipping.

� Use the Custom format if you want to tailor a form to your type of business.

Each format has an onscreen version and a printed version. This lets you record all the 
sales detail you need, but print only what you want customers to see. For example, if 
you use the Professional format, the onscreen version shows the number of hours 
you’re billing the client as well as your hourly rate; the printed version shows only the 
Description and the Amount fields.

You’ll learn how to customise forms in Lesson 13.

Filling in a sales form

Suppose Grangeworth Kitchens wants to bill a customer for a portion of a kitchen 
remodelling job. Because they expect payment to be made in the future (rather than 
cash on the spot), they need to create an invoice.

Filling in the customer information

Filling in an invoice is just like filling in a paper form; you enter the customer 
information first, followed by a description of the charges.

To enter customer information on an invoice:
1 From the Customers menu, choose Create Invoices.

Notice that the new invoice already has the current date (15/12/2007 in the 
sample file) entered in the Date field, and the next invoice number assigned in the 
Invoice No. field.

2 In the Customer:Job field, click the arrow next to the drop-down list.

QuickBooks shows you a list of Grangeworth Kitchens’s existing customers and 
jobs.

3 Choose Mr. Williams for the customer and job.

Because this name has already been entered on the Customer:Job list, QuickBooks 
knows the billing name, the address, and the payment terms. It provides this 
information for you on the top half of the form.
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Filling in the line item area

On the bottom half of the invoice, you list each service or product you’re selling on 
its own line, along with the amount the customer owes for that item. Because 
information about individual items is on separate lines, the lines are called line items.

In QuickBooks, you enter line items by using the Item list, so you don’t have to type 
and retype lines for services or products you sell frequently. For example, an architect 
would have one item for design and another for construction supervision.

But items are not just products you sell or services you provide to clients. Line items 
can be anything you might want to put in the detail area of an invoice, like a discount, 
a subtotal line, a markup, or other description. QuickBooks has ten different types of 
items.

Grangeworth Kitchens has already entered the items for which it bills customers on 
its Item list.

To complete the line item area of an invoice:
1 In the Quantity field, type 3.

2 In the Item field, type the letters Chairs:P (for pine chairs).

QuickFill is an alternative to choosing from a list. Whenever you’re in a field 
where you’ll use a list item, you can start typing the first few letters of the list item 
you want, and QuickBooks fills in the field with the item that matches the letters 
you’re typing.

3 Press Tab.

When you press Tab to accept a QuickFill entry, QuickBooks fills in other infor-
mation about the item, like its description, price and VAT rate. In this case, Quick-
Books displays “Pine chair” in the Description column, a price of £30, and a total 
amount of £90 plus VAT:
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Completing the sales form

To complete and record the invoice:
1 On the Create Invoices window toolbar, click the Print drop-down arrow, and 

then choose Preview.

QuickBooks asks if you wish to save the invoice.

2 Click Yes.

QuickBooks displays the invoice page as it will look when printed.

3 Click Zoom In and use the scroll bars to see the invoice items at greater magnifi-
cation.

4 Click Close.

5 In the Create Invoices window, record the sale by clicking Save & Close.

QuickBooks records the invoice in your Accounts Receivable register. If this had been 
a cash sales receipt, QuickBooks would have recorded the sale in your Undeposited 
Funds account until you deposited the money at the bank.



6–8

E n t e r i n g  s a l e s  a n d  i n v o i c e s

The Accounts Receivable register keeps track of the money your customers owe you.

To see the Accounts Receivable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 In the chart of accounts, double-click the Accounts Receivable account.

QuickBooks displays the Accounts Receivable register.

3 Select the sale you just recorded in the register.

4 Double-click the entry.

When you double-click an entry in a register, QuickBooks displays the original 
form (in this case, Mr. Williams’s invoice).

5 Leave the invoice open ready to use in the next exercise.

Memorising a sale

Many of the sales you make in your business are ones you repeat again and again. For 
example, you may have a standing monthly order from a customer, or you may 
perform essentially the same services for more than one client. QuickBooks lets you 
memorise sales forms so that you don’t have to retype the information. 

To memorise the invoice:
1 Make sure you have the invoice you want to memorise displayed on your screen. 

In this case, we’ll use the Mr. Williams invoice that we just created.
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2 From the Edit menu, choose Memorise Invoice.

QuickBooks displays the Memorise Transaction window.

3 Type a description that helps you recognise the memorised invoice, or keep the 
default description QuickBooks has provided. For now, type Pine chairs after the 
words “Mr. Williams”.

You can enter any description you like. Notice that you can also have QuickBooks 
remind you when to use the memorised transaction (for an invoice you always 
send at the end of the month, for example).

4 From the How Often drop-down list, select Monthly.

5 In the Next Date field, type 15/01/2008.

6 Click OK.

7 From the Window menu, choose Close All.

QuickBooks adds the memorised invoice to the Memorised Transaction list.

To recall a memorised sale:
1 From the Lists menu, choose Memorised Transaction List.

QuickBooks displays the Memorised Transaction List window.

2 Double-click the Mr Williams invoice you just added.

QuickBooks displays the Create Invoices window, with the information you 
memorised displayed on the form. It gives you a new invoice number and displays 
the next invoice date based on the settings you recorded. You can modify the 
information as you wish, or just save the invoice as it is.

3 Click Save & New to record the invoice.

4 Close the Memorised Transaction list.
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Emailing an invoice

If you prefer, you can send an invoice by email to your customer instead of printing 
it. To do this, you must have an Internet connection, an email account, and your 
default email package must be MAPI-compliant.

To email an invoice:
1 Click Previous to return to the new invoice for Mr Williams.

2 Click the Email button.

QuickBooks prompts you to enter an email address for this customer.

3 Type williams1@email.net and click OK.

Your default email package opens, with the invoice as a PDF attachment.

If your default email package is not MAPI-compliant, you have the option instead 
of saving the invoice as a PDF file. You can then create your own email and attach 
the file.

4 You would then amend the message if you wish, and send the email message as 
usual, but for this exercise you can close the message without sending it.

Note: If you have Pro or above and are signed up to QuickBooks Card Solutions, 
you can also use the drop-down arrow that appears next to the Email 
button and choose Email invoice with online payment option. The email 
would include a link to a secure payment page to enable the customer to 
pay their invoice online.

Entering a new service item

When you begin using your own QuickBooks company file, you’ll need to create your 
own line items to include on your invoices. In the next exercise, you’ll see how to add 
information to the Item list.

Grangeworth Kitchens already has a service item called Fitting that it uses when it 
wants to charge for general installation work. Suppose Grangeworth Kitchens wants 
to add a subitem for plastering to the Item list. (The company charges a higher rate for 
plastering, so they want a separate item for it on their Item list.)

To create a new service item:
1 From the Customers menu, choose Item List.

QuickBooks displays the Item list for Grangeworth Kitchens:
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2 Click the Item menu button, and then choose New.

QuickBooks displays the New Item window.

3 In the Type field, select Service from the drop-down list if not shown.

4 In the Item Name/Number field, type Plastering, and then press Tab.

5 Click the “Subitem of” tick box to select it.

6 In the drop-down list below the “Subitem of” field, select Fitting.

7 In the Description field, type Plastering and skimming.

8 In the Rate field, type 70.

9 In the Sales VAT Code field, select S from the drop-down list.

10 Next, assign this item to a Grangeworth Kitchens income account. In the Account 
field, select Labour:Fitting from the drop-down list.

Your screen should look like this:

11 Click OK to add the new item to Grangeworth Kitchens’s Item list.
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Now that the new item is on the Item list, Grangeworth Kitchens can invoice for 
plastering separately from their general fitting work. It can also create sales reports 
that show sales for fitting separately from sales for plastering.
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Lesson objectives
� To learn how to record customer payments in QuickBooks

� To learn how to handle customer discounts, partial payments, overpayments, or 
down payments

� To see how to record a deposit in QuickBooks, and learn how QuickBooks treats 
the deposit behind the scenes

� To learn how to enter cash back from a deposit in QuickBooks

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 7.qbw in 
the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Recording customer payments

If you’re receiving payment at the time of a sale, and you fill in a cash sales receipt, 
QuickBooks records a customer payment. When you invoice a customer, and you 
receive payment later, you enter the payment in the QuickBooks Receive Payments 
window.

The Receive Payments window lets you match up payments you receive with invoices 
you’ve written. You’ll be working with the Receive Payments window in this lesson.
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If you’re signed up to the QuickBooks Card Solutions you can receive a credit or debit 
card payment that a customer has made direct or online, or you can create a sales 
receipt for the credit/debit card payment.

Recording a payment in full

The simplest case is when a customer has one outstanding invoice and sends you a 
payment for the full amount. Suppose that Grangeworth Kitchens receives a cheque 
for £376.00 from Franklin Guest House. Here’s how you’d enter the payment:

To record a payment in full:
1 From the Customers menu, choose Receive Payments.

QuickBooks displays the Receive Payments window.

Your first step is to enter the name of the customer from whom you’ve received a 
payment.

2 In the Received from field, select Franklin Guest House:Private Dining Room from 
the drop-down list.

QuickBooks displays details of the outstanding invoice for Franklin Guest House 
in the Applied To fields.

Note: If you’re tracking individual jobs, make sure to select the job name from 
the Customer list. If you select only the customer’s name and not the job, 
QuickBooks won’t apply your payment to the job you want to track.

3 In the Amount field, type 376.00 and press Tab.

QuickBooks applies the payment to the one outstanding invoice.

4 In the Pmt. Method field, select Cheque from the drop-down list.

5 In the Cheque No. field, type 6745.
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6 Click “Group with other undeposited funds” if it is not selected already.

7 Click Save & New.

This records the payment and clears the window so you can enter another one. A 
“PAID” stamp will appear on the invoice the next time it is retrieved.

Note: If you are signed up to QuickBooks Card Solutions and the payment 
method was by credit or debit card, an additional option is displayed at the 
bottom of the Receive Payments window to process online when saving:

When you saved the payment record, you could then process the credit or 
debit card immediately. You would need to record the cardholder’s name 
and card details before sending:
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Entering a partial payment

Grangeworth Kitchens has also received a cheque for £2,000.00 from Offa Kitchens, 
which owes £8920.60.

To enter a partial payment in the Receive Payments window:
1 In the Received from field, select Offa Kitchens from the drop-down list.

Under “Applied To”, QuickBooks shows you the invoices still outstanding for the 
customer. Next, you need to enter the amount of the payment.

2 In the Amount field, type 2000.00. Then press Tab.

QuickBooks automatically applies the payment:

If there is more than one outstanding invoice, QuickBooks applies the payment to 
the oldest one. If you wanted to apply a payment differently, you would click 
Clear Payments, type the amounts to apply to each invoice, and then press Tab.

3 Click “Group with other undeposited funds” if it is not selected already.

4 Click Save & New to record the partial payment and clear the window.

Entering overpayments

If a customer sends you an overpayment, you simply enter the amount in the Receive 
Payments window, and QuickBooks keeps track of the additional payment. When the 
customer has future invoices, you can apply the overpayment to those amounts.

Suppose that Grangeworth Kitchens has received a payment of £4,500.00 from 
Cranberry’s. The outstanding invoice for that job is £4099.20.



7–6

R e c e i v i n g  p a y m e n t s  a n d  m a k i n g  d e p o s i t s

To enter the payment:
1 In the Customer:Job field of the Receive Payments window, select Cranberry’s 

from the drop-down list.

QuickBooks displays the invoice details and an outstanding balance of £4099.20.

2 In the Amount field, type 4500.00 and press Tab.

QuickBooks shows an Unused Payment of £400.80. QuickBooks keeps track of the 
credit amount for you, and you can apply it to any future invoices for the 
customer. The next time you invoice Cranberry’s and receive a payment, the 
Receive Payments window will show £400.80 for Unused Credits. 

3 Click “Group with other undeposited funds” if it is not selected already.

4 Click Save & New.

5 When QuickBooks displays a message telling you that the customer will have a 
credit if you proceed, click OK.

Handling down payments or prepayments

If a customer makes a payment before you’ve invoiced them for services (for example, 
as a down payment or retainer fee), you can still record the payment at the Receive 
Payments window. However, because you don’t have any invoices to which to apply 
the payment, QuickBooks records the payment as an Unused Credit (just like an 
overpayment).

QuickBooks holds the unapplied amount with the customer’s name. The next time 
you enter that customer in the Receive Payments window, QuickBooks displays the 
credit amount in the Unused Credits field. The customer’s balance also reflects the 
credit amount.
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Suppose Elizabeth Allen wants Grangeworth Kitchens to supply two oak dressers. She’s 
sent a cheque for £400 as a down payment, but Grangeworth hasn’t invoiced her yet.

To enter the down payment:
1 In the Received from field, select Elizabeth Allen from the drop-down list.

2 In the Amount field, type 400.00. Then press Tab.

QuickBooks displays the amount as an Unused Payment.

3 Click “Group with other undeposited funds” if it is not selected already.

4 Click Save & Close.

5 When QuickBooks displays a message telling you that the customer will have a 
credit if you proceed, click OK.

A few days later, Grangeworth Kitchens is ready to prepare invoices. They need to 
invoice Elizabeth Allen for the dressers.

To create an invoice for the customer who made a down payment:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window.

2 In the Customer:Job field, select Elizabeth Allen from the drop-down list.

3 In the Quantity field, type 2.

4 In the Item field, select Dressers:Oak Welsh dresser from the drop-down list

5 Click Save & Close to record the invoice and close the Create Invoices window.

Now you can see how QuickBooks applies the payment Elizabeth Allen made earlier.

Applying customer credits

So far you’ve dealt with two types of customer credits (an overpayment and a down 
payment). Next, you’ll see how QuickBooks applies an unused credit to an invoice.

You’ll apply the down payment by Elizabeth Allen to the invoice you just created.
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To apply the down payment:
1 From the Customers menu, choose Receive Payments.

2 In the Customer:Job field, select Elizabeth Allen from the drop-down list.

QuickBooks shows an Unused Credit of £400.00.

3 Highlight (don’t tick) the invoice for £940.00 that you just created:

4 Click the Set Credits button to display the Credits window.

The full amount of the credit appears in the Amt To Use column. You can change 
this amount if you don’t want to use the entire credit. 

5 Click the Done button.

6 Click Save & New to record the payment.

7 Now click Previous until this payment is redisplayed.
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QuickBooks has applied the existing credit to the new invoice:

8 Close the Receive Payments window.

Entering and applying credit memos

If a customer has returned goods or cancels their order, you’ll need to enter a credit 
memo and then apply it to the original invoice to reduce the balance owing. (If you 
have Pro or above and are signed up to QuickBooks Card Solutions, and the original 
payment was by credit or debit card, you also have the option to go online and make 
a credit to the customer’s credit or debit card.)

Suppose Elizabeth Allen cancels her order for the dressers. You need to create a credit 
memo, write a refund cheque for the down payment, and apply the credit memo to 
the invoice. 

Note: Since Mrs. Allen’s cheque hasn’t yet been deposited, you could simply 
return it, but for this exercise you’ll write a refund cheque.

To enter a credit memo:
1 From the Customers menu, choose Create Credit Memos/Refunds.

QuickBooks displays the Credit Memos/Refunds window:

2 In the Customer:Job field, select Elizabeth Allen from the drop-down list.
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3 In the Item field, select Dressers:Oak Welsh dresser from the drop-down list.

4 In the Qty field, type 2 and press Tab.

The window should look like this:

5 Click on the Cheque Refund button.

QuickBooks displays the Write Cheques window with the full amount of the credit 
(£940.00) already filled in. Since you only need to refund the amount of her down 
payment (£400.00), you need to amend the details.

6 Change the cheque number to 1200, and the amount to 400.00 and press Tab.

The refund cheque should look like this:
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7 Click Save & Close.

QuickBooks returns to the Credit Memos/Refunds window.

8 Click Save & Close.

Now you need to apply the remaining £540.00 from the credit memo to the 
invoice.

9 From the Customers menu, select Receive Payments.

QuickBooks displays the Receive Payments window.

10 In the Received From field, select Elizabeth Allen from the drop-down list.

The window now shows the £540.00 still due on the invoice:

11 Highlight (don’t tick) the invoice line and click the Set Credits button.

QuickBooks displays the Credits window.

12 Click Done

QuickBooks redisplays the Receive Payments window, now showing £540.00 in 
the Credits column.

13 Click Save & Close to apply the credit.

Applying credits to specific invoices

Normally, if the customer has more than one outstanding invoice, QuickBooks applies 
the credit to the oldest invoice first. However, you can choose to apply any credit to 
any invoice, or distribute a credit across multiple invoices, using the same general 
procedure as for the down payment.

For further information, see “Applying customer credits to specific invoices” in the 
Quick Books User Guide.
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Making deposits

When you use the Enter Sales Receipts window (for a sales receipt where you receive 
payment on the spot, for example for a cash sale), the Receive Payments window (for 
payments on invoices), or a payment item on an invoice, QuickBooks keeps track of 
the money you’ve received until you deposit it in the bank.

Selecting payments to deposit

At your office, you might hold payments in a locked cash drawer until you can get to 
the bank; QuickBooks holds them in an asset account called Undeposited Funds. 
When you’re ready to take your payments to the bank, you can record the deposit in 
QuickBooks, print a deposit slip to bring with you, and enter cash-back amounts.

To select payments to deposit:
1 From the Banking menu, choose Make Deposits.

QuickBooks displays the Payments to Deposit window, which lists the payments 
you have not yet deposited. Notice that you can filter the list by the type of 
payment, which could be useful for example if you deposit cash in one account 
and cheques in another.

2 Click the payments you want to bring to the bank.

For this exercise, select three of the payments you recorded in this lesson (for Offa 
Kitchens, Franklin Guest House, and Cranberry’s):
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3 Click OK.

QuickBooks displays the Make Deposits window:

The detail area shows the payments you just selected. If you have money to 
deposit that was not received for a sale (for example, an insurance premium 
refund), you would enter it here as well.

4 In the Deposit To field, select Master Bank Current (if not shown) as the account 
in which you want the money deposited.

QuickBooks shows the deposit total at the bottom of the window. If you wanted 
to print a deposit slip to take to the bank, you could click Print. 

5 Click Save & Close to record the deposit.
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How QuickBooks handles the deposit

QuickBooks updates your Undeposited Funds account to show that you’ve made a 
deposit, and it also adds the deposit to your bank account register.

To view the Undeposited Funds account:
1 From the Company menu, choose Chart of Accounts.

2 In the chart of accounts, double-click the Undeposited Funds account.

QuickBooks displays your deposits and reduces the balance in the account by the 
amount of the deposits (you may need to scroll up to see them).

Now you can look at the deposit transaction in the Master Bank Current account.

3 In the chart of accounts, double-click the Master Bank Current account.

QuickBooks has entered the deposit as a transaction in the Master Bank Current 
account register and has updated the balance:

4 Close the register windows and the chart of accounts.
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Getting cash back from a deposit

When you are recording the deposit in the Make Deposits window, you can enter 
information about any cash you took out of the deposit

To record cash back from a deposit:
1 From the Banking menu, choose Make Deposits.

QuickBooks displays the Payments to Deposit window. Notice that the deposits 
you made in the last exercise are no longer listed.

2 Select the £400.00 payment from Elizabeth Allen:

3 Click OK to display the Make Deposits window.

4 Type Float in the “Cash back goes to” field and press Tab.

5 When QuickBooks tells you that Float is not on the account list, click Set Up.

QuickBooks displays the New Account window with Type shown as Bank and 
Name preset to Float:
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6 Click OK to return to the Make Deposits window. (If you see a message about 
preprinted cheques, click No.)

7 In the Cash back amount field, type 60.00 and press Tab.

QuickBooks displays the Deposit Subtotal amount (£400.00) and the Deposit Total 
(the subtotal less the cash back amount: £340.00).

8 Click Save & Close.
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QuickBooks records the Deposit Total amount in the Master Bank Current 
account, and the cash back amount in the Float account:
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Lesson objectives
� To discuss the different ways you can handle your bills in QuickBooks

� To learn how to enter a bill in QuickBooks

� To use the Pay Bills window to pay a bill in QuickBooks

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it. Follow these steps to restore the lesson file to 
its original state so that the data in the file matches what you see on the screen as you 
proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 8.qbw in 
the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Handling bills in QuickBooks

When you have a business expense, you can handle it in one of the following ways: 

� Write a cheque manually and enter the information into a QuickBooks cheque 
register later. This doesn’t take best advantage of QuickBooks, but sometimes it’s 
necessary. For example, if you purchase supplies at a retail store, they expect 
payment on the spot, and you may not know the amount in advance.

� Use QuickBooks to write and print a cheque. When you receive a bill for which 
you want to make immediate payment, you can write a QuickBooks cheque more 
quickly and accurately than you can by hand, and QuickBooks makes the entry in 
your current account register for you.

� Use QuickBooks accounts payable to track your cash flow needs, the amounts you 
owe to suppliers and bills you want to pay later.

� Pay by credit card and enter the credit card receipt into QuickBooks later.
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In Lesson 4, you learned how to enter handwritten cheques, QuickBooks cheques, and 
credit card payments. This lesson shows you how to use QuickBooks for accounts 
payable. Using accounts payable involves two steps: entering the bill and paying the 
bill. You’ll practice both in this lesson.

Using QuickBooks for accounts payable

Some business owners, especially if they own smaller, home-based businesses, pay 
their bills when they receive them. Most business owners, however, find it more 
convenient to pay bills less often. (They also like keeping the cash in the company for 
as long as possible.) If you don’t plan to pay your bills right away, QuickBooks can 
help you keep track of what you owe and when you owe it.

The money you owe for unpaid bills is called your accounts payable. QuickBooks uses 
the Accounts Payable account to track all the money you owe. Like any QuickBooks 
balance sheet account, the Accounts Payable account has a register where you can 
view all your bills at once.

To see the Accounts Payable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 Double-click Accounts Payable in the list to open the register.

QuickBooks displays the Accounts Payable register.

The register keeps track of each bill you have entered, shows you the due date, and 
keeps a running balance of all the bills you owe. This helps you forecast your cash 
flow, and the QuickBooks reminder system helps you pay your bills on time.

3 From the Window menu, choose Close All to close all open QuickBooks windows.
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Entering bills

When you receive a bill from a supplier, you should enter it into QuickBooks as soon 
as you can. This keeps your cash flow forecast reports up to date and doesn’t give you 
the chance to set aside a bill and forget about it.

Grangeworth Kitchens has just received a bill from the company that created their 
new brochures. The bill includes a charge for courier delivery. Grangeworth Kitchens 
doesn’t plan to pay the bill until close to its due date, but the company wants to keep 
an eye on the accounts payable total, so it enters the bill now.

To enter a bill:
1 From the Suppliers menu, choose Enter Bills (not Enter Bills for Received Items).

QuickBooks displays the Enter Bills window:

The top half of the window is where you enter the bill. The bottom half is the 
detail area where you can assign the bill amount to different expense accounts, 
customers, or jobs.

Notice that the Bill Received box has a tick. The only time the Bill Received tick 
box should be cleared is if you’re using QuickBooks for stock and you want to 
record items you’ve received that you haven’t actually been billed for yet.

2 In the Supplier field, type Willis Advertising, and then press Tab.

3 When QuickBooks displays a message telling you that Willis Advertising is not on 
the Supplier list, click Quick Add.

4 In the Date field, type 31/03/2003.

5 In the Amount Due field, type 1200.00.
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6 Click in the Bill Due field.

Notice that QuickBooks supplies a date for you in the Bill Due field. The date 
displayed is ten days from the date in the Date field. You can change the date if 
you wish. If your Supplier list had payment terms entered for this supplier, 
QuickBooks would have used those terms to calculate the bill’s due date. 

For this exercise, change the date to 31/03/2003.

7 Click in the Account column on the Expenses tab and start to type Printing.

QuickFill completes the entry for you, and displays Printing and Reproduction as 
the account. QuickBooks lets you assign transactions to more than one account, 
so you can keep close track of where your company spends its money. Grange-
worth Kitchens wants to assign most of this bill to the Printing and Reproduction 
expense account, and the rest to the Freight & Delivery expense account.

8 Press Tab to accept Printing and Reproduction as the account.

9 Press Tab to accept S (standard) as the VAT code.

QuickBooks automatically splits out the VAT.

10 Highlight the Net Amt figure of 1,021.28 and overtype 1000.00.

11 Click in the Account column below Printing and Reproduction.

The remainder of the bill (£25.00) appears on the second line.

12 From the drop-down list, choose Freight & Delivery.

QuickBooks automatically recalculates VAT for both lines and assigns the net 
amount remaining (£21.28) to Freight & Delivery, with £3.72 to VAT.

Your screen should now resemble this one:

13 Click Save & Close to record the bill.
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Memorising bills

If you have regular bills for the same amount from a supplier, QuickBooks lets you set 
up a memorised bill so you don’t have to keep entering the same information.

Suppose that Grangeworth Kitchens has set up a standing order with the bank to pay 
the rent every month, having previously paid by cheque.

To enter a memorised bill:
1 From the Suppliers menu, choose Enter Bills.

QuickBooks displays the Enter Bills window.

2 Click Previous several times until you see the last bill for Chiltern Properties, dated 
03/03/2003:

3 From the Edit menu, choose Memorise Bill.

QuickBooks displays the Memorise Transaction dialog box.

4 In the Name field, type Rent after “Chiltern Properties”.

5 Click Standing Order.

6 In the How Often field, select Monthly from the drop-down list.

7 For Next Date, type 03/04/2003.

8 In the Number Remaining field, type 23 (there is to be a rent review in April 2005).

9 For Days in Advance to Enter, type 2.
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Your screen should look like this:

10 Click OK to record the memorised bill.

QuickBooks adds the bill to the Memorised Transactions list. When you start 
QuickBooks on 1 April (two days before the bill is due), it will display a message 
that the standing order is due:

If you then click Now, QuickBooks records the standing order in the current 
account register. This will happen on the first of every month until March 2005.

Paying bills

When you start QuickBooks or open a QuickBooks company, a Reminders list appears 
on the Company Navigator that tells you if you have transactions to complete, such 
as bills to pay or money to deposit. When QuickBooks tells you that you have bills 
due, you can open the Pay Bills window and select the bills you want to pay. 

Tip: If you don’t see the Reminders list when you start QuickBooks, enable it by 
choosing Preferences from the Edit menu. Click Reminders, click the 
My Preferences tab, and select “Show Reminders List when opening a Company 
file.”
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To pay a bill:
1 From the Suppliers menu, choose Pay Bills.

QuickBooks displays the Pay Bills window.

The Pay Bills window shows your unpaid bills as of any date you enter. For this 
exercise, type 31/03/2003.

You can select which bills you want to pay, whether by printed or handwritten 
cheque, debit card, or credit card. For this exercise, you’ll pay using a QuickBooks 
cheque.

2 Under Payment Method, select “To be printed”. 

For other payment methods, you would select “Assign cheque no.” and enter the 
handwritten cheque number, debit card or direct debit reference when prompted. 
If you have QuickBooks Pro or above you can also make a BACS payment, which 
you’ll see in a later exercise.

3 Select the Willis Advertising bill by clicking in the tick column.

QuickBooks displays a tick next to the bill and changes the amount in the Ending 
Bank Balance to reflect a payment of £1,200.00. If you want to make a partial 
payment, you can enter the amount you want to pay in the Amt. To Pay field.
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Your screen should resemble this one:

4 Click Pay & Close.

How QuickBooks records your bill payment

When you pay the bill through the Pay Bills window, QuickBooks makes an entry in 
the Accounts Payable register, showing a decrease of £1,200 in the total payables. It 
also creates a cheque from your current account to pay the bill.

To see the entry in the accounts payable register:
1 From the Company menu, choose Chart of Accounts.

QuickBooks displays the chart of accounts.

2 In the chart of accounts, double-click the Accounts Payable account.

QuickBooks displays the Accounts Payable register.

The register now shows the bill payment to Willis Advertising.

3 Close the Accounts Payable register.
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At the same time QuickBooks recorded the entry in your Accounts Payable register, it 
made an entry in your current account.

To see the entry in the current account register:
1 In the chart of accounts, double-click Master Bank Current account.

QuickBooks displays the current account register.

Notice the cheque to print for the payment to Willis Advertising.

2 Select the Willis Advertising transaction.

QuickBooks highlights the Willis transaction to show that it is selected.

3 On the toolbar, click Edit Transaction.

QuickBooks displays the Bill Payments (Cheque) window.

This cheque is called a Bill Payment Cheque and differs from the cheque form that 
you use to enter cheques directly into the current account. (That form shows 
expenses directly on the cheque voucher portion, while the bill payment form 
shows the bills paid by the cheque.)
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Printing cheques and remittances

If you’ve paid by printable cheque, you need to print off the cheques and remittances 
to send to the suppliers. When you print cheques, you have a choice of styles:

� Standard – prints only cheques, so you would need to print a separate remittance 
advice

� Voucher – prints a cheque with remittance advice attached.

If you’ve paid by another method – for example, handwritten cheque, debit card, 
direct debit, BACS – you may need to print a separate remittance advice.

For this exercise, you’ll print the cheque and remittance advice separately.

To print a cheque:
1 If you were printing onto preprinted cheque forms, you would make sure they 

were loaded into the printer. For this exercise, you can just print onto blank paper.

2 From the File menu, choose Print Forms, then choose Cheques.

3 Change the dates from 31/03/2003 to 31/03/2003. 

At this point you would select which cheques you wanted to print. In this example 
there is only one, and it is already selected.

You need make sure the number shown for First Cheque was set to match the first 
cheque number. Suppose the first cheque number in your batch was 000231.

4 In the First Cheque field, type 231.

5 Click OK.

QuickBooks displays the Print Cheques window.
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Here you can switch between Standard and Voucher cheque styles, and if you are 
using Standard style you can set the number of cheques left on the first page if you 
are printing a partial page. For now, leave the settings as they are.

6 Click Print.

To print a remittance advice:
1 From the File menu, choose Print Forms, then choose Remittance Advice.

2 Change the dates from 31/03/2003 to 31/03/2003. 

At this point you would select which remittance advices you wanted to print. In 
this example there is only one, and it is already selected.

3 Click OK, and print the remittance advice.

4 From the Window menu, choose Close All to close all the open QuickBooks 
windows.
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Paying bills through e-Payments Solutions (Pro and above)

You can subscribe to QuickBooks’ e-Payment Solutions to make a BACS payment 
through an online BACS agent. In order for this to work, you would need to apply to 
your bank for a BACSTEL-IP. You would also need Internet access.

For the following exercises, you will see how to set up the details in QuickBooks for 
paying suppliers through e-Payment Solutions.

You then will see how to make a payment using e-Payment Solutions.

To set up banking preferences to use BACS for e-Payment Solutions:
1 From the Edit menu, choose Preferences.

2 Select Banking, and click the Company Preferences tab.

3 Tick the boxes next to “Create BACS output files” and “I am signed up for e-
Payment Solutions”.

Note: If you tick the e-Payment Solutions box, the file will be encrypted ready for 
submission using the QuickBooks e-Payment Solutions. If you use another 
system to submit files directly, you would not tick the second box. The file 
would not be encrypted, and you would use your existing system to 
encrypt and submit it.

4 Click BACS User Number.

QuickBooks displays the Company BACS Details window.

5 Type 123456 then click OK.

Note: This number must always be 6 digits.

6 Click OK.
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7 For Non-Payroll export file location, type c:\qbtrain, or click Browse and select your 
training folder.

This is the location where your encrypted BACS files will be stored.

Type the same location for output files for Payroll export files.

Your screen should resemble this:

8 Click OK.

Next, you need to set up the BACS details in your bank account.

To set up BACS details in your bank account:
1 From the Lists menu, choose Chart of Accounts.

2 Select Master Bank Current.

3 Click the Account menu button, and choose Edit.

4 Click the BACS Information tab.

5 Complete the BACS details as follows:

Account Name: BACS E-Payments

Sort Code: 01-02-03

Account Number: 12345678

Your screen should resemble this:
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6 Click OK.

If you see a message about preprinted cheques, click No.

The next stage is to set up suppliers to enable them to be paid by BACS. In this exercise 
you will do this for just one employee, but in practice you would need to do this for 
all suppliers that you want to pay by this method. 

You can use BACS only for UK suppliers (or for foreign suppliers with UK bank 
accounts into which you can pay in UK sterling). The supplier needs to provide you 
with details of the bank account into which they want you to pay. If they want you 
to notify them by fax or email that you have made the payment, they will need to 
provide these details as well.

To set up suppliers to be paid by BACS:
1 From the Suppliers menu, choose Suppliers List.

2 Select Chester Ltd from the list.

3 Click the Supplier menu button, and choose Edit.

4 On the Address Info tab, for E-mail type accounts@chester.co.uk.

5 Click the BACS Information tab.

6 Complete the supplier’s bank details as follows:

Account Name: Chester Ltd

Sort Code: 10-20-30

Account Number: 87654321

Your screen should resemble this:
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7 Click OK.

You are now ready to pay your supplier.

To pay a supplier through e-Payments Solutions:
1 From the Suppliers menu, choose Pay Bills.

QuickBooks displays the Pay Bills window.

2 Select the Chester Ltd bill dated 09/03/2003 for 2655.50.

Note: You could select more than one bill and pay them in a batch.

3 For Payment Account, choose Master Bank Current (if it is not shown already) 
since this is the account for which you set up BACS payment details.

4 For Payment Method, choose BACS from the drop-down list.

Your screen should resemble this:
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5 Click Pay & Close.

At this stage QuickBooks produces an encrypted BACS payment file for each 
supplier in this batch, in this example one file for the payment to Chester Ltd. The 
filename starts QBOut-, and has the suffix .bacs. It is saved in the folder you 
specified earlier, in this case qbtrain.

6 Click OK.

7 Close the Suppliers List.

QuickBooks has also produced a BACS Bill Payment Cheque. You’ll now review 
the cheque.

8 From the Banking menu, choose Write Cheques.

9 Click the Back button until you see the BACS Payment to Chester Ltd:

The next stage would be to make the electronic payment using the encrypted file. To 
do this, you would carry out the following steps:

1 Go to the Supplier Navigator, and choose Process BACS Payments online using 
e-Payment Solutions. 

2 Log in to the payment services page.

3 Select the relevant file to transmit (in this example QBOut-310320030000.bacs), 
and click Upload File. 

A summary message would appear when transmission was complete. 
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You can then notify your supplier that you have made payment. You can use an 
additional e-Payment Solutions service so that they send remittance advices by email 
or fax. 

Otherwise you can print the remittance advice and send it by fax or post.
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Lesson objectives
� To discuss some of the tools QuickBooks gives you for analysing financial data: 

QuickReports, preset reports, graphs, and centres

� To create a QuickReport

� To learn about the types of preset reports QuickBooks offers

� To practice creating reports and viewing them onscreen

� To customise a report by changing how it looks and the data it covers (filtering)

� To learn how to export a report to Microsoft Excel

� To learn about the types of graphs QuickBooks offers

� To create and customise several graphs

� To learn to use QuickBooks Centres

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 9.qbw in 
the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.
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Reports and graphs help you understand your 
business

So far, you’ve been learning all the ways to track your data in QuickBooks. In this 
lesson, you’ll work with two of the most valuable tools in QuickBooks: reports and 
graphs. The insight they give you into your finances is one of the most important 
benefits of tracking your data in QuickBooks.

Often, perceptions of business profitability don’t match the facts. If you enter your 
data in QuickBooks, but don’t take the time to analyse the data, your business 
decisions are based on incomplete knowledge. Reports let you summarise your 
financial data so you make decisions based on analysis of the numbers.

Reports give you the “bottom line”—you can see exactly how profitable your business 
is. If it’s not doing as well as you’d hoped, you can create reports that show you which 
areas need improvement. QuickBooks has dozens of preset reports, but if you have 
specific reporting needs, you can customise any QuickBooks report to show exactly 
the data you want. And if you’re interested in getting quick information, you can use 
a QuickReport that lets you summarise information from your lists, forms, or registers 
with one click of a button.

Some people find it easier to see a visual picture of their financial data. If you’re 
interested in learning more about trends or patterns in your business data (for 
example, what proportion of your income comes from consulting services as 
compared to product sales), QuickBooks offers six types of QuickInsight graphs.

Creating QuickReports

One of the fastest ways to see a report on your QuickBooks data is to create a 
QuickReport. QuickReports are pre-designed reports that give you information about 
the items you’re currently viewing onscreen. Whenever you have a list, a register, or a 
form displayed, you can click a button to have QuickBooks create a QuickReport.

When to use a QuickReport

Suppose you’re viewing the Supplier list, and you want to see a history of all 
transactions for a certain supplier. Select the supplier’s name, click the Report menu 
button, and then select QuickReport. You’ll see a report listing information about each 
bill for that supplier.

In this exercise, Grangeworth Kitchens wants to see what it owes to Chester Ltd.
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To see what you owe a supplier:
1 From the Lists menu, choose Supplier List.

QuickBooks displays the Supplier list.

2 Highlight Chester Ltd..

3 Click the Reports menu button and choose QuickReport:Chester Ltd.

4 In the From and To fields, type 01/02/2003 and 28/02/2003, and click Refresh.

This QuickReport is displayed:

A supplier QuickReport shows all transactions for this month for the selected 
supplier, Chester Ltd. The transactions can include purchase orders, item receipts, 
bills, bill payments, and credits received from the supplier.

Tip: If you want to see only unpaid bills and unapplied credits for the selected 
supplier, select Open Balance instead of QuickReport in step 3.

Zooming in on a QuickReport

All QuickReports contain a summary of individual transactions. To help you better 
understand the information presented in reports, QuickBooks lets you trace report 
data to the individual transaction level using QuickZoom.

When you position the mouse pointer over a number in a report and you see the 
QuickZoom symbol (a magnifying glass with a Z in it), you can double-click the 
number to display the original transaction in QuickBooks.

Suppose you want more detail about the bill shown in the report. 
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To see more detail about an item:
1 Position the mouse pointer over the bill dated 20/02/2003.

The arrow pointer turns into a magnifying glass with the letter Z (Z for zoom).

2 Double-click the bill.

QuickBooks displays the Enter Bills window for the selected transaction:

3 Close the window.

QuickBooks returns you to the QuickReport.

Customising QuickReports

Each QuickReport window has a buttonbar at the top of the report for customising 
report content and layout.

In this exercise, you’ll customise the QuickReport you just created to display 
transaction numbers on the report.
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To add a column to a QuickReport:
1 In the QuickReport window, click Modify Report.

QuickBooks displays the Modify Report window.

The Display tab lets you select the columns and date range to include in the report.

2 In the Columns list, select Trans no.

QuickBooks displays a tick next to Trans no.

3 Click OK to display the customised Supplier QuickReport:

Notice that the bill dated 20/02/2003 is now listed as transaction 116.

Next, you’ll move the Trans no. column to a new position in the report.

To move a report column:
1 Position your mouse pointer over the Trans no. column that you added to the 

QuickReport (the mouse pointer changes to a hand).

2 Hold down the left mouse button and drag the Trans no. column to the right until 
you see an arrow between the Date Column and the Num column.
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3 Release the mouse button.

QuickBooks places the Trans no. column between the Date and Num columns:

Next, you’ll customise the report header.

To change information in the report heading:
1 In the QuickReport window, click Modify Report, and then click the 

Header/Footer tab.

On the Header/Footer tab, you can change the company name, report title, 
subtitle, and format for date and time prepared. You can also specify whether you 
want the header printed on all pages or on just the first page. The Header/Footer 
tab is the same for all QuickBooks reports.

Now change the report title from Supplier QuickReport to Supplier History Report.

2 In the Report Title field, select the text “Supplier QuickReport,” and overtype 
Supplier History Report as the new title.

3 Click OK to close the Modify Report window.
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QuickBooks changes the title of the report and redisplays it:

4 Close the report and Supplier List windows.

Creating and customising preset reports

In addition to QuickReports, QuickBooks has dozens of preset report formats. You can 
create profit and loss reports, balance sheet reports, accounts receivable reports, sales 
reports, accounts payable reports, stock reports, and many others.

To create a QuickBooks report, all you have to do is choose the type of report you want 
from the Reports menu, including:

� Company & Financial: include profit and loss statements, balance sheets and 
cash flows.

� Customers & Receivables: which invoices are due (or overdue) and how much 
each customer owes your company.

� Sales: what you have sold and to whom.

� Jobs, Time & Mileage: (QuickBooks Pro/Accountant only) the status and profit-
ability of the jobs and projects you track in QuickBooks.

� Suppliers & Payables: which bills are due and current balances with each supplier.

� Purchases: what you have bought and from whom.

� Stock: values and quantities of stock you have on hand or on order.

� Employees & Payroll: what you need to pay your employees, meet current payroll 
liabilities and fill in your P11 and P35 tax forms (only if Payroll is turned on).

� Banking: deposit detail, cheque detail, and missing cheques.

� Accountant & Taxes: income tax summary and detail, general ledger, trial 
balance, journal, transaction journal, and audit trail.

� Budgets (& Forecasts): how your income and expenses compare to the budgets 
you have set up, and (QuickBooks Accountant only) compare to forecasts.

� List: information stored in QuickBooks lists.

� VAT: keep track of your VAT liability.



                                                                                                

9–9

L E S S O N  9

Creating a balance sheet report

The balance sheet report summarises assets and liabilities to show equity.

To create a balance sheet report:
1 From the Reports menu, choose Company & Financial, then Balance Sheet 

Standard.

The report on your screen should look like this:

2 Scroll the report window to see more of the report.

Notice that the button bar in this window is the same as for the QuickReport.

3 Keep the report displayed on your screen. You’ll use it in the next exercise.

Filtering reports

You can customise preset reports the same way you customise QuickReports. In this 
exercise you’ll customise the balance sheet comparison report and “filter” it to include 
only the transactions you specify.
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To filter a preset report:
1 With the balance sheet report displayed, click Modify Report on the report 

buttonbar, and then click Filters.

QuickBooks displays the Filters tab of the Modify Report window:

The Filters tab lets you set custom criteria for the transactions you want included 
in the report. QuickBooks includes only those transactions that match the rules 
you create.

Suppose you want to filter uncleared transactions out of the balance sheet. 

2 In the Filter scroll box, select Cleared.

Notice that QuickBooks provides a description of the selected filter below the 
filters list. To find out more about applying a particular filter, click Tell me more.

3 Under Cleared, click Yes.

4 Click OK.

QuickBooks displays the customised balance sheet report:
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If you scroll down to the bottom of the report, you’ll see that the figures have 
changed since QuickBooks removed uncleared transactions from the report.

5 Close the report window.

Creating and customising a sales report

In this exercise you’ll create a QuickBooks sales report. Then you can customise it by 
changing the date range it covers.

To create a custom sales report:
1 From the Reports menu, choose Sales, then Sales By Customer Summary.

QuickBooks displays the Sales by Customer Summary report:

The Dates field in the buttonbar shows that the report covers “This Month-to-
date.” Customise the report to show sales figures from the company start date.
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2 In the Dates field, choose All from the top of the drop-down list.

QuickBooks updates the report and displays the new data:

Using QuickZoom in a preset report

As with most QuickBooks reports, you can QuickZoom on any item in the report to 
see more detail.

Note: QuickZoom is not available on cash-basis reports.

To QuickZoom on a report item:
1 Position the mouse pointer over the £12,208.00—the amount for Cranberry’s.

The cursor turns into a magnifying glass with a Z in it.

2 Double-click on the £12,208.00.

QuickBooks displays a Sales by Customer Detail report for Cranberry’s:
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To QuickZoom to the original invoice for a transaction:
1 Double-click anywhere in the first line of the report (invoice 4 dated 14/10/2003). 

QuickBooks displays Invoice 4 for Cranberry’s:

2 Close the Create Invoices window.

3 Close the Sales by Customer Detail report window.

4 Keep the Sales by Customer Summary report on your screen for the next exercise.

What you see when you use QuickZoom in a report depends on the type of report you 
have displayed:

� If the report shows summary figures (like the sales by customer summary report 
we just displayed), and you QuickZoom an amount, QuickBooks displays a trans-
action report that includes the transactions which comprise that amount.

� If the report shows transactions, and you QuickZoom a transaction, QuickBooks 
displays the invoice, bill, or other form for the requested transaction.
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Saving report settings

After you have customised a report to provide the information you need, you can have 
QuickBooks memorise the settings so you can quickly produce the same report in the 
future. (QuickBooks memorises a report’s settings, not the actual data.)

Creating memorised report groups

In addition to saving report settings, you can create memorised report groups that you 
can use to organise your memorised reports in a way that makes sense for your 
business and to allow you to quickly process a group of reports at once. 

QuickBooks comes preset with a number of memorised report groups each containing 
common reports for each area. You can add your own reports to these groups, modify 
the groups to meet your needs, and even create your own groups.

In this exercise, you’ll create a memorised group called “End of Year” to which you 
will add some memorised reports. Later, you’ll learn how you can batch process 
memorised reports.

To create a memorised report group:
1 Choose Memorised Reports from the Reports menu, then choose Memorised 

Report List.

QuickBooks opens the Memorised Report list:

2 Click the Memorised Report menu button and choose New Group.

QuickBooks opens the New Memorised Report Group dialog box.

3 In the Name field, type End of Year.
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The dialog box should look like this.

4 Click OK.

QuickBooks adds the new group to the Memorised Report list.

Memorising preset reports

Now, you’ll memorise a report and it to the memorised report group you just created.

To memorise a report:
1 Redisplay the customised Sales by Customer Summary report.

2 On the report buttonbar, click Memorise.

QuickBooks displays the Memorise Report dialog box:

3 Leave the name of the report as is.

4 Click the “Save in Memorised Report Group” box to select it, and then choose End 
of Year from the drop-down list.

The dialog box should look like this:

5 Click OK to memorise the report and add it to the End of Year memorised report 
group.

6 Close the report.

Adding reports to memorised report groups

Now, you’ll add two previously memorised reports to the End Of Year group.

To add memorised reports to a memorised report group:
1 In the Memorised Report List window, select the Profit & Loss report.

2 Click the Memorised Report menu button, then choose Edit.

QuickBooks opens the Edit Memorised Report window.
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3 Leave the report name as is.

4 Choose End of Year from the drop-down list.

5 Click OK.

QuickBooks moves the Profit & Loss report to the End of Year report group:

6 In the Memorised Report List window, select the Unpaid Bills Detail report.

7 Click the Memorised Report menu button, and then choose Edit.

8 Leave the report name as is.

9 Choose End Of Year from the drop-down list.

10 Click OK.

The End Of Year group in the Memorised Report List window now shows all three 
reports you’ve added:

Once a report is memorised, you can easily display it from the QuickBooks Memorised 
Report list.

To display a memorised report:
1 In the Memorised Report list, select Sales by Customer Summary.

2 Click Display.

QuickBooks displays the report.

3 Leave the report open.
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Printing reports

Any time you have a report displayed in the report window, you can print it by 
clicking the Print button in the report buttonbar.

To print a report:
1 With the Sales by Customer Summary report displayed, click Print.

QuickBooks displays the Print Reports window.

You can see how your report will look by clicking the Preview button.

2 Click Preview.

QuickBooks displays a preview of your report onscreen.

3 Click Close to close the Print Preview window.

4 Close the Print Report window, and then close the report window.

Processing reports in groups

Organizing your memorised reports in groups makes it fast and easy to process several 
reports at once. Now, you’ll process the reports you added to the End Of Year report 
group created in the previous exercise.

To batch process reports:
1 In the Memorised Report list, select End of Year.

2 Click Display.
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QuickBooks opens the Process Multiple Reports window, which you can use to 
display or print the selected reports. You can also change the date range for reports 
before you display or print them by clicking in the From or To columns.

3 Leave all three reports selected and click Display.

QuickBooks opens the three reports in the End Year group.

4 From the Window menu, choose Close All.

Exporting reports to Microsoft Excel or a CSV 
file

Occasionally, you may want to change a report’s appearance or contents, or filter the 
data, or run “what if” scenarios on your data in ways that you cannot in QuickBooks.

You can send your QuickBooks reports to Microsoft Excel or to a comma-separated 
values (CSV) file to use in another spreadsheet. Since the changes you make in your 
spreadsheet do not affect your QuickBooks data, you are free to customise reports as 
needed, and even change data to run “what if” scenarios.

Note: To export to Excel, you need Microsoft Excel 97 or higher (Excel 2000 
illustrated). If you don’t have this, you can export to a CSV file instead.

Sending a report to Microsoft Excel

When exporting a report to Microsoft Excel, you indicate whether or not you want to 
preserve the formatting from your QuickBooks report. You also have the option of 
turning on or off several Excel features from within QuickBooks.

By default, QuickBooks preserves the look of your report when exporting to Microsoft 
Excel, and turns on the following Excel features:

� AutoFit sets column widths in Excel wide enough to display your data without 
cutting off words or numbers.

� Freeze panes let you scroll through data and keep row and column headers visible.
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� Show Gridlines turns on gridlines in Excel.

In this exercise, you’ll learn how to preserve QuickBooks report formatting options in 
Excel, and how to control certain Excel features from within QuickBooks.

To send a report to Microsoft Excel:
1 From the Reports menu, choose Company & Financial, then Balance Sheet 

Standard.

2 On the Report buttonbar, click Modify Report.

QuickBooks displays the Modify Report window.

3 For Dates, type 01/03/2003 and 31/03/2003.

4 Under Columns, click the Previous Period, £ Change and % Change tick boxes.

Your screen should resemble this one:
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5 Click OK.

Your balance sheet should now look like this:

6 On the Report buttonbar, click Excel.

QuickBooks displays the Export Report window.

7 Click “a new Excel workbook.”

8 Tick the option “Include a new worksheet in the workbook that explains Excel 
worksheet linking”.
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9 Click Advanced.

QuickBooks displays the Export Report - Advanced options window.

10 Under Preserve formatting options, click the Colours tick box to clear it.

The title font will remain blue in QuickBooks, but display in black in Excel.

11 Under Turn on Excel features, select the Auto Filtering tick box.

Your screen should now resemble this one:

12 Click Export.
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QuickBooks starts Excel (if not open) and sends the report to a new spreadsheet, 
with the report displayed on the current worksheet, and an additional worksheet 
with tips about exporting and linking (you can review it at your convenience):

If you wanted to save the report, you would choose Save As from the Excel File 
menu. Leave the report open in Excel; you’ll use it in the next exercise.

Filtering a report in Microsoft Excel

Within Microsoft Excel, you can filter any column of data using a drop-down list at 
the top of the column. Using the drop-down list, you can apply a number of preset 
filters, or create your own custom filter.

In this exercise, you’ll filter the balance sheet report in order to find out if any of 
Grangeworth Kitchens’s account balances have decreased since the previous period.

To filter a report in Microsoft Excel:
1 In the Excel window, click the Down Arrow in the £ Change column of the 

balance sheet report, and choose (Custom...) from the drop-down list.

Excel displays the Custom AutoFilter dialog box:
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2 In the £ Change field, choose “is less than” from the drop-down list.

3 In the field to the right, type 0.

Your screen should resemble this one:

4 Click OK.

Excel filters the £ Change column for negative amounts and displays the results, 
which should look something like this:

5 Close Excel without saving the report and close the report in QuickBooks.
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Creating QuickInsight graphs

A report gives you numbers that are essential if you want to stay on top of your 
business’s finances. But when you want a visual picture to plan current or future 
business decisions, a graph is another invaluable tool.

A QuickInsight graph shows your data pictured as either a bar graph or a pie chart. 
These are simply different views of the same company financial information.

QuickBooks has six types of graphs, providing up to 15 different views of your data:

� Income and Expenses

� Sales

� Accounts Receivable

� Accounts Payable

� Net Worth

� Budget v Actual

To create a QuickInsight graph, select the type of graph you want from one of the 
report submenus.

Creating an Income and Expense graph

If you want your business to be profitable, you need to keep an eye on your expenses. 
The income and expense graph shows you exactly what you’re spending and where, 
relative to the income you receive. 

To create an income and expense graph:
1 From the Reports menu, choose Company & Financial, then Income & Expense 

Graph.

2 Click Dates, change the date range to 01/09/2002 to 31/03/2003, and click OK.

QuickBooks displays this graph:
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In the top portion of the graph window, QuickBooks displays a bar graph and 
legend showing total income and expenses. In the lower portion, QuickBooks 
displays a pie chart and legend showing expense percentages by account (ten 
accounts at a time). 

3 To display more accounts, click Next Group on the upper buttonbar in the graph 
window (the button is greyed-out if no other accounts were active in this period).
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Features of QuickInsight graphs

These features are common to all QuickInsight graphs:

� Every graph window, except for the Net Worth and the Budget vs Actual graphs, 
shows a bar graph in the top half of the window and a pie chart in the bottom half.

The bar graph usually shows totals. For example, the Income and Expense graph 
shows the total for income and the total for expenses in each month of the period.

The pie chart shows a breakdown of the information in the bar graph; each pie 
slice in the Income and Expense graph represents a type of income or expense. 
Next to the pie chart is a legend showing which income or expense accounts corre-
spond to which colours and what percentage of the pie each slice represents.

� Every graph window has a buttonbar you can use to customise the graph. For 
example, you can change the time period shown in the graph by clicking the Dates 
button. If you want the pie chart to show a breakdown by customer or class rather 
than a breakdown by account, just click By Customer or By Class.

� Just as you can use QuickZoom in a report to get more detail, you can use 
QuickZoom in a graph to see the numbers behind the picture. When you move 
the mouse pointer over a bar or pie slice, QuickBooks shows you the numbers it 
represents. When you zoom in on a pie slice, you can find out exactly how much 
you received or spent (in pounds) for each account.

Customising graph data

To display income accounts instead of expense accounts:
1 Click Income at the bottom of the graph window.

2 Click By Customer on the buttonbar.

QuickBooks changes the pie chart to display income by customers:
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Using QuickZoom with graphs

To help you better understand the information shown in the graphs, QuickBooks lets 
you trace graphical data using QuickZoom graphs.

To display the sales for Offa Kitchens:
1 Position the mouse pointer over the Offa Kitchens wedge in the pie chart.

Note: If a wedge is too small to click, click on its line in the legend instead.

The pointer changes to a magnifying glass with the letter Z inside.

2 Double-click the Offa Kitchens wedge.

QuickBooks displays a QuickZoom graph of sales by month for Offa Kitchens:

To display a report describing the transactions for a given month:
1 Position the mouse pointer over the bar representing February 2003.

The pointer turns into the QuickZoom symbol.

2 Double-click the bar.

QuickBooks displays the custom transaction detail report for February 2003:

You may need to scroll the window to the right to see the entire report.
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To display a transaction in the report:
1 Double-click one of the lines on the report for Invoice 19.

QuickBooks displays the invoice:

2 From the Window menu, choose Close All.

3 Click No if QuickBooks asks if you want to memorise the report.

Customising how graphs display

You can customise graphs to control what data they include and how the data is 
displayed. In this exercise, you’ll change the display from 3D to 2D graphs. This often 
allows your computer to generate graphs faster.

To change from 3D to 2D:
1 From the Edit menu, choose Preferences.

QuickBooks displays the Preferences window.

2 In the left scroll box, click Reports & Graphs.
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QuickBooks displays the Preferences window for Reports and Graphs:

3 Click the Draw graphs in 2D (faster) tick box.

4 Click OK.

5 From the Reports menu, choose Sales, then Sales Graph.

QuickBooks displays the sales graph in 2D:

6 Close the graph.
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Lesson objectives
� To give you an overview of stock in QuickBooks

� To practice filling in a purchase order for stock items

� To track the receipt of the stock items in QuickBooks 

� To adjust stock manually, to enter a stock loss or increase

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 10.qbw 
in the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Turning on the stock feature

The QuickBooks stock feature is turned on in your lesson file, but you’ll review how 
to turn on this feature so you become familiar with QuickBooks preferences. If you 
need to track stock for your company, you can turn the feature on while completing 
the EasyStep Interview. If you want to turn on the stock feature after you’ve completed 
the EasyStep Interview, follow this procedure.

To turn on the stock feature:
1 From the Edit menu, choose Preferences.

2 Select Purchases & Suppliers from the scroll box.
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3 Click the Company Preferences tab.

Note: Only the QuickBooks Administrator can change company preferences.

4 Click the “Stock and purchase orders are active” tick box to select it.

A tick shows that the stock feature is turned on.

5 Click OK.

Entering products into stock

Many small businesses that carry stock don’t know the number of units they have on 
hand or on order at any given time, and have no way of getting that information 
quickly. Using QuickBooks to manage your stock, you’ll be able to track the number 
of items in stock and the value of your stock after every purchase and sale. As you order 
stock items, receive and later sell the items, QuickBooks tracks each stock-related 
transaction. You will know the status of your stock and will have a more accurate 
picture of your business’s assets.

To track stock, you must enter each product into the Item list as a stock part. Once you 
enter a product, QuickBooks tracks it as you sell or reorder the product.

To enter a product into stock:
1 From the Suppliers menu, choose Item List.

QuickBooks displays the Item list.

2 Click the Item menu button, and then choose New.

QuickBooks displays the New Item window.

You’ll enter one new item into your stock.

3 In the Type field, choose Stock Part from the drop-down list.
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QuickBooks changes the New Item window to accept information for a stock part:

4 In the Item Name/Number field, type Maple dresser.

5 Select the “Subitem of” tick box, and then choose Dressers from the drop-down 
list.

6 In the Description on Purchase Transactions field, type Maple Welsh dresser, and 
then press Tab to move to the Cost field.

Notice that QuickBooks fills in the Description on Sales Transactions field with the 
same description you entered for the purchase side. You can leave the sales 
description the same or change it later.

7 In the Cost field, type 169.00. 

8 For Purch VAT Code, select S from the drop-down list.

9 In the Preferred Supplier field, choose Windsor & Wycombe from the 
drop-down list (or type the first few letters; QuickBooks fills in the rest).

10 In the Sales Price field, type 300.00. 

11 For Sales VAT Code, select S from the drop-down list.

12 In the Income Account field, choose Sales:Retail.

13 Press Tab to move to the Asset Account field.

Stock Asset was filled in when you selected Stock Part as the type of item. Leave 
this default setting.

14 In the Reorder Point field, type 15.
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15 In the On Hand field, type 20, and then press Tab to move to the Total Value field.

Notice that QuickBooks has calculated the value of your item by multiplying the 
On Hand quantity by the Cost.

Your New Item window should resemble this one:

16 Click OK to close the New Item window.

QuickBooks adds the new item to the Item list:

17 Close the Item List window.
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Ordering products

Once you enter your current products and suppliers into the Item and Supplier lists, 
you’ll need to order products to maintain your stock levels.

Creating purchase orders

To order a product using a purchase order:
1 From the Suppliers menu, choose Create Purchase Orders.

QuickBooks displays the Create Purchase Orders window.

You use the Create Purchase Orders window to enter the products you wish to 
order, the quantities, and the supplier. As you fill in this information, QuickBooks 
automatically calculates purchase order number, item cost, and total cost.

Notice that QuickBooks has already entered today’s date and a sequential purchase 
order number.

2 In the Supplier field, choose Firth & Co. from the drop-down list.

Notice that QuickBooks displays all of the information about Firth & Co. in the 
appropriate places on the purchase order form.

3 In the Item field, choose Sinks:Double sink from the drop-down list.

4 In the Qty field, type 25.

5 In the Supplier Message field of the purchase order, type Please rush ship this order.
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Your Purchase Order should resemble this one.

6 Click Save & Close to record the purchase order.

After you have created a purchase order, QuickBooks adds the Purchase Orders 
account to the chart of accounts. This is a non-posting account and does not affect 
your balance sheet or income statement. The Purchase Orders account is used to 
produce a QuickReport showing current purchase orders so you always know what is 
on order.

Generating a report of purchase orders

To generate a purchase orders report:
1 Display the chart of accounts.

2 In the chart of accounts, click Purchase Orders once to select it.

3 Click the Reports menu button and choose QuickReport:Purchase Orders.

QuickBooks displays a report of all purchase orders, including the one just created:
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4 Close the QuickReport and the chart of accounts.

Receiving stock

When you receive the items on your purchase order, you have to enter them into 
stock. You can receive items with or without a bill. 

This exercise shows you how to enter stock items you’ve received for which the bill 
will follow later.

To receive stock without a bill attached:
1 From the Suppliers menu, choose Receive Items.

QuickBooks displays the Create Item Receipts window:

The Create Item Receipts window lets you enter details of stock parts received.

2 In the Supplier field, choose Firth & Co. from the drop-down list.

QuickBooks tells you that there are open purchase orders for this supplier and asks 
if you wish to receive against one of these orders.

3 Click Yes.

QuickBooks displays the Open Purchase Orders window for Firth & Co.
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4 Click the purchase order to select it.

5 Click OK to move the information to the item receipt.

Your Create Item Receipts window should resemble this one:

6 Click Save & Close to process the receipt.

QuickBooks adds the items to your stock. If you display the Item list, you’ll see that 
you now have 25 additional double sinks on hand.

Entering a bill for stock

If you’ve entered an item receipt for stock, but the bill hasn’t arrived yet, you can still 
record the bill in QuickBooks. Entering the bill as shown in this exercise records the 
amount in your accounts payable account so you can track how much you owe. When 
the bill comes, you pay the bill from the Pay Bills window in the usual way.

To enter the bill:
1 From the Suppliers menu, choose Enter Bill for Received Items.

QuickBooks displays the Select Item Receipt window, where you can select the 
supplier and the item for which you have a bill.
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2 In the Supplier field, choose Firth & Co. from the drop-down list.

QuickBooks fills in the Date and Memo fields.

3 Select “Received items (bill to follow)”. 

4 Click OK.

QuickBooks displays the details in the Enter Bills window.

5 Click Save & Close.

QuickBooks reminds you that the transaction is linked to others.
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6 Click Yes.

QuickBooks changes the item receipt to a bill in the Accounts Payable account and 
lists the bill in the Pay Bills window. If you look at Accounts Payable, you’ll see 
that the Firth & Co. bill has increased the balance by £998.75.

Because you must have stock on hand before you can enter a sale for stock parts, 
we recommend that you enter your item receipts before entering sales.

Manually adjusting stock

When you have spoilage or send out samples of your products, you can adjust your 
stock manually.

To adjust the stock manually:
1 From the Suppliers menu, choose Stock Activities, and then choose Adjust 

Quantity/Value on Hand.

QuickBooks displays the Adjust Quantity/Value on Hand window.

The Adjust Quantity/Value on Hand window lets you enter the adjustment 
account, and either the New Qty or the Qty Difference.

You’ll adjust the stock account to remove two damaged units from the Maple 
dresser stock.

2 In the Adjustment Account field, type Stock Adjustment and press Tab.

3 Click Set Up when prompted that Stock Adjustment is not in the account list.

QuickBooks opens the New Account window:



10–12

S e t t i n g  u p  s t o c k

4 Click OK.

QuickBooks creates the new account.

5 In the Qty Difference column for Dressers:Maple dresser, type –2 (the number of 
damaged units), and then press Tab.

QuickBooks calculates the value adjustment and decreases the stock by two items.

6 Click Save & Close.
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Lesson objectives
� To give an overview of VAT in QuickBooks (the steps involved in tracking, 

collecting, and paying it)

� To demonstrate how to prepare your company for VAT

� To see how to apply VAT to a item

� To show how to determine a business’s sales tax liability

� To show how to pay VAT liability to HM Customs & Excise (from April 2005: HM 
Revenue and Customs)

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 11.qbw 
in the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Overview of VAT in QuickBooks 

Value Added Tax (VAT) is a simple tax in principle, but can be very complicated in 
practice. You must account for VAT on all the goods and services you purchase and 
sell in the course of your business. It requires careful bookkeeping and periodic returns 
to HM Customs and Excise (or HM Revenue and Customs). QuickBooks can help you 
meet these obligations efficiently.

In Lesson 2, “Setting up QuickBooks,” you saw how to set up your VAT preferences in 
QuickBooks. In this lesson, you’ll learn how to set up the VAT so that you can produce 
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invoices with VAT amounts, and track and report VAT as HM Customs and Excise 
(HMRC) requires. Besides normal VAT reporting, you can use other approved methods 
such as cash and annual accounting. You can also set up QuickBooks to handle the 
VAT aspects of trade with other European Community (EC) member states. 

You become liable to register for VAT once your income goes over a certain threshold. 
Below this threshold your registration is voluntary. Once registered, when you supply 
taxable goods or services you must charge VAT to your customers as part of your 
invoice to them. This is known as output tax.

When you purchase goods and services for your business, your suppliers may charge 
you VAT if they are also registered. This is known as input tax and is usually 
recoverable.

If you supply only taxable goods or services, the difference between the VAT you 
charge to your customers and the VAT you have incurred is the amount that you must 
pay to HMRC. If you have incurred more VAT than you have charged, HMRC will 
refund you the difference.

QuickBooks keeps track of all your input and output VAT in three ways:

� Up-to-date maintenance of your VAT Control account. QuickBooks records in 
your VAT Control account all the VAT due on sales invoices as well as the VAT that 
can be recovered on expenses and bills paid to suppliers.

� Production of invoices with VAT amounts. Every time your company sells 
products or services, QuickBooks can produce a “VAT invoice” to send to your 
customer. QuickBooks can deal with part payments and credit notes.

� Production of VAT reports needed for your VAT return. QuickBooks tracks the 
total VAT charged and incurred for each period. At the end of your tax period, 
QuickBooks makes it easy to complete your VAT return and pay the tax you owe.

Charging VAT

It is important that you establish the correct VAT status of the types of products your 
business makes.

If your business makes exempt products, you may find that the amount of input tax 
that you can recover in your VAT return is restricted by partial exemption rules. Check 
with your accountant or the local VAT office for further details of these rules and how 
they might apply to your business.

Who your customers are and where they are located can affect whether you charge 
VAT on a particular product. You can normally zero-rate the goods you supply to 
customers in another member state of the EC if you have a record of their VAT 
registration number and print it on your invoice to them. If your EC customer does 
not provide you with a VAT number, you must treat the sale in the same way as you 
treat a sale to a UK customer.
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When you create a new item, the default VAT code is always S for Standard. However, 
if the item is zero-rated or exempted from VAT, you can assign it the correct VAT code.

On sales forms, each line item gets the default VAT code you set up when you created 
the item. If you don’t charge want to charge VAT on a certain invoice, you must assign 
a zero-rated VAT code to each line item on the sales form.

In the company preferences, you can set a default VAT code that you normally use. 
You you can specify in the company preferences that you want to be able to set 
customer VAT codes, and you can also specify a default VAT rate for customers:

If you have a customer (e.g. a charity), for whom you usually charge a different rate of 
VAT from that on the item list, you must have the option ‘Allow customer VAT codes’ 
turned on in company preferences (as above). Then when you set up the customer, 
you can specify their default VAT rate. In this example, a VAT-exempt company has 
the VAT code E (instead of S), which will be used by default on sales forms:

For more details of setting up customers from the Customer:Job list, see Lesson 3.
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Preparing for trade with other EC member states

QuickBooks’ standard VAT reports do not give you the VAT return amounts for sales 
to and purchases from companies in other EC member states. To track the value of 
these sales and purchases, you must add new VAT codes to the VAT table.

To add EC VAT codes:
1 From the Lists menu, choose VAT Codes List.

QuickBooks displays the VAT Code List window.

2 Click the VAT Code menu button, and then select New.

QuickBooks displays the New VAT Code window: 

You need to enter three new VAT codes, rates, and descriptions:

EZ - 0.0% - European sales and purchases, zero-rated (used for all zero-rated 
sales to EC member states and all purchases from EC member states that would be 
exempt acquisitions in the UK). 

EP - 0.0% - European purchases, standard-rated (used for all purchases of goods 
from EC member states that would be standard-rated acquisitions in the UK).

ES - 17.5% - European sales, standard-rated (used for all standard-rated sales to 
customers in EC member states who are not registered for VAT).

3 Enter the first VAT Code, Rate, Description, and click EC VAT Code. 

4 Click Next, enter the second VAT Code, Rate, Description, and click EC VAT Code.

5 Click Next, enter the third VAT Code, Rate, Description, and click EC VAT Code.
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6 Click OK.

QuickBooks closes the New VAT Code window. The new codes appear in the VAT 
Code list: 

7 Close the VAT Code List window.

Grangeworth Kitchens has a new German customer, the Müller GmbH company in 
Munich. Its VAT registration number is already known. Grangeworth sells to Müller 
GmbH three oak Welsh dressers.

To invoice a European customer:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window.

2 In the Customer:Job field, type Muller GmbH, and press the Tab key.

3 Click QuickAdd in the Customer:Job Not Found box.

4 Type 3 in the Quantity column.

5 Click in the Item column, choose Dressers:Oak Welsh dressers from the drop-
down list and press Tab.

6 In the VAT column, choose EZ.

Notice that in the VAT AMT column, the VAT amount has been changed to 0:

7 Click Save & Close
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Handling import VAT from non-EC countries

When you import a shipment from outside the EC, it must be cleared through HMRC 
before being imported into the UK. Customs clearance usually involves paying import 
VAT.

Grangeworth Kitchens has a new supplier from the U.S., John Rush Inc., from whom 
they buy 50 pine tables. As John Rush Inc. is outside the EC, it doesn’t charge any VAT.

To enter an import bill:
1 From the Suppliers menu, choose Enter Bills.

2 In the Supplier field, type John Rush Inc. and press Tab.

3 Click QuickAdd in the Supplier Not Found box.

4 Enter the bill from John Rush Inc., your non-EC supplier, by clicking the Items tab, 
choosing Tables:Pine table in the Item column and entering 50 in the Qty column.

5 Select Z in the VAT code column. 

The bill should not have any VAT on it, and your screen should look like this:

6 Click Save & Close.

Handling fuel scale charges

QuickBooks can handle the VAT owing if you provide fuel to employees for business 
and private use. For each VAT period you should calculate the VAT due using the 
HMRC fuel scale charge table (we recommend you use a spreadsheet).

To enter fuel scale charges:
1 From the Company menu, choose Make Journal Entries. (If QuickBooks displays a 

message about automatic journal numbering, click OK.)
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2 On the first line, select the Motor Expense account and enter a Debit of 232.09 for 
the VAT-inclusive amount of the fuel benefit.

3 On the second line, select the Motor Expense account and enter a Credit of 202.00 
to the Motor Expense account for the VAT-exclusive amount. 

4 On the same line, select S for VAT Code and enter 30.09 for the VAT Amount at the 
standard rate.

5 Next to “Show on VAT reports”, click Output (Sale). 

Your window should resemble this one:

6 Click Save & New, leaving the General Journal Entry window open.

Viewing the VAT Control account

Each time you record an invoice or sales receipt that includes VAT, QuickBooks enters 
the information in the VAT Control account register. This displays all the transactions 
that are recorded to the VAT Control account, and provides a running balance of the 
account. You can also see which transactions have already been filed.

To view the VAT Control account:
1 From the Company menu, choose Chart of Accounts.

QuickBooks opens the Chart of Accounts.

2 Double-click VAT Control.

QuickBooks opens the register for the VAT Control account.

3 Scroll up to see earlier transactions that have already been filed (indicated by F in 
the tick column).

4 Close the VAT Control account window.
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Adjusting the VAT Control account

You may need to make an adjustment to your VAT Control account to correct an error 
in your VAT return or to account for a discrepancy in a VAT payment or prepayment. 
You do this by creating a general journal entry (the adjustments will show on your 
VAT reports unless you right-click on the adjustment in the VAT control account 
register and mark it as “filed”). Enter the VAT amount in the Increase field for VAT that 
is payable or in the Decrease field for VAT that is deductible. 

Normally such adjustments are made only by an accountant.

Grangeworth Kitchens has to adjust its VAT Control account, because the balance is 
£30 higher than it should be.

To adjust the VAT Control account:
1 On the first line of the General Journal Entry window, select VAT Control under 

Account and type 30.00 under Debit.

Remember that this is a liability account—a debit reduces the VAT you owe.

2 On the second line, type VAT Adjustment in the Account field and press Tab.

The Account Not Found box appears.

3 Click Set Up.

The New Account window appears, with VAT Adjustment in the Name field.

4 In the Type field, select Expense from the drop-down list, as shown:

5 Click OK to close the New Account window.

QuickBooks has filled in 30.00 in the Credit field for the VAT Adjustment account 
in the General Journal Entry window.
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6 Click Output (Sale) for ‘Show on VAT reports’.

7 Click Save & Close.

Paying VAT to HM Revenue and Customs

QuickBooks gives you a single procedure for producing the figures you need for your 
VAT return along with a QuickBooks cheque to pay your VAT liability.

Note: This procedure works only if you are using accrual-based VAT accounting.

To pay VAT liability:
1 From the Suppliers menu, select VAT, then File VAT.

QuickBooks displays the Pay VAT window.

2 Change the “Show VAT through” date to 31/03/2003 and press Tab.

QuickBooks recalculates the details, and prefills the necessary fields.

3 Click in the Pay column so that a tick appears.

4 Select “To be printed”.

Your Pay VAT window should resemble this one:
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5 Click Next.

QuickBooks displays the Value Added Tax Return report:

6 Click Next.

An information message is displayed.

7 Click OK.

QuickBooks redisplays the File VAT window.

8 Click Print.

The Print dialog box appears.

9 Click Print.

QuickBooks sends the VAT return to your printer, records the VAT cheque in the 
current account register, and deducts the amount from the VAT Control account. 

You can use the QuickBooks return to fill in the VAT 100 return that you send to 
HMRC. The VAT cheque can be printed in the usual way.

Note that VAT payments do not affect VAT reports at all. After you pay your VAT for 
a reporting period, your VAT reports for that period maintain the amount you paid. 
This provides you with the necessary support in the event of a VAT audit.

If you are using accrual-based accounting, the VAT control account entries are marked 
“Filed” once you have completed the return. 
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This means that when you are completing the next return, any late entries from the 
previous period that were not included in that VAT return can easily be picked up, 
because they are not marked “Filed”. 

Once an entry is marked as “Filed”, you cannot make any changes to it except to the 
description or account designation (to do this, in the Register right-click on the entry).

VAT reports

QuickBooks can create reports to show your VAT position at any time, whether cash- 
or accrual-based. Along with the VAT Return report which you produced in the last 
exercise, QuickBooks offers these VAT reports:

� VAT 100: shows the amounts you need to complete your VAT return, especially if 
your VAT accounting is cash-based. 

� VAT Detail: shows individual input and output transactions, with total input and 
output tax. 

� VAT Summary: summarises total inputs and outputs by VAT code and shows the 
balance due to or from HMRC for a reporting period. 

� EC Sales List: shows all sales using the EC VAT codes (if set up).

� VAT Exception Report: The VAT Exception report shows unfiled VAT transac-
tions up to the end of the previous VAT reporting period. This enables you to find 
any outstanding VAT liabilities from previous VAT reporting periods.

The reports are available from the Reports menu by selecting VAT, then the desired 
report.

You should print and save all these reports when you are preparing your VAT return. 
QuickBooks automatically creates each report for the last full VAT quarter using the 
dates and accounting method (accrual or cash basis) you chose in VAT Preferences. If 
you’re using cash accounting for VAT, QuickBooks prepares two VAT Detail reports.
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Lesson objectives
� To give an overview of payroll in QuickBooks

� To learn more about payroll setup

� To set up employee payroll information

� To see how to record SSP, SMP and SPP

� To practice writing and printing a payroll cheque

� To learn how QuickBooks tracks your tax liabilities

� To practice paying payroll taxes

� To learn about reviewing P60 forms and printing P35s, and making an electronic 
submission at payroll year-end

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Change and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 12.qbw 
in the Name field.

5 Click Change and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Overview of payroll tracking

To calculate payroll, QuickBooks uses tax tables. The lesson file includes tax table data 
needed to complete this lesson. To get the tax tables to use with your own QuickBooks 
company data file, you need to subscribe to the QuickBooks Payroll Service and keep 
your tax tables up to date from CD or the Internet. To learn about and subscribe to the 
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service, choose About Payroll Services—or see the User Guide for an overview and 
contact information.

QuickBooks calculates each employee’s gross pay, and then calculates taxes and 
deductions, including SSP, SMP, SPP or SAP if applicable, to arrive at the net pay. With 
QuickBooks, you can write the pay cheque, record the transaction in your QuickBooks 
current account, and keep track of your tax liabilities.

You, as the employer, must subtract income tax (PAYE) and National Insurance 
contributions (NIC) before issuing an employee’s pay cheque. You may also deduct for 
benefits such as contributions to health insurance or pensions. QuickBooks makes 
these calculations, including directors’ NIC.

Calculating payroll with QuickBooks

To do its payroll calculations, QuickBooks needs four kinds of information:

� Information about your company

This includes the company name, address, and PAYE reference number. You enter 
this information when you set up your QuickBooks company in the EasyStep 
Interview. (You can view most company information by choosing Company 
Information from the Company menu.)

� Information about your employees

The QuickBooks Employee list stores general information about each of your 
employees, and specific information related to payroll (such as the employee’s 
salary or hourly rate and miscellaneous additions, deductions, and company 
contributions). You can store payroll information that most employees have in 
common in employee defaults. Whenever you have a new employee to add, 
simply enter information specific to that employee (name, address, and so on).

� Information about your payroll items

QuickBooks maintains a list of payroll items that affect the amount on a payroll 
cheque, including company expenses related to payroll. When you specify you 
want to use payroll, QuickBooks creates a number of payroll items for you. You 
add others as you need them.

� Tax tables

QuickBooks uses tax tables to calculate payroll. You get the current tax tables and 
keep them current when you subscribe to the QuickBooks Payroll Service 
mentioned above. If you choose not to subscribe, you need to calculate and enter 
PAYE and NICs manually for each pay cheque.

Once you’ve set up payroll in QuickBooks and subscribed to the QuickBooks Payroll 
Service, all you do is enter the salary or number of hours worked during the pay period 
for each employee, and any sick or maternity leave taken. QuickBooks calculates the 
gross wages for the employee (if necessary), and then refers to its tax tables and the 
company and employee information you’ve entered to calculate the net pay figure. 



12–4

D o i n g  p a y r o l l

QuickBooks also calculates your company payroll expenses (for example, your 
contributions to National Insurance).

Note: This lesson is designed to demonstrate some of the payroll features in 
QuickBooks. How you process payroll for your company may differ. 

Note also that because the lesson file is not set to the current tax year, 
some details do not appear as they would when you use payroll with 
current tax tables for your own company, and some dates will need to be 
changed to make the exercises work. In some cases you will use the default 
current date on the file, but where the instructions specify a date, make 
sure you use the date specified to ensure you can follow the process 
described.

Setting up for payroll

The QuickBooks payroll feature is turned on for the lesson (and sample) file. However, 
payroll is turned off by default for other company files.

To turn payroll on for any QuickBooks company file:
1 From the Edit menu, choose Preferences, and click Payroll & Employees.

2 Click the Company Preferences tab and select “Full payroll features.”

Note: You can also turn on the payroll feature during the EasyStep Interview.

3 Click OK.

Adding payroll items you need

QuickBooks maintains a list for everything that affects the amount on a payroll 
cheque and for every company expense related to payroll. This list is called the Payroll 
Item list. QuickBooks adds some of the items for you, and you can add new items of 
your own to the list.

You work directly with payroll items as you do payroll tasks. Behind the scenes, 
QuickBooks tracks your payroll liabilities in a Payroll Liabilities account (an Other 
Current Liability account) and your payroll expenses in a Payroll Expenses expense 
account. When you create a new payroll item, the Payroll Item Setup wizard helps you 
assign the item to the correct account or accounts by prefilling the account name.

To view the Payroll Item list:
1 From the Employees menu, choose Payroll Item List. (You must have payroll 

turned on to see this choice.)

QuickBooks displays the Payroll Item list:
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You’ve already used the QuickBooks Item list, so this list should look familiar. Just 
like the regular Item list, each payroll item has a Name and a Type. A payroll item 
can be Salary, Hourly Pay, Deduction, Addition, Commission, Company Contri-
bution, Payroll Tax, SSP, SMP and so on.

2 Scroll down the Payroll Item list to Collection of Student Loan and double-click 
on this item to see how it was set up.

QuickBooks displays the Payroll Item Setup wizard for the Collection of Student 
Loan payroll item. The first window shows the name used on pay cheques and 
payroll reports.

3 Click Next.

This window shows the liability agency to whom you pay the tax and the liability 
account that keeps track of the liability. If you have the supplier name, bank, or 
agency to whom you pay your payroll taxes in the first field, QuickBooks can 
create the liability cheque when taxes are due.

For other payroll items, you might see different windows or information:

� The expense account to which your payments are assigned is shown for 
Payroll Expense items.

� The Company and Employee Tax Rates window shows the rates used by the 
tax tables. 

� The Taxes window (below) lets you select taxes affected by a payroll item.
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4 Click Finish to return to the Payroll Item list.

5 Close the Payroll Item list.

Setting up employee payroll information

QuickBooks calculates payroll for each employee on the basis of that employee’s pay 
rate, tax code, and so on. The Employee list stores general as well as payroll 
information about each employee.

What information does QuickBooks store?

You are going to add a new employee to Grangeworth Kitchens payroll in a moment. 
First, look at the information QuickBooks stores in the Employee list.

To view information stored in the Employee list:
1 From the Employees menu, choose Employee List.

QuickBooks displays this window:

2 Select James E MacDonald, then click the Employee menu button and choose Edit.

QuickBooks displays the Edit Employee window for James E MacDonald, with the 
Personal Info tabs selected.
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The Address Info tab contains the general information QuickBooks has about 
James MacDonald: his name, address, date of birth, National Insurance number, 
and joining date. The Additional Info tab lets you add custom fields to the 
Employee list.

3 Change tabs by selecting Payroll and Compensation Info.

QuickBooks displays the Payroll Info section of the Edit Employee window.

The Payroll Info tab contains an employee’s specific salary or hourly rate, and any 
additions, deductions, or company contributions.

4 Click Tax/NI Details.

QuickBooks displays the Taxes for James E MacDonald window.
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James’s tax and NI codes are shown. The tick boxes indicate special types of taxes 
which can be calculated for each pay cheque.

5 Click OK to return to the Edit Employee window. 

6 Click Bank Details.

QuickBooks displays the Bank Details window. 

7 Since there are no bank details set up for this employee, you need to enter them. 
Complete the details as follows:

8 Click OK to return to the Edit Employee window.

9 Click OK again to return to the Employee list.
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Using the employee defaults to store common information

QuickBooks doesn’t require you to enter the same information over and over for each 
employee. Information that applies to most of your employees can be added to your 
employee defaults. Then, when you add an employee, QuickBooks automatically fills 
in the stored default information. You need only add or change any information that 
is different for a particular employee.

To view the Employee Defaults:
1 With the Employee list displayed, click the Employee menu button and choose 

Employee Defaults.

QuickBooks displays the Employee Defaults window.

Use this window to set up common payroll information.

All Grangeworth Kitchens employees have the same standard holiday allowance, 
so that is entered in the employee defaults.

2 Click Sick/Holiday.

QuickBooks displays the Sick & Holiday Defaults window.

Information regarding earned sick days and holiday days is entered in this 
window. QuickBooks keeps track of the earned time each pay period.

3 Click Cancel to close the Sick & Holiday Defaults window.

4 Click OK to close the Employee Defaults window.
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Adding a new employee

Suppose you want to add a new employee to the payroll.

To add a new employee:
1 With the Employee list displayed, choose New from the Employee menu button.

QuickBooks displays the New Employee window.

2 Click the Address Info tab and enter the employee data as shown:

3 Change tabs by selecting Payroll and Compensation Info.

4 In the Earnings section of the window, click the Item Name column, choose 
Hourly Pay from the drop-down list and press Tab.

5 In the Hour/Annual Rate column, type 15.00 and press Tab.

6 In the Pay Frequency field, select Weekly from the drop-down list.

7 In the Pay Method field, select Cheque from the drop-down list. Since he is being 
paid by this method, you will not need to enter his bank details.

The Payroll Info window should look like this:
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8 Click Tax/NI Details.

QuickBooks displays the Taxes for Tony Smith window.

This is where you set the tax and National Insurance details. You would also use 
this window to indicate other tax-related details, for example if the employee was 
a director.

9 Type 233L in the Tax Code field.

10 Select A from the drop-down list in the NI Code field.

11 Click OK.

QuickBooks displays an information message.

12 Click OK.

QuickBooks redisplays the New Employee window.

13 Under “Additions, Deductions, Employer Contributions, and Tax Credits”, select 
Bonus in the Item Name column and press Tab. 

14 In the Amount column, type 15.00 and press Tab.

Your New Employee window should now look like this:
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15 Click OK.

16 When QuickBooks asks whether you want to set up additional payroll 
information, click Leave As Is.

QuickBooks returns to the Employee list, now showing the new employee’s name.

Entering SSP, SMP and SPP

QuickBooks enables you to record time that employees take off due to sickness or 
maternity leave, and automatically calculates the amount of any Statutory Sick Pay 
(SSP), Statutory Maternity Pay (SMP) or Statutory Paternity Pay (SPP) that applies. You 
can also record Statutory Adoption Pay (SAP).

SSP is payable after the first three waiting days. When entering sick leave for an 
employee, you also need to record their normal working pattern so that QuickBooks 
can recognise which days qualify for SSP. For example, if an employee works Mondays, 
Wednesdays and Fridays, and they are sick from Monday of one week until Friday of 
the next week, this would count as 6 qualifying days: 3 waiting days in the first week, 
followed by 3 days in the second week for which SSP would be payable. The working 
patterns all start on a Sunday, and you can record as many patterns as you need for 
the same employee to reflect their schedule. In this example the working pattern 
would be NWNWNWN.

For SMP, you need to record the Sunday of the week maternity leave starts, the date 
on which the employee finishes work, the date the birth is expected, and the actual 
birth date. SMP is payable for 26 weeks from the date she finished work.

The details you enter for SPP depend on whether the absence is taken for a birth or an 
adoption. SPP is payable for one or two full weeks within 8 weeks of the birth or 
adoption. 
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To enter SSP:
1 In the Employee list, double-click James E Macdonald.

2 In the Edit Employee window, change tabs by selecting Statutory Pay Info.

3 Click below SMTWTFS, and select the working pattern NWWWWWN from the 
drop-down list. This represents working Monday–Friday.

4 Under Entry Type, select Sick from the drop-down list.

5 For the Start Date, type 07/04/2003, and for the end date type 21/04/2003.

Your screen should look like this:

6 Click OK. If a message appears about previous SSP, click No.
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To record SMP:
1 From the Employee List, double-click Lynda J Hamilton.

2 In the Edit Employee window, change tabs by selecting Statutory Pay Info, then 
click the SMP tab.

3 Under Entry Type, select Maternity Leave from the drop-down list.

4 For the Start Date, type 06/04/2003. This date must be the Sunday of the first week 
of maternity leave.

5 Press Tab. QuickBooks automatically calculates the last week of maternity pay.

6 For Expected week of childbirth, type 04/05/2003. (If a message appears about 
previous SMP, click No.)

Once the child was born, you would enter the actual date in the Date of birth box.

7 For Intended maternity leave start date, type 09/04/2003. This is the actual date 
maternity leave starts, in this case the Wednesday.

Your screen should look like this.

8 Click OK.
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9 If QuickBooks displays a message about the employee providing medical evidence, 
click OK.

To record SPP:
1 From the Employee List, double-click Andrew G Turner.

2 In the Edit Employee window, change tabs by selecting Statutory Pay Info, then 
click the SPP tab.

Paternity leave can be one or two full weeks. Under Entry Type, you would select 
Paternity Leave from the drop-down list.

For a birth, you would then complete the remaining fields in much the same way 
as for SMP in the previous exercise. 

3 Click Adoption. 

QuickBooks displays a different set of fields that relate to SAP. 

For an adoption, you would complete the relevant dates when you were notified 
by the employee.

4 Click Cancel.
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5 Close the Employee List.

Note: When you have paid employees, you could refer to the Statutory Payments 
Detail report. To view this, from the Reports menu choose Employees & 
Payroll, then choose Statutory Payments Detail.

Paying employees

QuickBooks lets you print payroll cheques in a batch or one at a time. You can also 
process BACS or Giro payments all in a batch. If you are signed up for the QuickBooks 
ePayment Solutions, you can transfer money from your bank account to pay 
employees by BACS (Pro or higher). 

You may want to process salaried employees in a batch, and do the hourly employees 
one at a time.

Paying by cheque

In this exercise, you will create a payroll cheque for the new employee whose details 
you set up earlier, Tony Smith.

To create a payroll cheque:
1 From the Employees menu, choose Pay Employees. 

2 If a message appears about updating tax tables, click on “Don’t remind me”.

QuickBooks displays the Select Employees To Pay window.

Tip: If you had a large number of employees, and used different payment 
methods, you could select a list filter to display only employees paid by 
one method, in this example by cheque, or you could filter by pay 
frequency.

3 Click in the tick column to the left of Tony Smith’s name.

4 Make sure that “Enter hours and preview payment before creating” is selected.
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5 Click Create.

QuickBooks displays the Preview Payment window, filling in the earnings and 
bonus details you entered in the previous exercise when you entered Tony Smith 
as a new employee.

6 In the Hours column, type 35 and press Tab.

QuickBooks fills in the Employee Summary area of the Preview Payment window, 
showing all the deductions from Tony’s pay cheque. The net amount of the 
cheque appears at the bottom.

Because payroll tax rates change regularly, your figures may vary from this
illustration.

The Company Summary area of the window shows employer-paid taxes and 
contributions that do not affect the amount of the pay cheque (e.g., employer-
paid benefits). 
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7 Click Create.

QuickBooks redisplays the Select Employees To Pay window.

8 Click Leave.

QuickBooks writes a payroll cheque for the correct net amount, showing the 
deductions in the voucher area. 

Viewing the payroll cheque

QuickBooks records payroll cheques in your QuickBooks current account register. You 
can see the cheque by going to the register.

To view the pay cheque from the register:
1 From the Lists menu, choose Chart of Accounts.

2 Double-click the Master Bank Current account.

QuickBooks displays the Master Bank Current account register.

3 Select the pay cheque transaction for Tony Smith, and click Edit Transaction.

QuickBooks displays the Pay Cheque – Master Bank Current Account window:

Notice that the Pay Cheque Summary shows a additions and deductions 
summary. If you want to see the deductions that make up this total, you can click 
the Payment Detail button.

4 Make sure that the To be printed box is ticked.

5 Click Save & Close to close the Pay Cheque – Master Bank Current account 
window (click OK if asked to confirm).

6 Close the Master Bank Current account register, but leave the chart of accounts 
open.
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Printing pay cheques and pay slips

You print pay cheques as you would any QuickBooks cheque. If you use voucher 
cheques, QuickBooks prints the payroll item detail on the voucher. If not, you can 
print pay slips to give your employees.

To print a pay cheque:
1 From the File menu, choose Print Forms, and then choose Pay Cheques.

QuickBooks displays the Select Pay Cheques to Print window.

2 Make sure there is a number in the First Cheque Number field.

3 Make sure there is a tick next to Tony Smith’s name. 

4 Click OK.

5 Click Print in the Print Cheques window.

6 When asked if the cheque printed correctly, click OK.

Making a batch payment

In this exercise, you will see how to make payments to a batch of employees.

To create a payment batch:
1 From the Employees menu, choose Pay Employees. 

QuickBooks displays the Select Employees To Pay window.

2 Set the payment date to 30/04/2003.
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3 Click in the tick column to the left to select Andrew G Turner, James E MacDonald 
and Lynda J Hamilton.

4 Make sure that “Enter hours and preview payment before creating” is selected.

5 Click Create. (If a message appears warning you that this is a sample file, click OK.)

QuickBooks displays the Preview Payment window for Andrew G Turner.

6 Under Hours, type 170 and press Tab.

QuickBooks completes the amounts for the payroll items for this employee, with 
the net amount shown at the bottom. Andrew is a director, and his NICs are 
calculated annually.

Because payroll tax rates change regularly, your figures may vary from this
illustration.
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7 Click Create. 

QuickBooks displays the Preview Payment window for the next employee in the 
batch, in this case James E MacDonald. 

8 Under Hours, type 170 and press Tab.

9 Click Create. 

QuickBooks displays the Preview Payment window for the next employee in the 
batch, in this case Lynda J Hamilton. 

10 Under Hours, type 170 and press Tab.

11 Click Create.

QuickBooks redisplays the Select Employees To Pay window.

12 Click Leave.

QuickBooks produces a payment for the employees in this batch. 

13 Close the Employee List.

If you wish to see the effect of a batch payment, you can view the payment in the 
Master Bank Current account register, where it is shown as a single 
transaction of type PAYROLL. By looking at the detail of the 
transaction, you can see the list of employees paid.

Paying employees through e-Payment Solutions 
(Pro or higher)

You can subscribe to QuickBooks’ e-Payment Solutions to make a payroll BACS 
payment through an online BACS agent. In order for this to work, you would need to 
apply to your bank for a BACSTEL-IP. You would also need Internet access.

For the following exercises, you will see how to set up the details in QuickBooks for 
paying employees through e-Payment Solutions.

You will also see how to set a director’s NIC payments to be calculated on a monthly 
basis.

You then will see how to make a payment using e-Payment Solutions, which will also 
show the SSP and SMP payments for the employees whose sick and maternity leave 
you recorded earlier.

To set up banking preferences to use BACS for e-Payment Solutions:
1 From the Edit menu, choose Preferences.

2 Select Banking, and click the Company Preferences tab.
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3 Tick the boxes next to “Create BACS output files” and “I am signed up for e-
Payment Solutions”.

Note: If you tick the e-Payment Solutions box, the file will be encrypted ready for 
submission using the QuickBooks e-Payment Solutions. If you use another 
system to submit files directly, you would not tick the second box. The file 
would not be encrypted, and you would use your existing system to 
encrypt and submit it.

4 Click BACS User Number.

QuickBooks displays the Company BACS Details window.

5 Type 123456 then click OK.

Note: This number must always be 6 digits.

6 Click OK.

7 For Payroll export file location, type c:\qbtrain, or click Browse and select your 
training folder.

This is the location where your encrypted BACS files will be stored.

Type the same location for output files for Non-Payroll export files.

Your screen should resemble this:
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8 Click OK.

Next, you need to set up the BACS details in your bank account.

To set up BACS details in your bank account:
1 From the Lists menu, choose Chart of Accounts.

2 Select Master Bank Current.

3 Click the Account menu button, and choose Edit.

4 Click the BACS Information tab.

5 Complete the BACS details as follows:

Account Name: BACS E-Payments

Sort Code: 010203

Account Number: 12345678

Your screen should resemble this:
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6 Click OK.

If you see a message about preprinted cheques, click No.

The next stage is to set up employees to enable them to be paid by BACS. In this 
exercise you will do this for just one employee, but in practice you would need to do 
this for all employees that you want to pay by this method.

The exercise also shows how to set a director’s NIC to be paid on a monthly basis 
instead of an annual basis. You would do this in the first pay period of the tax year.

To set up employees to be paid by BACS:
1 From the Employees menu, choose Employee List.

2 Select Lynda J Hamilton from the list.

3 Click the Employee menu button, and choose Edit.

4 From the Change tabs drop-down list, choose Payroll and Compensation Info.

5 For Pay Method, choose BACS from the drop-down list (if it is not shown already).
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6 Click Bank Details.

QuickBooks displays the Bank Details for Lynda J Hamilton window. Here you 
would complete the bank details. In this case, the bank details have already been 
set up, but the account number is incorrect.

7 Delete the last two digits of the account number.

8 Click OK to return to the Edit Employee window.

9 Click OK.

Since Andrew Turner is a director, and he is paid on a regular basis over the LEL, you 
can apply a per period arrangement for assessing and paying NICs, which he has 
agreed to. You can make this change only in the first period of the payroll year. You 
will also update his tax code at the same time.

To set up a director to have NICs calculated per pay period:
1 Select Andrew G. Turner from the list.

2 Click the Employee menu button, and choose Edit.

3 From the Change tabs drop-down list, choose Payroll and Compensation Info.

4 Click Tax/NI Details.

5 Change the tax code to 678L, with an Effective from date of 01/04/2003.

6 For NIC Calculation Method, choose Per Period from the dropdown list.
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7 Click OK. (If you see any warning messages, click OK.)

8 Click OK in the Edit Employee window.

You are now ready to run the payroll payment. 

To pay employees through e-Payments Solutions:
1 From the Employees menu, choose Pay Employees. 

QuickBooks displays the Select Employees To Pay window.

2 Click in the tick column to the left to select Andrew G Turner, James E MacDonald 
and Lynda J Hamilton.

3 Change the Payment Date to 30/04/2003.

4 Make sure that “Enter hours and preview payment before creating” is selected.

5 Click Create. (If you see any messages, for example that a bank account name will 
be truncated, click OK.)

QuickBooks displays the Preview Payment window.

6 For Hours, type 170.

7 Click Create.

8 Make sure that “Enter hours and preview payment before creating” is selected.

9 Click Create. (If a message appears warning you that this is a sample file, click OK.)

QuickBooks displays the Preview Payment window for Andrew G Turner.
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10 Under Hours, type 170 if not shown already, and press Tab.

QuickBooks completes the amounts for the payroll items for this employee, with 
the net amount shown at the bottom. Notice that the NIC Annual Calc box is no 
longer ticked, since you changed the NIC calculation method.

Because payroll tax rates change regularly, your figures may vary from this
illustration.

11 Click Create. (If you see a message about director’s NIC calculation, click Yes.)

QuickBooks displays the Preview Payment window for the next employee in the 
batch, in this case James E MacDonald. Because the lesson file is not set to the 
current date, the SSP payment is not actually shown, but if you were using your 
own company file with current payroll data, it would look something like this:
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12 Click Create.

QuickBooks displays the Preview Payment window for the next employee in the 
batch, in this case Lynda J Hamilton. Because the lesson file is not set to the 
current date, the SMP payment is not actually shown, but if you were using your 
own company file with current payroll data, it would look something like this:

13 Click Create.

QuickBooks redisplays the Select Employees To Pay window.
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14 Click Leave.

QuickBooks produces a payment for the employees in this batch. 

15 Close the Employee List.

16 Click Create.

QuickBooks redisplays the Select Employees To Pay window.

17 Click Leave.

At this stage QuickBooks produces an encrypted BACS payment file for the 
employees in this batch. The filename starts QBOut-, and has the suffix .bacs. It 
is saved in the folder you specified earlier, in this case qbtrain.

18 Click OK.

19 Close the Employee List.

Since the file is encrypted, you can view the BACS report to see details of the 
payment.

20 From the Reports menu, choose Employees and Payroll, then choose BACS Report.

21 Change the date range to 01/04/2003–30/04/2003 and click Refresh.

QuickBooks displays the BACS report for the payment you just made.

The next stage would be to make the electronic payment using the encrypted file. To 
do this, you would carry out the following steps:

1 From the Banking menu, choose Banking Services, then choose Pay Employees via 
e-Payment Solutions. 

2 Log in to the payment services page.

3 Select the relevant file to transmit (in this example QBOut-300420030000.bacs), 
and click Upload File. 

A summary message would appear when transmission was complete. 
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You would receive a monthly statement of charges, sent by email. QuickBooks would 
automatically create a cheque for the direct debit payment.

Tracking your tax liabilities

As an employer, you need to track both payroll expenses and payroll liabilities. These 
are the company payroll expenses you need to track:

� Employees’ gross pay

� Employer payroll taxes, such as PAYE and NICs.

QuickBooks uses the Payroll Expenses account to track these actual costs to your 
company (deductions from employee pay cheques aren’t considered an actual cost 
because they’re monies you are merely holding for the government; they don’t come 
directly from your company assets). When you run your payroll, QuickBooks keeps 
track of your company’s expenses for each employee. You can then see totals for these 
expenses on the Payroll Summary by Employee report and Profit and Loss Statement.

QuickBooks uses the Payroll Liabilities account (an Other Current Liability account) 
to track what you owe to the government. When you do your payroll, QuickBooks 
calculates how much you owe for each tax, deduction, or employer contribution 
payroll item and records that information as a transaction in the liability account. This 
produces a record of how much tax you owe at any time, so you can plan to have the 
cash available for payment. When you pay your payroll taxes or other payroll 
liabilities, QuickBooks decreases the balance of the liability account.

Look at the payroll expense and liability accounts so you can see how QuickBooks 
recorded expenses and liabilities related to Tony Smith’s pay cheque. 

To display the payroll expenses QuickReport:
1 In the Chart of Accounts window, scroll down and select the Payroll Expenses 

account.

2 Click the Reports menu button and choose QuickReport: Payroll Expenses.

QuickBooks displays the QuickReport. You can see the expense items paid by the 
company for Tony Smith’s pay cheque.
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3 Close the QuickReport.

4 In the chart of accounts, double-click the Payroll Liabilities account.

QuickBooks displays the account register, showing a separate transaction for each 
item from Tony’s pay cheque. The running balance increases for every liability.

5 Close the register, then close the chart of accounts.
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Paying payroll taxes

As long as you have a valid subscription to the QuickBooks Payroll Service, 
QuickBooks uses current tax tables to keep track of your tax liabilities as they accrue, 
so you know how much you owe at any time.

Finding out what you owe

If you’re about to pay taxes or other liabilities, the payroll liabilities report shows you 
how much to pay. Suppose Grangeworth Kitchens is ready to make a tax payment, and 
wants to see how much is owing.

To create a Payroll Liability Balances report:
1 From the Reports menu, choose Employees & Payroll, and then Payroll Liability 

Balances.

QuickBooks displays a report of what Grangeworth owes for each payroll item. 
You can scroll across to see each month and the total balance.

2 Close the report.

Writing a cheque for payroll taxes

Each month, use the Liability Cheque window to fill in a QuickBooks cheque to 
Inland Revenue for payroll taxes.

Important: Do not write a cheque from the Write Cheques window. Quick-
Books cannot properly adjust your Payroll Liabilities account
unless you use the Pay Liabilities feature.
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To pay payroll liabilities:
1 From the Employees menu, choose Process Payroll Liabilities, then Pay Payroll 

Liabilities.

QuickBooks displays the Select Date Range For Liabilities window.

2 In the two date fields, type 06/04/2002 and 05/04/2003 

3 Click OK.

QuickBooks displays the Pay Liabilities window.

4 Click next to the first item.

QuickBooks places ticks against all items for which there are liabilities, and 
updates the Ending Bank Balance. 

5 Click “Review liability cheque to enter expenses/penalties”. 
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Now your Pay Liabilities window should look like this:

6 Click Create. (If you see a warning message, click No.)

QuickBooks displays your cheque in the Liability Cheque window:

7 In the Memo field, type the PAYE reference for this payment, in this case 
976 879A71 0002 12.

8 Tick the To be printed box (if it isn’t already).

9 Click Save & Close to record the cheque (click Yes if asked to confirm).

Whenever you make a payment and record your cheque this way, QuickBooks 
decreases the balance of your Payroll Liabilities account.
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Processing payroll at year-end

Quick Books can process your P60 end-of-year forms for employees and generate 
reports covering the information needed for your P35 end-of-year return to Inland 
Revenue, including P11 Deductions Worksheets. 

You can file your end-of-year reports electronically directly from QuickBooks if you 
have an Internet connection. QuickBooks guides you through all the stages that you 
would need to carry out in order to complete your online filing.

To do this with your own company data, you would need to register in advance with 
the Inland Revenue and obtain a user ID and Activation PIN so you can activate the 
service on the Government Gateway website. You would need be in single-user mode 
to file the end-of-year returns, and you would need to be connected to the Internet.

For this exercise, you will carry out all the steps except for the final one, since you will 
not be allowed to file the data from the lesson file!

Before you start, you need to make sure you have recorded the IR Office Number and 
Employer’s PAYE Reference Number in QuickBooks.

To record the Inland Revenue and PAYE numbers:
1 From the Edit menu, choose Preferences.

2 Select Payroll & Employees, and click the Company Preferences tab.

3 Under Tax Office Number and Reference, type 914/55195. 

4 Click OK.

To process payroll year-end:
1 From the Employees menu, choose Process Payroll Year End.

QuickBooks displays the Payroll Year End Process window.
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2 Change the Payroll Year by selecting 2002/2003 from the dropdown list.

QuickBooks lists the Grangeworth’s employees. It shows the current status, 
currently “Process Year End not started”.

3 Click Mark All.

4 Click Review P14/P60 Data.

Quick Books displays the first employee’s P14/P60:

5 Click Next to continue until you’ve reviewed each P14/P60.

6 Click OK.

QuickBooks returns to the Payroll Year End Process window. Notice that the status 
has changed, and the next step is indicated.
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7 Click Print P14/P60 Forms.

QuickBooks displays the Print P60s window. 

From here, you can select whether you want to print the P60s onto Inland 
Revenue forms or Intuit pre-printed forms, or onto Laser Mailer P60. You would 
make sure you had the correct paper loaded in your printer. For this exercise, you 
can just leave the default style, and use whatever paper is in your printer.

8 Click Print.

QuickBooks returns to the Payroll Year End Process window. Again, the status has 
been updated and the Next Step has changed.

9 Click Review P35 Data.

QuickBooks displays the P35 Data window, showing the Employee Summary.

10 Select each tab in turn to review the information for each of the working sheets. 
Some fields are pre-filled, but you can enter or amend information in some boxes.
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Working sheet 1 is shown on this tab:

Working sheet 2 is shown on this tab:
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Working sheet 3 is shown on this tab:

11 Click OK.

QuickBooks returns to the Payroll Year End Process window. Again, the status has 
been updated and the Next Step has changed.

12 Click Checklist & Declaration.

QuickBooks displays the Checklist and Employer’s Declaration window.
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13 You would answer all the questions as appropriate for your company. 

For this exercise, in the first section, tick Yes for question 1, and No for all the 
others.

In the Declaration section, tick the boxes next to P14 and P11 are enclosed.

For P38A, tick ‘is not due’ (because you have ticked Yes for question 1). 

Your form should resemble the following:

14 Click OK.

QuickBooks returns to the Payroll Year End Process window. Again, the status has 
been updated and the Next Step has changed. You are now ready to print the P35 
for your own records. The P35 report summarises all the copy P60 forms you are 
submitting to Inland Revenue. It gives you the information needed for your P35 
CS return. 
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15 Click Print P35 Form.

QuickBooks displays the P35 - Employer’s Annual Return window, showing the 
P35 overstamped ‘Office Copy Only’:

16 If the Print dialog box does not appear automatically, click the Print button in this 
window. 
Print the P35 copy.

17 Close the P35 - Employer’s Annual Return window to return to the Payroll Year 
End Process window.

At this stage, you cannot proceed any further because you are using the lesson file 
with sample data. 

18 If you were working with your own company data, you would click the final 
button, File Online. This would submit your data to the Inland Revenue. 

Note: You would need to be connected to the Internet, and you would need to 
have your user ID and Activation PIN ready.

Tip: With QuickBooks Payroll, you can also generate BACS reports and P45 
forms for leavers—see the onscreen Help for details.
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Lesson objectives
� To learn how to modify a preset invoice form

� To design a custom invoice form

� To modify a the layout of an invoice template

� To see how to print invoices

� To learn how to prepare a collection letter for overdue customers

� To learn how to edit a prewritten QuickBooks letter

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 13.qbw 
in the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

About QuickBooks forms

Each form you use in QuickBooks has its own layout of fields and columns for entering 
information. If the layout of a particular form doesn’t meet your needs, you can create 
your own custom layout and use your version instead of the QuickBooks version.

In Lesson 1, you learned about the three preset formats for invoices: professional, 
service, and product. If these formats don’t precisely fulfil your needs, you can 
customise them using the Custom invoice template. For each form, you can decide 
which fields and columns to include, what they are called, and where to place them. 
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Once you have created your forms, you can save the new layouts as “templates”—to 
use whenever you wish, and to modify whenever you want. 

The forms you can customise in QuickBooks are the invoice, the cash sale (sales 
receipt), credit memo, statement, purchase order, and (in QuickBooks Pro/Accountant 
only) estimate and delivery note.

Customising an invoice

QuickBooks lets you customise an invoice form to suit your business. For example, you 
can change the title, add a due date field, and change the order of fields. But you may 
sometimes want to design a completely different invoice form. QuickBooks lets you 
do that, too. In the Layout Designer, you can move or resize columns, turn on or off 
borders around fields, and control font type and size for each field. 

In these exercises, you’ll use both the customising and Layout Designer features in 
QuickBooks to create a professional-looking invoice.

Note: In QuickBooks Pro/Accountant, there are some additional formatting 
options (not illustrated), and an additional tab where you can customise 
fields that appear only on estimates.

Creating a new template

To create a new invoice template:
1 From the Lists menu, choose Templates.

QuickBooks displays the Templates list.
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2 Click the Templates menu button, and then choose New.

QuickBooks displays the Select Template Type window.

3 Since Invoice is already selected, click OK.

QuickBooks displays the Customise Invoice window.

4 In the Template Name field, type My Invoice.

Your window should look like this:

The Customise Invoice window uses multiple tabs to display sets of formatting 
options for each part of the form. To display the available formatting options, click 
the tab for the part of the form you want to change.

Notice that the Header tab is currently selected. The Header tab displays the 
formatting options for the top part of the invoice form. You can specify the title 
of each field and whether you want it displayed onscreen, on paper, both or 
neither. You can enter a new title by overtyping the current title text.

Tip: If you want to track information about a particular invoice without 
displaying it, you can select the Screen tick box and clear the Print tick box.
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5 Click the Fields tab.

The Fields tab is where you select which fields you want to appear onscreen and 
on paper. You can specify your own title (label) for each field.

Suppose you want to remind customers of payment due dates at the time you send 
the invoice. You can customise the invoice form to display the Due Date field.

6 To have the Due Date field display both onscreen and on the printed form, click 
the Screen and Print columns for Due Date to select both tick boxes.

Changing field order on a form

The lower half of the standard QuickBooks invoice form is where you enter details 
about the items or services purchased by the customer. You can change the order of 
these fields as they appear on your invoices.
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To change the order of fields on a form:
1 Click the Columns tab.

The Order column shows you how fields display from left to right on the invoice 
form. Currently, Item is the first column and Amount the last. Suppose you want 
the Qty field to appear after the Item field, and before the Description field.

2 Type 2 in the Order column in the Quantity row.

3 Type 3 in the Order column in the Description row.

Your screen should look like this:

Tip: You can click the Default button to return to original QuickBooks settings.
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Making other changes to the invoice

You can also change the information displayed in the footer – which summarises the 
invoice totals – and the company, format or printer settings.

To make other changes:
1 Click the Footer tab.

2 Suppose you did not want the outstanding balance total to be shown on the 
printed version of the invoice. Click the box next to Balance Due in the Print 
column to clear it.

3 Click the Company tab.

This is where you can change the company information printed on the invoice, 
for example, to include the company’s logo.

4 Click in the tickbox for Use logo.
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5 Navigate to the QuickBooks program folder, and select the file logo.bmp.

If you wanted to change the logo graphic at any time, you would click the Specify 
button and select a different file.

6 When QuickBooks displays a message about copying the file to the lesson 
directory, click OK.

7 Click the Format tab.

This is where you can change the formatting details if you wanted to use a 
different font for the different fields, include the invoice status, or (for 
Pro/Accountant) add trailing zeros to align quantities on the decimal point. 

For now, leave the settings as they are.

8 Click the Printer tab.

This is where you can change printer settings for this invoice type. 

For now, leave the settings as they are.

9 Click the OK button to save your changes.

Displaying your customised form

Now display the customised form to see your changes.
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To display the custom form:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Intuit Product Invoice template in the Create Invoices 
window.

2 In the Form Template field, choose My Invoice from the drop-down list.

Notice how this form reflects the changes you made. The Due Date field now 
displays onscreen and the Qty field appears before the Description field.

3 Leave the Create Invoices window open.
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Designing a custom layout for an invoice form

With the QuickBooks Layout Designer, you can change the design or layout of a form. 
In the Layout Designer, you can move, resize, change the width of columns, turn on 
or off borders around fields, and control font type and size for each field.

Here are a few examples of what you can do with a custom layout:

� Give your company name, address, and logo special treatment on the form. For 
example, you could centre your logo at the top of the form and put your company 
name and address in a special font immediately below the logo.

� Enlarge a custom field so that it can hold more information. For example, if you’re 
using a custom field to enter e-mail addresses, you can lengthen the field so that 
it can hold a long e-mail address.

� Position the customer’s billing address so that it coincides with the address 
window in the envelopes you use.

Changing the position of fields on the form

Next, you’ll use the Layout Designer to move the P.O. Number and Sample fields, and 
to decrease the width of the Quantity column.

To move fields on forms:
1 With the My Invoice template still selected, click Customise next to the Template 

field.

QuickBooks displays the Customise Template window.

2 In the “Select a template” list, select My Invoice if it isn’t already selected.

3 Click Edit.
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QuickBooks displays the Customise Invoice window that you used before.

Next, you’ll use the Layout Designer to change the design of the form.

4 Click Layout Designer.

QuickBooks displays the Layout Designer window.

By clicking the Zoom buttons, you can zoom out to see an overall view of the form 
or zoom in for a closer look at a small section of the form.

5 On the form, click the P.O. No. field.

6 Press and hold the Shift key.

7 On the form, click “Sample” field (below P.O. No).

Tip: Holding down the Shift key when clicking on an object allows you to select 
multiple fields at the same time. This lets you move the fields together.

Notice the four-directional arrow that appears when you move the cursor over the 
selected fields. The P.O. No. and Sample fields on your screen should look like this:
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8 Release the Shift key.

9 With the cursor over the selected fields, press and hold the left mouse button.

10 Drag the selected fields so that the top of the P.O. No. field is even with the top of 
the Invoice To field.

11 Release the mouse button.

Your screen should now look like this:
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Changing the width of a field

Grangeworth Kitchens Ltd rarely enter a quantity greater than four characters, so you 
want to make the Qty column smaller. Decreasing the width of the Qty column also 
increases the width of the Description column.

To change the width of a field:
1 Scroll the Layout Designer window so the Qty field is visible.

2 Click Qty to select it.

The Qty field should look like this:

Notice that when the cursor is positioned between the Qty and Description 
columns, it turns into a two-directional arrow:

3 Click and hold the left mouse button on the line separating the Qty and 
Description columns.

4 While holding down the mouse button, drag the column line to the left (just right 
of the one-inch mark on the ruler).

5 Release the mouse button.

The forms area on your screen should look like this.

Tip: If you want to change the font or border for any field, double-click the 
field. QuickBooks displays the Properties window, where you can change 
the font, font style, size and justification, and you can add or remove a 
border around the field.

6 Click OK to save the changes in the Layout Designer.

7 Click OK to close the Customise Invoice window.
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Previewing the new form

Notice that the invoice form displayed by QuickBooks doesn’t show the changes you 
just made in the Layout Designer. This is because these changes only affect the printed 
invoice and not the form QuickBooks displays for data entry.

To preview the invoice:
1 To see how the printed invoice form will look, click the Print drop-down list on 

the Create Invoices window toolbar, and then choose Preview.

QuickBooks displays the Print Preview window.

The invoice displayed in the Print Preview window shows exactly how the printed 
invoice will look, including the changes you made in the Layout Designer.

2 When you are finished looking at the preview, click Close.

3 Click Save & Close.
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Customising email for sales forms 
(Pro/Accountant)

When sending a sales form or report by email, QuickBooks displays a default message, 
which you can override on an ad-hoc basis. However, with QuickBooks 
Pro/Accountant, you can customise the default messages to use when emailing 
invoices or other sales forms. 

Suppose Grangeworth Kitchens wanted to use the contact’s first and last names, and 
include in the email message a reminder to quote the invoice number when sending 
payment.

To customise an email message:
1 From the Edit menu, choose Preferences.

2 Click Send Forms in the left scroll box.

3 Click the Company Preferences tab to display the default message text preferences.

4 Leave ‘Change default for’ set to Invoices.

5 In the first drop-down list, select To, and in the second select <First> <Last>.
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6 In the message section, add a new paragraph by typing the following:

When sending payment, please remember to quote the invoice number.

7 Click OK.

Next time you chose to email an invoice, QuickBooks would use the new version 
of the message as the default, although you could still override this.
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Using QuickBooks Letters

From time to time, you may need to send a letter to a customer or vendor (or employee 
or anyone on your Other name list), or to a list of people. With QuickBooks, you can 
easily add the pertinent QuickBooks data (such as name, address, and balance 
information) to a letter without having to re-type it.

QuickBooks Pro/Accountant provides a number of business letters focusing on 
collections, news, and announcements. You can edit these letters as needed to suit 
your business and style of communication.

Preparing collection letters

In this exercise, you’ll learn how to prepare a collection letter to send to customers 
with overdue payments.

To prepare a collection letter:
1 From the Company menu, choose Write Letters.

2 If QuickBooks prompts you to find letters, click Copy. QuickBooks will copy the 
QuickBooks letters from your installation directory to your Qbtrain folder.

QuickBooks opens the Write Letters wizard.

3 Click Prepare a Collection Letter and click Next.

4 When QuickBooks prompts you to choose who you want to write to:

� For number 1, choose Active.

� For number 2, choose Customer.

� For number 3, choose 1–30 days.
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Your screen should look like this:

5 Click Next.

QuickBooks displays a list of all active customers with payments overdue by 1–30 
days.

6 Leave all names selected and click Next.

7 When QuickBooks prompts you to choose the letter you want to use, click 
“Friendly collection” and click Next.
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8 In the Name field of the next screen, type Andrew Turner. In the Title field, type 
Director.

Your screen should look like this:

9 Click Create Letters.

10 If QuickBooks displays a message about missing information, click OK.

QuickBooks starts Microsoft Word (if it’s not running already) and displays 
collection letters for the customers that you selected.
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You can scroll through the Microsoft Word document to see the letters. Notice 
that QuickBooks entered Andrew Turner’s name and title at the end of each letter.

11 Close the Microsoft Word file without saving.

When you do save letters you’ve created using QuickBooks Letters, don’t save 
them to the QuickBooks Letters folder. That folder should only be used to store 
original QuickBooks Letters.

If you wanted to print the letters, you would choose Print from the Microsoft 
Word File menu.

12 Return to QuickBooks Pro/Accountant.

Editing a QuickBooks Letter

You can make changes to individual letters using Microsoft Word, or you can make 
global changes by editing the QuickBooks Letter used to generate a specific letter.

In this exercise, you’ll edit the collection letter you prepared in the last exercise 
(Friendly collection). However, instead of working with completed letters with 
customer information already filled in, you’ll work with the underlying QuickBooks 
Letter used to create the letters.

To edit a QuickBooks Letter:
1 From the Company menu, choose Write Letters.

QuickBooks opens the Write Letters wizard.

2 Click Design QuickBooks Letters and click Next.

3 In the screen that appears, click “View or Edit Existing Letters” and click Next.

4 When QuickBooks prompts you to choose the QuickBooks Letter you want to view 
or edit, click Overdue customers (collection letters), and then select “Friendly 
collection” from the list of available letters.
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Your screen should look like this:

5 Click Edit Letter.

QuickBooks opens Microsoft Word (if it’s not running already) and displays the 
QuickBooks Letter (Friendly collection) and a toolbar (QuickBooks Collection 
Letter Fields) that you can use to add information from QuickBooks to the letter 
in Word.

Note that you can move the toolbar by clicking it with your mouse pointer and 
dragging it to a new location.
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6 Click your mouse pointer after the full stop at the end of the first sentence and the 
press the Spacebar once. (You’ll insert a sentence into the paragraph.)

7 Type Our records show that your balance is overdue.

8 Click your mouse pointer after the word is in the sentence you just typed, and 
press the Space bar again.

9 From the Insert Collection Info. Fields drop-down list on the QuickBooks 
Collection Letter Fields toolbar, select Range(days) of Overdue Invoices.

QuickBooks adds the <<OverdueRange>> field to the sentence you just typed:

When you create letters using this modified QuickBooks letter, QuickBooks will 
replace the <<OverdueRange>> field with the number of days each customer you 
create a letter for is overdue.

10 From the Word File menu, choose Save As.
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11 Navigate to the Collection Letters folder in your Qbtrain folder and click Save.

Tip: Saving the file to the Qbtrain folder you created to use with this guide 
(instead of your QuickBooks folder) ensures you do not overwrite the 
original QuickBooks Letter.

12 To see how this change affects the final letter output, close the letter file in 
Microsoft Word and go through the “Preparing collection letters” exercise again.

Your letters should resemble this one:

13 Close Microsoft Word.



13–24

C u s t o m i s i n g  f o r m s  a n d  w r i t i n g  Q u i c k B o o k s  L e t t e r s

Printing labels

With QuickBooks Pro/Accountant, you can print labels to use when sending items or 
correspondence to customers, suppliers or employees. You have the option to exclude 
inactive customers or suppliers, and to control whether to print for specific jobs (so 
you do not get multiple labels for a customer with several current jobs for example). 
You can also manually select individual names from a list, or specify a whole or partial 
postcode. 

In the following exercise, you will explore some of the different options available. 
Note that you can print shipping labels directly from an invoice, or separately as in 
this exercise.

To print labels:
1 From the Company menu, choose Print Labels.

QuickBooks displays the Print Labels window.

2 In the Name field, select Selected names... from the drop-down list.

QuickBooks displays the Select Names window.

3 From here, you could press the Control key and select the individual names you 
wanted. For now, press Cancel.

4 Back at the Print Labels window, select Customer Type.

5 Change Sort labels by to Postcode.

6 Click the tickbox for Print Ship To addresses where available.
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Your screen should look like this:

7 To actually print the labels, you would click OK, then select the type of label 
stationery. For now, click Cancel.
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Lesson objectives
� To learn how to use multiple price levels

� To use sales orders and delivery notes with invoices

� To learn how to create job estimates

� To create an invoice from an estimate

� To display project reports for estimates

� To update a job’s status

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

Note: To complete this lesson, you must be using QuickBooks Pro or 
Accountant.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 14.qbw 
in the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Using multiple price levels

In lesson 6, you set up a new service item for Grangeworth Kitchens Ltd and assigned 
a price to that item. Sometimes businesses want to vary an item’s price based on who 
they are selling to. For example, Grangeworth Kitchens Ltd charges different prices 
depending on whether it is selling to residential or trade customers.
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You can associate price levels with specific customers so that each time you create an 
invoice (or other sales form) for that customer, QuickBooks uses the appropriate price 
level when calculating rates and amounts on the form. Price levels make it easy to use 
different rates on sales forms without having to calculate percentage amounts 
manually. Price levels affect amounts for service, stock, stock assemblies and non-
stock parts.

With QuickBooks Accountant, you can also create price levels associated with 
individual items.

In this section, you’ll create a new price level, associate it with one of Grangeworth’s 
customers, and then create an invoice for that customer.

Note: The ability to create multiple price levels is available in QuickBooks Pro 
or Accountant only. You must be using QuickBooks Pro or Accountant to 
complete the rest of this lesson.

Creating new price levels

Grangeworth Kitchens Ltd charges its residential customers the base sales price it set 
up on its Item list. The company charges its preferred trade customers 25 percent less 
than the base sales price. In this exercise, you’ll create a new price level for 
Grangeworth Kitchens to use to reduce the price to its preferred trade customers. 

For each price level you create, you assign a name and percentage increase or decrease 
to the item’s base sales price or a specific fixed price. You can create up to 100 price 
levels to use on invoices, sales receipts and credit memos. 

To create a new fixed % price level:
1 From the Lists menu, choose Price Level List.

2 From the Price Level menu button, choose New.

QuickBooks displays the New Price Level dialog box.

3 In the Price Level field type Preferred Wholesaler.

4 For the Price Level Type, select Fixed % from the drop-down list.
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5 Select “Reduce sales price by” and then type 25 in the Percentage field. Always 
enter the percentage as a positive number.

The dialog box should look like this:

6 Click OK.

The new price level appears in the list.

To create an item type price level (Accountant only):
1 From the Price Level menu button, choose New.

QuickBooks displays the New Price Level dialog box.

2 In the Price Level field type Spring Promotion.

3 For the Price Level Type, select Per Item from the drop-down list.

QuickBooks displays a list of items.

4 Scroll down the item list and click in the tick column to select

� Sinks: Butler’s sink

� Sinks: Double sink

� Taps: Mixer taps

You’ll now decrease the prices for these items by a percentage.
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5 Click on Adjust Selected Prices.

QuickBooks displays the Adjust Selected Prices dialog box.

6 Set the prices to be 10% lower than their standard price, and click OK.

QuickBooks calculates the prices for the selected items and displays them in the 
right-hand column.

You can also enter specific prices for individual items.

7 Click in the tick column next to Taps: Silver taps.

8 In the right-hand column, type the price 20.00.

Your screen should look like this:

9 Click OK.

The new price level appears in the list.

10 Close the Price Level List.

Associating price levels with customers

When you assign a price level to a customer, QuickBooks applies it when calculating 
rates and amounts on sales forms.

To associate a price level with a customer:
1 From the Customers menu, choose Customer:Job List.

2 From the Customer:Job list, choose Offa Kitchens.

3 From the Customer:Job menu button, choose Edit, and then click the 
Additional Info tab.
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4 From the Price Level drop-down list, choose Preferred Wholesaler.

Your screen should look like this.

5 Click OK to close the Edit Customer window and save your changes.

6 Close the Customer:Job list.

Using price levels on sales forms

In this section, you’ll create an invoice for Offa Kitchens to see how the newly-
associated Preferred Wholesaler price level affects amounts on the form.

To use a price level associated with a customer:
1 From the Customers menu, choose Create Invoices.

2 From the Customer:Job drop-down list, choose Offa Kitchens.

Notice that QuickBooks displays the name of the price level associated with this 
Customer:Job in parentheses above the Customer:Job drop-down list. (This
information will not be printed on the form.)

3 In the Qty field, type 2 and press Tab.

4 In the Item column, choose Chairs:Pine chair from the drop-down list. 

5 Click below 2 in the Qty field and type 4.
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6 In the Item field, choose Dressers:Pine Welsh Dresser.

Your screen should look like this:

7 Keep the invoice open and choose Item List from the Lists menu.

8 In the Item list, go to Chairs:Pine chair. Note that the price for is £30.00, but the 
rate on the invoice is £22.50. QuickBooks has automatically reduced the rate on 
the invoice by 25 percent.

Note: You can set up QuickBooks to round rates up to the next whole pound. 
From the Edit menu, choose Preferences. Choose Sales & Customers from 
the scroll list and then click the Company Preferences tab. Click the. 
“Round all sales prices up to the next whole pound” tickbox and click OK

9 Scroll to Dressers:Pine Welsh dresser and note that the base sales price is £360.00, 
while the rate on the invoice using the Preferred Wholesaler price level is £270.00, 
or 25 percent less.

10 Close the Item list.

11 Record the invoice by clicking Save & Close.

Assigning price levels to individual line items

In addition to associating price levels with customers, you can also use price levels on 
an ad-hoc basis on sales forms. For example:
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� You’ve associated a price level with a customer, but want to charge the base sales 
price for an item on a sale to that customer.

� You want to use a price level for one or more items, but you don’t want to assign 
a price level to the customer for whom you’re recording the sale.

To apply a price to a single line item: 
� Click in the Price column and select the price level you want to use from the 

drop-down list.

QuickBooks applies the price and recalculates the amount and balance due.

Using sales orders and delivery notes

If you’re using QuickBooks Pro or Accountant, you can use sales orders to manage 
customer orders for products not in stock or services not yet available, without 
affecting your account balances. You can use sales orders in two ways:

� Create a sales order, then create an invoice based on the sales order.

� Create a sales order from an invoice on which one or more items are out of stock.

In addition, you can create a delivery note from a sales order (or from an invoice) to 
include with the goods when you ship them.

With QuickBooks Accountant, you can also generate a purchase order from a sales 
order.

In this exercise, you’ll create a sales order for Franklin Guest House which you’ll use 
as the basis of an invoice and delivery note. First, you must enable the sales orders 
function.

To enable sales orders:
1 From the Edit menu, select Preferences.

2 In the left panel of the Preferences window, select Sales & Customers.

3 Click the Company Preferences tab.

4 Click the tick boxes for “Enable Sales Orders” and the two tick boxes beneath it, if 
they are not already ticked.

5 Click OK.

QuickBooks closes all active windows in order to change the settings.
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Creating sales orders

The sales order form works like the other sales forms in QuickBooks.

To create a sales order:
1 From the Customers menu, select Create Sales Orders.

QuickBooks displays the Create Sales Orders window:

2 In the Customer:Job field, select Franklin Guest House:Residents Dining Room.

QuickBooks fills in the address details.

3 Click in the Item field on the first line and select Chairs:Oak chair from the drop-
down list.

QuickBooks fills in the description and price details.

4 Click in the Ordered field on the first line, type 4 and press Tab.

QuickBooks calculates the totals for the first line.

5 Click in the Item field on the second line and select Tables:Oak table from the 
drop-down list.

QuickBooks fills in the description and price details.

6 Click in the Ordered field on the second line, type 1 and press Tab.

QuickBooks calculates the totals for the second line.

7 Click in the Item field on the third line and select Dresser:Oak Welsh dresser from 
the drop-down list.

QuickBooks fills in the description and price details.
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8 Click in the Ordered field on the third line, type 1 and press Tab.

QuickBooks calculates the totals for the third line. Your screen should now look 
like this:

9 Click Save & Close.

Creating invoices from sales orders

When you are ready to send Franklin Guest House an invoice, you can generate it 
directly from the sales order you’ve created.

To create an invoice from a sales order:
1 From the Customers menu, select Create Sales Orders.

QuickBooks displays the Create Sales Orders window.
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2 Click the Previous button until your Franklin Guest House sales order is displayed:

Note that the Invoiced and Clsd (closed) columns now appear to the right of the 
Total column.

3 Click the Create Invoice button (top right).

QuickBooks displays the Create Invoice Based On Sales Order dialog box:
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4 Click “Create invoice for selected items”, then click OK.

QuickBooks displays the Specify Invoice Quantities dialog box:

For each item, the quantities on hand, ordered, previously invoiced, and to 
invoice are shown. 

5 Click OK.

QuickBooks displays the invoice:

Note: If there are any items which are out of stock, they would be shown on the 
form but not printed. You can check this in the Print Preview window.

6 Click Save & New.

7 Click Back to return to the saved invoice.
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Creating delivery notes

You can now print a delivery note corresponding to your invoice. If you wished, you 
could also print a shipping label in a similar way.

To print a delivery note:
1 From the drop-down menu next to the Print button, select Print Delivery Note:

QuickBooks creates the delivery note and displays the Print window:

2 Click Preview.

You can see the delivery note includes the items and quantities, but not the prices.

3 At this stage you would normally print the delivery note, but for now click Close 
then Cancel.

The invoice is redisplayed.

4 Click Save & Close.
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Creating sales orders from invoices

If you choose items on an invoice which are out of stock, you can create a sales order 
for the items which you are unable to supply. In this exercise, you’ll see how to set 
QuickBooks to warn you when items aren’t in stock, then you’ll create a sales order for 
such an item.

With QuickBooks Accountant, you can then create a purchase order from that sales 
order.

To enable out-of-stock warnings:
1 From the Edit menu, select Preferences.

2 In the left panel of the Preferences window, select Purchases and Suppliers.

3 Click the Company Preferences tab.

Make sure the tick boxes for “Purchase Orders and Stock” are ticked as shown:

4 Click OK.

QuickBooks closes all active windows in order to change the settings.

To create a sales order from an invoice:
1 From the Customers menu, select Create Invoices.

QuickBooks displays the Create Invoices window.

2 In the Customer:Job field, select Mr Williams from the drop-down list.

QuickBooks fills in the address details.

3 Click on the Quantity field on the first line and type 5.

4 Click on the Item field and select Chairs:Oak chair from the drop-down list.

QuickBooks displays this warning:
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5 Click OK.

QuickBooks fills in the item description and price.

6 Click Save & Close.

QuickBooks displays this warning:

7 Click Yes.

QuickBooks displays the Specify Quantities to Place on Sales Order window:

This shows the quantities ordered, on hand, on other sales orders, available (on 
hand less other SOs). You can amend the quantities to invoice and to transfer to 
the sales order, or add other out-of-stock items. 

Since there are no oak chairs in stock, the To Invoice column shows zero and To 
Sales Order shows five oak chairs.

8 Click OK.
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QuickBooks displays the order in the Create Sales Orders window.

9 Click Save & Close.



                                                                                                

14–17

L E S S O N  1 4

Creating purchase orders from sales orders (Accountant only)

With QuickBooks Accountant, if you do not have sufficient stock (or if you wanted to 
order additional stock for items that appear on a sales order), you can generate a 
purchase order directly from the sales order you’ve created.

In this exercise, you’ll create a purchase order for the oak chairs on Mr Williams’ sales 
order. You must have QuickBooks Accountant to carry out this exercise, otherwise 
proceed to the next section, ‘Creating jobs and estimates’.

To create a purchase order from a sales order:
1 From the Customers menu, select Create Sales Orders.

QuickBooks displays the Create Sales Orders window.

2 Click the Previous button until your Mr Williams sales order is displayed:

3 Click the down arrow next to the Create Invoice button (top right) and choose 
Purchase Order.

QuickBooks displays the Create Purchase Order Based On The Sales Transaction 
dialog box:
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4 Click “Create purchase order for all allowed items”, then click OK.

QuickBooks displays the purchase order, with Grangeworth Kitchens’ usual 
supplier for oak chairs already filled in. Notice that the memo field shows which 
sales order it relates to:

5 Click Save & Close.

Creating jobs and estimates

An estimate is a description of work or products you propose to sell to a current or 
prospective customer. You can have more than one estimate for each name (customer 
or customer:job combination). If the customer accepts the estimate, you can turn the 
estimate into an invoice, modifying it as necessary. When you have actual costs and 
revenues, you can compare them to your estimated costs and revenues to see if you 
were over or under the estimate.

Estimates are “non-posting” transactions—they do not affect any financial reports or 
income and expense balances. QuickBooks allows you to create invoices from 
estimates either by transferring the entire estimate to an invoice or by allowing you to 
choose a percentage or selected items to invoice from the estimate. The ability to bill 
for only a percentage of the estimate or selected items on an estimate is called progress 
invoicing.

When you create a new QuickBooks company using the EasyStep Interview, 
QuickBooks asks you if you use estimates and/or progress invoicing. If you respond 
yes, QuickBooks turns on these features for you (Pro/Accountant only). If you respond 
no, you need to turn on these features in order to use them. 
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Turning on estimates and progress invoicing

To turn on estimates and progress invoicing in QuickBooks:
1 From the Edit menu, choose Preferences.

2 Click Jobs & Estimates in the left scroll box.

3 Click the Company Preferences tab to display the job and estimate preferences.

QuickBooks displays the Jobs and Estimates Preferences window:

4 Click Yes for “Do You Create Estimates?”

5 Click Yes for “Do You Do Progress Invoicing?”

6 Click OK to record and close the Preferences window.

Creating a new job

Now that you’ve turned on estimating, you can add a new job for a kitchen renovation 
project for your customer, Sutton Housing Association. Then you’ll create an estimate 
for the job.

To create a new job:
1 From the Customers menu, choose Customer:Job List.

2 In the Customer:Job list, select Sutton Housing Association.

3 Click the Customer:Job menu button, and then choose Add Job.
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QuickBooks displays the New Job window.

4 In the Job Name field, type Kitchen refurbishment Flats 25-30.

5 Click the Job Info tab.

QuickBooks displays the Job Info portion of the New Job window.

6 In the Job Status field, select Pending from the drop-down list.

7 In the Start Date field, type 05/05/2008.

8 In the Projected End field, type 12/05/2008.

9 In the Job Description field, type Remodel kitchens.
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10 In the Job Type field, type Renovations and press Tab, then click QuickAdd.

Job types give you a way to classify your jobs so you can group and subtotal similar 
jobs on your reports. By using them, you’ll be able to determine which kinds of 
jobs are the most profitable for your business.

Your screen should resemble this one:

11 Click OK.

QuickBooks returns you to the Customer:Job List.

Notice that the new kitchen refurbishment job is listed as a pending job for Sutton 
Housing Association. 
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Writing an estimate

Now that you’ve created a new job for the kitchen refurbishment, you can create an 
estimate for it.

To create an estimate:
1 In the Customer:Job list, select Sutton Housing Association:Kitchen refurbishment 

Flats 25-30 (make sure you don’t select one of their other jobs).

2 Click the Activities menu button, and then choose Create Estimates.

If QuickBooks displays a message about change tracking, click OK.

QuickBooks displays the Create Estimates window for this customer and job. You 
learned in Lesson 6 how to fill in an invoice form, so this form should be familiar.

3 Press Tab to accept Sutton Housing Association:Kitchen refurbishment Flats 25-30 
in the Customer:Job field.

Notice that QuickBooks enters the customer’s name and address in the appropriate 
area of the form.

4 In the Estimate No. field, type 11.

5 In the Item column, type Fitting.

Before you can finish typing, QuickBooks has filled it in for you, and QuickBooks 
fills in any default description for this item.

6 Press Tab twice to move to the Qty field.

7 Type 69 in the Qty field, and then press Tab.

The total amount is calculated by QuickBooks when you move out of this field.

8 In the Markup field, type 60%.

9 Click the line under “Fitting” in the Item column.
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10 Select Pine Kitchen Cabinets:Pine base cabinet.

11 Press Tab twice to move to the Qty field, and then type 6.

12 On the next line in the Item column, choose Sinks:Double sink.

13 Press Tab twice to move to the Qty field, and then type 6.

Your estimate should look like this:

Notice that QuickBooks has filled in most of the information for the estimate 
based on the items selected.

Note: The version on screen shows all the markup information, but the version 
you send to the customer does not show this. Click the arrow next to the 
Print button, and choose Preview to see the customer’s version.

14 Click Save & Close to save the estimate.

QuickBooks returns you to the Customer:Job list. Notice the Estimate Total 
column for the Pending kitchen refurbishment job for Sutton Housing Association 
Flats 25-30 now has a balance of 7966.50.
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Creating multiple estimates

You can create multiple estimates for a customer or job. This is useful if you wish to 
issue estimates reflecting “best-case” and “worst-case” scenarios, or based on different 
grades of materials. Any one of these estimates can be used to create invoices in the 
usual way. 

To create an additional estimate:
1 From the Customers menu, select Create Estimates.

2 In the Customer:Job field, select Sutton Housing Association:Kitchen refur-
bishment Flats 25-30, and press Tab.

3 For the first item line, select Fitting, with a quantity of 75 and a markup of 80%.

4 For the second item line, select Pine base with drawer, with a quantity of 6.

5 For the third item line, select Sinks:Butler’s sink, with a quantity of 6.

6 Click Save & New.

7 On the Customer:Job list, notice the Estimate Total column for the Pending 
kitchen refurbishment job for Sutton Housing Association Flats 25-30 now has a 
balance of 17660.25.

Tracking changes to an estimate (Accountant)

If you wish, you can amend an estimate and track the changes on the estimate itself 
(Accountant only). 

To track changes to an estimate (Accountant only):
1 In the Create Estimates window, click Previous to return to the estimate you just 

created.

2 On the pine base cabinets with drawers line, amend the quantity to 12.

3 Click Save & Close.

QuickBooks displays a message asking if you want to track the change on the 
estimate:
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4 Click Add.

QuickBooks records the changes on the estimate.

5 Click Previous to redisplay estimate 12 if not shown, and scroll down or enlarge 
the estimate window to see the change record (in the Description column):

6 On the Customer:Job list, notice the Estimate Total column for the Pending 
kitchen refurbishment job for Sutton Housing Association Flats 25-30 now has a 
balance of 18858.75.
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Creating an invoice from an estimate

Once you have created your estimate(s) and the customer has approved the job, you 
can use the appropriate estimate to invoice the customer. There are two methods of 
doing this: you can open the estimate and choose to create the invoice from there (in 
much the same way as you did when creating an invoice or purchase order from a sales 
order in earlier exercises), or you can create an invoice and choose the estimate on 
which to base it. In the following exercise, you’ll use the latter method.

This exercise uses QuickBooks Pro/Accountant’s progress invoicing feature.

Progress invoicing (also known as progress billing), lets you invoice for jobs that you 
work on and complete in phases. When using progress invoicing, you start by creating 
an estimate for the job (you don't have to give this estimate to the customer). Then, 
as you complete each phase, you can easily transfer items from the original estimate 
to an invoice. You can specify which items to include on each invoice and change 
estimated amounts or percentages. When you use estimates to create progress 
invoices, you can run reports to help you track your estimated versus actual costs.

To create an invoice from an estimate:
1 In the Customer:Job list, select Sutton Housing Association:Kitchen refurbishment 

Flats 25-30.

2 Click the Activities menu button, and then choose Create Invoices.

QuickBooks displays the Create Invoices window.

3 Press Tab in the Customer:Job field.

QuickBooks displays the available estimates for this job:
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4 Highlight the first estimate (11) and click OK.

QuickBooks displays the Create Progress Invoice Based On Estimate dialog box.

Grangeworth Kitchens Ltd are going to bill for one-third of the job before starting 
work, one-third when the project is one-third complete, and the final one-third 
when the job is completed.

5 Select “Create invoice for a percentage of the entire estimate.”

6 Type 33.333 in the “% of estimate” field.

If you needed to invoice for only selected items on an estimate or for varying 
percentages or amounts for different items, you would select the option “Create 
invoice for selected items or for different percentages of each item.” QuickBooks 
then displays a table of all items on the estimate and allows you to select which 
items you want to include and the amounts for each item.

7 Click OK.

QuickBooks completes the invoice for one-third of each item on the estimate. 
Your invoice should resemble this one:

Notice that QuickBooks changed the invoice template to Progress Invoice and 
added fields for estimate amount, prior amount, and total %. QuickBooks will also 
keep track that one-third of the Sutton Housing Association kitchen refur-
bishment job has been invoiced and that two-thirds has not yet been invoiced.
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Note: If you don’t want your customers to see this level of detail on the invoice 
you send them, you can customise the invoice to remove some of these 
columns from the printed form. See Lesson 13, “Customising forms”, for 
more information.

8 Click Save & Close to record the invoice.

9 Close the Customer:Job List window.

Creating sales or purchase orders from estimates 
(Accountant)

With QuickBooks Accountant, you also have the ability to create a sales order or a 
purchase order based on an estimate.

In this case, you would open the estimate, click the button next to Create Invoice, and 
choose either Sales Order or Purchase Order (there is also the option to create an 
invoice). This is much the same as the method you used when creating a sales order 
from Mr Williams’ invoice earlier.
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Displaying reports for estimates

QuickBooks provides five reports on estimates, as described in the following table. You 
can create these reports from the Jobs, Time & Mileage submenu in the Reports menu.

Displaying the job progress invoices vs. estimates report

Since you’ve just completed a progress invoice, you can see how QuickBooks 
Pro/Accountant records this on the Job Progress Invoices vs. Estimates report. 

To display the job progress invoices vs. estimates report:
1 From the Reports menu, choose Jobs & Time, then Job Progress Invoices vs. Esti-

mates to display this report (you may need to change the Dates to show All):

In this case, only the estimates and progress invoice you completed for Sutton 
Housing Association are shown. The amount of the progress invoice is shown in 
the Progress Invoice column. The % Progress column shows how much of the total 
estimate you’ve invoiced so far.

2 Close the report window.

Report Description

Job Estimates vs. Actuals Summary Compares estimated cost to actual cost and 
estimated revenue to actual revenue for all 
customers and jobs.

Job Estimates vs. Actuals Detail (for 
one job)

For a particular customer or job, compares 
estimated costs to actual costs and estimated 
revenues to actual revenues.

Job Progress Invoices vs. Estimates Compares each estimate with progress invoices 
based on the estimate.

Item Estimates vs. Actuals For each item, compares estimated cost to 
actual cost and estimated revenue to actual 
revenue.

Estimates by Job Shows for all estimates whether they are active 
and the amount, sorted by Customer:Job..
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Updating job status

Every time you change the status of a job, you should update its job status in the 
Customer:Job list. For example, the estimate for the kitchen remodel is no longer 
pending: Sutton Housing Association awarded you the job and you have started work.

To update the status of a job:
1 From the Customers menu, choose Customer:Job List.

QuickBooks displays the Customer:Job list.

2 In the list, select Sutton Housing Association:Kitchen refurbishment Flats 25-30.

3 Click the Customer:Job menu button, and then choose Edit.

QuickBooks displays the Edit Job window.

4 Click Job Info.

QuickBooks displays the Job Info portion of the Edit Job window.

5 In the Job Status field, select “In progress.” 

Your screen should look like this:

6 Click OK.

QuickBooks returns you to the Customer:Job list. The Customer:Job list now 
shows this project as being in progress.

7 Close the Customer:Job list.
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Lesson objectives
� To turn on the multicurrency preference in QuickBooks Pro/Accountant

� To learn how to set up foreign accounts

� To create foreign customers and suppliers

� To see how to add foreign prices to items

� To produce foreign invoices

� To maintain foreign-exchange rates

� To describe how QuickBooks treats the Exchange Gain/Loss account

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

Note: To complete this lesson, you must be using QuickBooks Pro or 
Accountant.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 15.qbw 
in the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Turning on multicurrency

In this lesson, you’ll learn how to set up QuickBooks to record transactions in 
currencies other than pounds sterling. Once this is done, QuickBooks accounts for and 
integrates foreign currency transactions seamlessly with the rest of the business.
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Note: Once multicurrency has been selected for a company, it cannot be turned 
off again for that company.

Suppose Grangeworth Kitchens Ltd arranges to supply kitchen fittings to a Belgian 
firm, Maisons Magritte. The first thing you need to do is to turn on the multicurrency 
preference.

To turn on multicurrency:
1 From the Edit menu, select Preferences to display the Preferences window.

2 From the scroll box on the left, select Accounting.

3 Click on the Company Preferences tab to display it:

4 Click the “Use multicurrency” tickbox. 

QuickBooks displays this message:

5 Click Yes to confirm.

QuickBooks fills in “United Kingdom Pounds” as the home currency (in which 
Grangeworth Kitchens Ltd normally deals). The multicurrency section on the tab 
now looks like this:

6 Click OK.
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Updating the Currency list

If you are doing business in a foreign currency, it’s important to keep the Currency list 
in QuickBooks up to date.

Grangeworth Kitchens Ltd needs to update the Euro rate. In QuickBooks, you can keep 
up to date with currency rates by downloading them, or amend them manually. 

To update a foreign-exchange rate:
1 From the Lists menu, select Currency List to display it:

If you wanted to download the latest rates, you would click the Currency menu 
button and select Download Current Exchange Rates. For this exercise, you’ll 
update the Euro rate manually.

2 Highlight Euro.

3 Click the Currency menu button and select Edit.

QuickBooks displays the Edit Currency window:

4 In the Exchange Rate field, type 0.6186.

5 Click OK.

QuickBooks updates the rate in the Currency List:
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Setting up foreign accounts

Now that you have turned multicurrency on and updated the Euro exchange rate, the 
next step is to set up Euro accounts for Accounts Receivable (for invoices to Maison 
Magritte) and Accounts Payable (for travel expenses, shipping, etc.).

To set up a foreign Accounts Receivable account:
1 From the Company menu, choose Chart of Accounts.

2 Click the Account menu button and select New.

QuickBooks displays the New Account window. 

3 In the Type field, select Accounts Receivable.

4 In the Name field, type European A/R.

5 In the Currency field, select Euro from the drop-down list.

QuickBooks fills in the exchange rate held in the Currency list. 
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The window now looks like this:

6 Click OK.

Now set up the European Accounts Payable account.

To set up a foreign Accounts Payable account:
1 In the Chart of Accounts window, click the Account menu button and select New 

Account to redisplay the New Account window. 

2 In the Type field, select Accounts Payable.

3 In the Name field, type European A/P.

4 In the Currency field, select Euro from the drop-down list.

5 Click OK.

The Chart of Accounts now shows the two new accounts (you may need to enlarge 
the window or scroo down to display both):
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Creating foreign customers and suppliers

Now you need to create Maisons Magritte as a new customer.

To create a new foreign customer:
1 From the Customers menu, select Customer:Job list to display it.

2 Click the Customer:Job menu button and select New.

QuickBooks displays the New Customer window:

3 In the Customer and Company Name fields, type Maisons Magritte.

QuickBooks fills in the first line of the Bill To field.

4 In the Currency field, select Euro from the drop-down list.

QuickBooks fills in the Exchange Rate field.

5 On the second line of the Bill To field, type 222 Rue de Commerce, then press Return.

6 On the third line of the Bill To field, type 1000 Brussels, then press Return.

7 On the fourth line of the Bill To field, type Belgium, then press Return.

8 Click the Copy button to copy the address to the Ship to field.
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Your screen should look like this:

9 Click the Additional Info tab to display it:

10 In the Price Level field, type Overseas Customer and press Tab.

11 When QuickBooks displays a message that this price level is not on the Price Level 
list, click Set Up.

12 Select Fixed % as the Price Level Type.

13 Select Increase and type 5 for the Percentage.

14 Click OK to confirm the Price Level details.
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15 Click OK to confirm the new Customer details.

The Customer:Job list now shows Maisons Magritte:

Grangeworth Kitchens Ltd employees stay at the Hotel Brel when visiting Maisons 
Magritte in Brussels. Now set up Hotel Brel as a supplier.

To create a foreign supplier:
1 From the Suppliers menu, select Suppliers List to display it.

2 Click the Supplier menu button and select New.

QuickBooks displays the New Supplier window:

3 In the Supplier and Company Name fields, type Hotel Brel.

QuickBooks fills in “Hotel Brel” on the first line of the Address field and in the 
Print on Cheque as field.

4 In the Currency field, select Euro from the drop-down list.

QuickBooks fills in the Exchange Rate field.

5 On the second line of the Address field, type Konigstraat 240.

6 On the third line of the Address field, type 1000 Brussels.

7 On the fourth line of the Bill To field, type Belgium, then press Tab.
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Your screen should look like this:

8 Click OK.

The Hotel Brel now appears in the Supplier list:

Adding foreign prices to items

If you regularly buy or sell items in a foreign currency, you can add a foreign price to 
these items. This protects you from fluctuations in the exchange rate.

Grangeworth Kitchens Ltd wants to set up a European price for its oak dressers. First 
you have to turn on the foreign pricing preference.

To turn on foreign pricing:
1 From the Edit menu, select Preferences to display the Preferences window.

2 From the scroll box on the left, select Accounting.

3 Click on the Company Preferences tab to display it.

4 Click the “Use foreign prices on items” tickbox. 
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5 Select Euro from the drop-down list in the Foreign item currency field.

The window looks like this:

6 Click OK.

Now add the foreign price for oak dressers.

To add a foreign price:
1 From the Lists menu, select Item List to display it:

2 Highlight Oak Welsh dresser in the list.

3 Click the Item menu button and select Edit.
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QuickBooks displays the Edit Item window:

4 In the Sales Information section, type 650.00 in the Foreign Price field.

5 Click OK.

Creating a foreign invoice

To see how this all fits together, create an invoice for Maisons Magritte’s first shipment 
of oak dresser.

To create a foreign invoice:
1 Click the Invoice button on the toolbar.

QuickBooks displays the Create Invoice window.

2 In the Customer:Job field, select Maisons Magritte from the drop-down list.

3 In the Quantity field, type 3.

4 In the Item field, select Dressers:Oak Welsh dresser from the drop-down list.
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QuickBooks has selected the European A/R account for this invoice and displays a 
price (682.50 euros) which is the foreign price you have just entered (650 euros) 
increased by the overseas customer price level (+5%):

5 In the VAT column, you would use a European VAT code (like those you set up in 
lesson 11). For now, select Z (zero-rated) from the drop-down list.

Your invoice form should now look like this, showing a total amout of 2047.50 
euros.

6 Click Save & Close.

7 To see how QuickBooks automatically converts foreign amounts for reports, 
generate a Customer Balance Summary. From the Reports menu, select Customers 
and Receivables, and then Customer Balance Summary.
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Note that QuickBooks has converted Maison Magritte’s 2047.50 euro balance into 
£1266.58:

8 Close the report.

Entering and paying foreign bills

As with foreign customers, handling bills from foreign suppliers is quite similar to the 
procedure for domestic suppliers.

Andrew Turner pays a visit to Maisons Magritte and stays at the Hotel Brel. You need 
to enter and then pay the bill.



                                                                                                

15–15

L E S S O N  1 5

To enter a foreign bill:
1 Click the Bill button on the toolbar to display the Enter Bills window:

2 In the Supplier field, select Hotel Brel from the drop-down list.

QuickBooks changes to the European A/P account and the Amount Due field is 
now prefixed with the euro symbol.

3 Type 750 in the Amount Due field.

4 On the Expenses tab, type Travel & Ent:Travel in the Account column.

5 Select Maisons Magritte in the Customer:Job column.

Your screen should look like this:

6 Click Save & Close.
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To pay a foreign bill:
1 From the Suppliers menu, select Pay Bills to display the Pay Bills window:

2 In the A/P Account field, select European A/P from the drop-down list.

The bill from the Hotel Brel now appears:

3 Click in the tick column to select the Hotel Brel bill.

4 Under Payment Method, select Cheque.

Note: If you do much business in a foreign currency, you will probably want to 
open a bank account in that currency.

5 Click the “To be printed” option.

6 Click Pay & Close.
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Exchange rate gains and losses

If you do business in foreign currencies, changes in exchange rates produce two types 
of gains and losses: 

� Unrealised gains and losses arise on transactions that haven’t been completed.

� Realised gains and losses arise once transactions have been completed.

Example: Grangeworth Kitchens Ltd’s invoice for 2047.50 euros was worth £1266.56 at 
the exchange rate of .6186 prevailing on the day it was written.

If the rate goes up to .6273 a week later, the invoice is now notionally worth £1284.40, an 
unrealised gain of £17.84.

If the rate is down to .6224 when the invoice is paid, its actual worth is £1274.36, a realised 
gain of £7.80.

For a full explanation of how QuickBooks treats foreign-exchange gains and losses, as 
well as descriptions of more advanced multicurrency operations, see “Using multiple 
currencies (Pro only)” in the QuickBooks User’s Guide.
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Lesson objectives
� To learn how to track time worked on a project

� To learn how to invoice a customer for time worked on a project

� To create project reports for time tracking and learn about other project reports in 
QuickBooks 

� To learn how to set up items used to track time worked by owners or partners

� To learn how to pay non-employees for time worked

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

Note: To complete this lesson, you must be using QuickBooks Pro or 
Accountant.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 16.qbw 
in the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.
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Tracking time and mileage

Tracking time

QuickBooks Pro/Accountant provides time tracking for any job. Time tracking lets you 
keep track of the time a person spends on each job (including sick and holiday time 
and time spent for general overhead). The person whose time you track can be an 
employee, an owner or partner, or a subcontractor. 

You can use time data to:

� Invoice the customer for the time spent doing a job.

� Provide hours worked on an employee’s pay cheque, or a cheque to a 
non-employee (supplier, owner, or partner).

� Track the cost of employees’ gross pay by job.

� Report on the number of hours worked—by person, by job, or by item.

Turning on time tracking in QuickBooks 

First you must turn on time tracking if this has not been done.

To turn on time tracking:
1 From the Edit menu, choose Preferences.

2 Click Time Tracking in the left scroll box. Then click the Company Preferences tab.

This screen is displayed:

3 Click Yes for “Do You Track Time?” if not already selected.

4 You have the option to change the first day of the week, but for now leave it as 
Monday.

5 Click OK to save the preferences.
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Entering time data in QuickBooks 

There are three ways to get time data into a QuickBooks  company file:

� Enter time directly on a weekly timesheet or single activity form.

� Use the Stopwatch to time an activity while you are performing it.

� Use the QuickBooks Timer program to track time and then import the time data 
directly into QuickBooks.

When you track time with QuickBooks , you have a choice of two forms to enter time: 
Weekly Timesheet or Time/Enter Single Activity window. If you want to enter time for 
multiple jobs or multiple days, then the Weekly Timesheet is the best choice.

If you tend to enter detailed notes about your activities, or you prefer to enter time 
data as you complete an activity, use the Time/Enter Single Activity window instead.
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Information you enter in the Time/Enter Single Activity window displays in the 
Weekly Timesheet, and vice versa. They’re different views of the same information.

The Timer program is useful when you have employees or subcontractors who need 
to track their time but don’t need or want to run QuickBooks. When time is imported 
into QuickBooks  from the Timer application, you view the imported data on the same 
timesheets you would use if you entered the data directly into QuickBooks.

If you have employees who don’t have access to a computer, you can print blank 
copies of the weekly timesheet for your employees to fill in by hand.

To print a blank timesheet:
1 From the Employees menu, choose Time Tracking, then Use Weekly Timesheet.

2 From the Print drop-down menu, choose Print Blank Timesheet.

3 In the Print Timesheets window, click Print.

Recording employee time on a weekly timesheet

In this exercise, you’ll complete a weekly timesheet for Charlie Walker. In a later 
exercise, you’ll learn how to invoice a customer for the time Charlie spent working on 
a job for that customer.

To enter information on a weekly timesheet:
1 From the Employees menu, choose Time Tracking, then Use Weekly Timesheet.

QuickBooks displays the Weekly Timesheet window.

By default this window shows the current week, but you can choose to record time 
spent on a different week. To do this, you would click Set Date, and type in a new 
date.

2 In the Name field, select Charlie S. Walker from the drop-down list.

QuickBooks will track the time you enter for this employee and display it when 
you are ready to pay employees.
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3 Click in the Customer:Job column, and then choose Sutton Housing Association: 
Kitchen refurbishment Flats 19-24 from the drop-down list.

QuickBooks will associate the time that you enter in this window with the kitchen 
refurbishment being completed on flats 19-24 for Sutton Housing Association.

4 In the Service Item column, type Fitting.

After you type a few characters, QuickBooks fills in the rest of the item for you. 
The Item list, which contains all the services and goods your business provides, is 
the same list that is available to you on invoice forms and throughout 
QuickBooks.

Notice that QuickBooks fills in the information in the Payroll Item column for 
you.

Charlie Walker is paid by the hour. QuickBooks has his hourly rate stored in the 
Employee list, on the Payroll Info tab.

Tip: If you try to select a payroll item that is not associated with this employee, 
QuickBooks displays a warning message. For example, if you try to select 
Salary as the payroll item for Charlie Walker, QuickBooks tells you that 
you do not have that type of payroll item set up for the employee. (It still 
lets you make the selection, but it warns you that the Salary is set up with 
a £0.00 rate.)

5 In the Payroll Item column, select Hourly Pay.

6 Click in the M 31 column.

M stands for Monday and 31 for the date: Monday, 31 March 2003. Monday is 
shown as the first day of the working week, as you specified in Preferences earlier.

7 Type 8 to enter the number of hours worked on Monday and press Tab.

8 If a warning appears, click Yes to clear it.

9 In the Tu field, type 8 and press Tab.

As you enter each day’s hours, the week’s total hours appear in the Total column.
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10 Type 8 in the fields for W, Th and F, and press Tab.

Your screen should resemble this one:

The invoice icon to the right of the Total column tells QuickBooks if the time will 
be transferred onto an invoice. In its current setting, you’re telling QuickBooks  
that you do want to invoice the customer for time worked. 

If you do not plan to invoice the customer for time worked, you can click the 
invoice icon and QuickBooks  displays a red “X” over it. 

11 Click Save & Close to record the Weekly Timesheet.

QuickBooks records the time for Charlie Walker and for Sutton Housing Associ-
ation’s kitchen refurbishment job.

This time can now be transferred onto an invoice for Sutton Housing Association’s 
kitchen refurbishment job or used to create a pay cheque for Charlie Walker.

Tracking mileage

By tracking your vehicle mileage, you can enter, sort, and print lists of your vehicles 
and the mileage you've driven for work-related tasks. You can use this information for 
your tax deductions (if applicable) and for billing your customers.

You cannot use this feature to reimburse employees or suppliers for mileage. Nor can 
you track specific vehicle expenses, such as fuel or tolls with this feature. However, you 
can track these types of expenses by entering bills for them as the expenses are 
incurred by employees.

Important: Intuit recommends that you consult your tax advisor, accountant,
Inland Revenue or HMRC to determine if you can deduct the costs of
operating and maintaining your vehicle and which method you
should use.
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Entering mileage

To record mileage:
1 From the Company menu, choose Enter Vehicle Mileage.

2 In the Vehicle field, type Ford Transit Van and press Tab.

3 When QuickBooks tells you that Ford Transit Van is not on the Vehicle List, click 
QuickAdd. 

4 Change the Trip Start Date and Trip End Date to 17/12/2007.

5 For Total Miles, type 24.

6 Make sure the box for Billable is ticked.

7 For Customer: Job, select Sutton Housing Association: Kitchen refurbishment Flats 
19–24.

8 For Item, type Mileage and press Tab.

9 When QuickBooks tells you that Mileage is not on the Item list, click Set Up.

QuickBooks displays the New Item window.

10 Set up the Mileage item as follows:

� Type – Other Charge

� Description – Chargeable mileage

� Amount or % – 0.43

� Sales VAT Code – S

� Account – Motor Expense
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11 Click OK to return to the Enter Vehicle Mileage window.

Your screen should resemble the following:

12 Click Save & New.

13 Add two more entries for the same vehicle and customer:job as follows:

� 18 December – 12 miles

� 19 December – 12 miles

Since you have already set up the Ford Transit Van vehicle and the Mileage item, 
you can select them from the relevant drop-down lists when you enter these fields. 
Remember to tick the Billable box.

Invoicing a customer for time and mileage

Now you can invoice Sutton Housing Association for the time Grangeworth Kitchens 
Ltd’s employee, Charlie Walker, spent on the kitchen refurbishment job, and for the 
mileage incurred.

To create an invoice based on time:
1 From the Customers menu, choose Create Invoices.

2 Select Sutton Housing Association:Kitchen refurbishment Flats 19-24 in the 
Customer:Job field.

3 If QuickBooks displays a reminder that the customer has outstanding billable time 
or costs, click OK.

4 In the Date field, type 21/12/2007, if it is not shown already.

5 Click Time/Costs in the Create Invoices window. 

QuickBooks displays the Choose Billable Time and Costs window.
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6 Click the Time tab.

QuickBooks displays the information entered on Charlie Walker’s timesheet for 
the Sutton Housing Association kitchen refurbishment job:

Note: QuickBooks  by default displays each line from the timesheet with the same 
service item as a line item on the invoice. If you prefer to combine all lines 
into one line item, click the Options button and select “Combine activities 
with the same service item”. In the Options for Transferring Billable Time 
window, you can also select to transfer notes about time activities (in 
addition to descriptions) onto invoices.

7 Click Select All to use all lines representing time worked by Charlie Walker.

QuickBooks places a tick in the Use column to the left of each entry.
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8 Click OK.

Your invoice should now resemble this:

9 Keep the invoice open to use in the next exercise.

To create an invoice based on mileage:
1 In the Create Invoices window, click Time/Costs.

2 Click the Mileage tab.

QuickBooks displays the information you entered for the three trips for this job:

3 Click Select All.
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4 Click OK.

Your invoice should now resemble this:

5 Click Save & Close to record the invoice.
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Displaying project reports for time and mileage 
tracking

QuickBooks  provides four reports on time, as described in this table. You can create 
these reports by choosing Jobs, Time & Mileage from the Reports menu.

There are also four mileage reports, available from the same menu:

Displaying the Time by Job report

The Time by Job summary report summarises the total hours for each job, and the 
Time by Job detail report breaks down those summary figures into hours for each 
service item and hours for each customer:job.

Project report Description

Time by Job 
Summary

Shows hours worked subtotalled first by customer or job and 
then by service item.

Time by Job Detail Lists each time activity (that is, work done by one person for 
a particular customer or job on a specific date), and shows 
whether the work is billed, unbilled, or not billable. The 
report groups and subtotals the activities first by customer 
and job and then by service item.

Time by Name Shows hours worked (or tracked as sick or holiday time), 
subtotalled first by the name of the person who performed 
the work and then by the customer or job the person 
performed the work for.

Time by Item Shows the hours worked, subtotalled first by service item 
and then by customer or job.

Project report Description

Mileage by Vehicle 
Summary

Shows mileage and expense amount based on Inland 
Revenue published guidelines (mileage allowance for 
employees who use their own cars for business travel), sub-
totalled by vehicle.

Mileage by Vehicle 
Detail

Shows the mileage for each vehicle on a specific date, and 
shows the expense amount based on Inland Revenue 
published guidelines (mileage allowance for employees who 
use their own cars for business travel).

Mileage by Job 
Summary

Shows mileage subtotalled by customer and job.

Mileage by Job Detail Lists each mileage entry for a particular customer or job on a 
specific date, with the amount billable to the customer. It 
also shows the billing status for each entry: billed, unbilled 
or not billable. The report groups and subtotals the entries 
by customer and job.
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To create a Time by Job report:
� From the Reports menu, choose Jobs, Time & Mileage, then Time by Job Summary.

QuickBooks displays the Time by Job Summary report, showing the total time 
worked for the Sutton Housing Association kitchen refurbishment Flats 17-24 job:

Viewing time data in more detail

Like all QuickBooks reports, you can QuickZoom any of the numbers in a report to see 
more detail. 

Suppose you want to see who worked on installation for Sutton Housing Association. 
You can point to the item in the report (the pointer changes into the QuickZoom 
symbol) and double-click to get more information.

1 Double-click on the 40 hours for Fitting on the kitchen refurbishment job.

QuickBooks  displays a Time by Job Detail report for the time data you selected:

You can see that Charlie Walker did the work and the time has already been billed 
to the customer.

2 Close the Time by Job Detail and the Time by Job Summary reports.
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3 If QuickBooks asks you if you want to memorise the report, click No.

You can generate other time reports by selecting them from the Jobs, Time & 
Mileage submenu in the Reports menu.

Viewing mileage reports

In a similar way, you can view mileage reports and zoom in to see more detail.

To create mileage by vehicle reports:
1 From the Reports menu, choose Jobs, Time & Mileage, then Mileage by Vehicle 

Summary.

QuickBooks displays the Mileage by Vehicle Summary report, showing the total 
number of miles and the expense incurred:

2 Double-click on the mileage or mileage expense figure.

QuickBooks displays the Mileage by Vehicle Detail report, showing the breakdown 
for each trip:

3 Close the report windows.
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Displaying other project reports

In addition to the estimate and time reports, QuickBooks provides several project 
reports to track job profitability, as described in the following table.

Paying non-employees for time worked

When the company file has time data for a person who is not on your payroll, you can 
write cheques based on the time worked. QuickBooks can transfer time data for a 
specified date range to a cheque, prefilling the Items tab of a cheque with the time 
data, including hours worked and rate.

You can pay a subcontractor, owner or partner for time worked. The person must be 
on one of these lists:

� Supplier (appropriate for subcontractors)

� Other Names (appropriate for owners and partners)

Note: To pay an ordinary employee for time worked, use the payroll feature. 

Creating service items for subcontractors, owners or partners

When you use service items for subcontractors, QuickBooks  records expenses and 
income for the work in separate accounts. You can use such items on both purchase 
forms and sales forms.

In this section you’ll learn how to do the following:

� Set up a service item to use to track work performed by a subcontractor

� Enter time worked for a subcontractor

� Prepare a cheque to pay a subcontractor for time worked

Project report Description

Job Profitability 
Summary

Compares the actual cost to the actual revenue for all 
customers and jobs. The report subtotals the data first by 
customer and then by job.

Job Profitability Detail 
(for one customer:job)

For a particular customer or job, compares actual costs to 
actual revenues and shows the difference between the two 
amounts. The report subtotals the data first by item type and 
then by item.

Item Profitability For each item, compares the actual cost to actual revenue 
and shows the difference between the two amounts. The 
report subtotals the data first by item type and then by item.

Profit & Loss by Job For each job, shows income, cost of goods sold, profit, 
expenses and net income.



                                                                                                

16–17

L E S S O N  1 6

To set up a service item for subcontractors:
1 From the Lists menu, choose Item List.

2 Click the Item menu button, and choose New.

3 In the Type field of the New Item window, choose Service from the drop-down list.

4 In the Item Name/Number field, type Planning.

5 Tick the “This service is performed by a subcontractor, owner, or partner” tick box.

QuickBooks displays fields for sales and purchase information.

6 In the Description on Purchase Transactions field, type Job Planning and press Tab.

QuickBooks copies the text into the Description on Sales Transactions field.

7 In the cost field, type 50.00 and press Tab.

8 Type S for Purch VAT Code.

9 From the drop-down list in the Expense Account field, choose the expense 
subaccount called Contract Labour.

10 In the Sales Price field, type 90.00.

11 Type S for Sales VAT Code.

12 In the Income Account field, type Planning and press Tab.

13 When QuickBooks tells you that Planning is not on the Account list, click Set Up.

14 In the New Account window, choose Income from the Type field drop-down list.
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15 Click OK.

Your screen should now look like this:

16 Click OK to close the New Item window.

17 Close the Item list.

In the next section, you learn how to use the Planning item you’ve just created to track 
time performed by a subcontractor for Grangeworth Kitchens Ltd.

Recording non-employee time worked

You record data for time worked by non-employees the same way as for employees. 

To enter non-employee time worked:
1 From the Employees menu, choose Time Tracking and Time/Enter Single Activity.

QuickBooks displays the Time/Enter Single Activity window.

2 In the Name field, type William Phillips and press Tab.
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3 Click Quick Add when prompted, then select Other as the name type and click OK.

4 In the Customer:Job field, choose Elizabeth Allen.

5 In the Service Item field, select Planning from the drop-down list and press Tab.

6 Type 8:00 in the Duration field and press Tab.

Your screen should look like this:

7 Click Save & Close.

8 If QuickBooks displays a message about classes, click Save Anyway.
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Preparing a cheque for non-employee time worked

In this section, you’ll learn how to create a cheque to reimburse a subcontractor for 
time worked on a specific job.

Note: This procedure applies for subcontractors who are responsible for their 
own tax (i.e. suppliers rather than employees). If your business uses 
subcontractors, you need to ascertain whether they or you are responsible 
for processing their tax payments.

1 From the Banking menu, choose Write Cheques.

QuickBooks displays the Write Cheques window.

2 Select Master Bank Current Account from the Bank Account drop-down list if not 
shown.

3 Click the To be printed tick box.

4 In the Pay to the Order field, choose William Phillips from the drop-down list, and 
press Tab.

5 Click Yes when QuickBooks asks if you want this cheque to pay for time worked.

QuickBooks displays the Select time period dialog box.

6 Type 15/12/2007 in the Start Date field and press Tab.

7 Type 17/12/2007 in the End Date field and click OK.
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QuickBooks prefills the Items tab of the cheque with the time data, including 
hours worked and rate. 

Notice that time activity is marked unbillable (icon in right-hand column of Items 
tab) so that it is not billed twice—as a time activity and an item.

8 Click Save & Close in the Write Cheques window.
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Lesson objectives
� To learn how you can set different units of measure for stock, sales and purchases

� To see how these stock parts appear in purchase orders and invoices

� To learn how to create and build stock assemblies

� To see how QuickBooks tracks assemblies and their costs

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

Note: To complete this lesson, you must be using QuickBooks Pro or 
Accountant.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 17.qbw 
in the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.

Using units of measure

You may find that when you purchase stock items, your suppliers use different units 
of measure from you. Similarly, you may store items in a warehouse in boxes, for 
example, but sell them as individual units.

QuickBooks enables you to record stock items using different units of measure for the 
stock (or inventory) unit, the purchase unit and the sales unit. It automatically 
calculates costs and prices for you. You can view reports in whichever units of measure 
you choose.
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Turning on units of measure

The first thing you need to do is to turn on Units of Measure.

To turn on units of measure:
1 From the Edit menu, select Preferences to display the Preferences window.

2 From the scroll box on the left, select Purchases & Suppliers.

3 Click on the Company Preferences tab to display it.

4 Tick the “Units of measure are active” tick box.

5 Click OK.

Creating items with units of measure

In these exercises, you’ll create several new items with different combinations of units 
of measure.

Note: Once a stock item has been used in transactions, you cannot change the 
units of measure. It’s recommended that you set the units of measure 
when you first create items.

Using the same units of measure

By default, QuickBooks will assign identical units of measure. However, if you want 
this unit of measure to be named on forms such as invoices, you must set up the unit. 
For example, you might want labour or service charges to be shown in hours, while 
timber or fabric is to be shown in metres.

Grangeworth Kitchens Ltd is going to buy, stock and sell oak drawer fronts. They will 
label the unit of measure “each”.
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To set a unit of measure:
1 From the Suppliers menu, choose Item List.

QuickBooks displays the Item List.

2 Click the Item menu button, then choose New.

QuickBooks displays the New Item dialog box.

3 From the Type drop-down list, choose Stock Part.

4 In the Item Name/Number field, type Oak Drawer Front.

5 Click the Units of Measure button.

QuickBooks displays the Define Units of Measure for Oak Drawer Front dialog box.

6 For “I stock this item in”, type each.

7 Click OK.

QuickBooks returns to the New Item dialog box.

8 In the Description on Purchase Transactions box, type PN818 Oak Dr Fr.

9 For the Description on Sales Transactions, type Oak Drawer Front.

10 For the Cost, type 12.00.

11 For Sales Price, type 25.00.

12 For both the Purchase VAT and Sales VAT Codes, choose S.

13 For Income Account, choose Sales:Retail.

14 For Stock on Hand, type 5 and press Tab.

QuickBooks fills in the value of the stock on hand.

15 For the As Of date, type 31/03/2003.
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Your screen should look like this:

16 Click OK. 

QuickBooks adds the new stock part to the Item List.

Using a different purchase unit

Suppose Grangeworth Kitchens Ltd are going to buy kitchen cupboards, which they 
will stock (and sell) in individual units. Linden May supply them in pallets of ten 
cupboards.

To set a different purchase unit:
1 From the Item List, click the Item menu button, then choose New.

QuickBooks displays the New Item dialog box.

2 From the Type drop-down list, choose Stock Part.

3 In the Item Name/Number field, type Kitchen Cupboard.

4 Click the Units of Measure button.

QuickBooks displays the Define Units of Measure for Kitchen Cupboard dialog 
box.

5 For “I stock this item in”, type each.

6 Under Purchasing Unit, click the tick box next to “Same as Stocking” to clear it.

7 For “I purchase this item by”, type pallet and press Tab.

8 For Association to Stocking, type 10 and make sure that “each per pallet” is shown.
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Your screen should look like this:

9 In the Description on Purchase Transactions box, type PN443 Kit Cab.

10 For the Description on Sales Transactions, type Base Kitchen Cupboard.

11 For the Cost, type 200.00.

12 For Sales Price, type 45.00.

13 For both the Purchase VAT and Sales VAT Codes, choose S.

14 For Income Account, choose Sales:Retail.

15 For Stock on Hand, type 5 and press Tab. 

QuickBooks fills in the value of the stock on hand as 100.00, which is the cost of 
5 individual cupboards in the stock unit (each), not of 5 pallets (the purchase 
unit).

16 For the As Of date, type 31/03/2003.

Your screen should look like this:

17 Click OK. 
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Using a different sales unit

Suppose Grangeworth Kitchens Ltd are going to buy oak doors, which they will buy 
and stock as individual items, and sell in pairs.

To set a different sales unit:
1 In the Item List, click the Item menu button, then choose New.

QuickBooks displays the New Item dialog box.

2 From the Type drop-down list, choose Stock Part.

3 In the Item Name/Number field, type Oak Door.

4 Click the Units of Measure button.

QuickBooks displays the Define Units of Measure for Oak Door dialog box.

5 For “I stock this item in”, type each.

6 Under Sales Unit, click the tick box next to “Same as Stocking” to clear it, type pair 
and press Tab.

7 For Association to Stocking, type 2 and make sure that “each per pair” is shown. 

Your screen should look like this:

8 Click OK.

9 In the Description on Purchase Transactions box, type PN815 Door Oak.

10 For the Description on Sales Transactions, type Pair of Oak Doors.

11 For the Cost, type 35.00.

12 For Sales Price, type 130.00.

13 For both the Purchase VAT and Sales VAT Codes, choose S.

14 For Income Account, choose Sales:Retail.

15 For Stock on Hand, type 4 and press Tab. 

QuickBooks fills in the value of the stock on hand as 140.00, which is the cost of 
4 individual oak doors in the purchase/stock unit (each), not of 4 pairs (the sales 
unit).

16 For the As Of date, type 31/03/2003.
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Your screen should look like this:

17 Click OK. 

Using a different stock unit

Suppose Grangeworth Kitchens Ltd are going to buy handles, which they will buy and 
sell as individual items, and stock in pairs.

To set a different stock unit:
1 In the Item List, click the Item menu button, then choose New.

QuickBooks displays the New Item dialog box.

2 From the Type drop-down list, choose Stock Part.

3 In the Item Name/Number field, type Handle.

4 Click the Units of Measure button.

QuickBooks displays the Define Units of Measure for Handle dialog box.

5 For “I stock this item in”, type pair.

6 For the Sales Unit, click the tick box next to “Same as Stocking” to clear it, type 
each and press Tab.

7 For Association to Stocking, type 2 and select “each per pair”. 

8 For the Purchasing Unit, click the tick box next to “Same as Stocking” to clear it, 
type each and press Tab.

9 For Association to Stocking, type 2 and select “each per pair”. 
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Your screen should look like this:

10 Click OK.

11 In the Description on Purchase Transactions box, type PN012 Handle.

12 For the Description on Sales Transactions, type Handle.

13 For the Cost, type 6.00.

14 For Sales Price, type 10.00.

15 For both the Purchase VAT and Sales VAT Codes, choose S.

16 For Income Account, choose Sales:Retail.

17 For Stock on Hand, type 4 and press Tab. 

QuickBooks fills in the value of the stock on hand as 48.00, which is the cost of 4 
pairs of handles (the stock unit), not of 4 each (the purchase/sales unit).

18 For the As Of date, type 31/03/2003.

Your screen should look like this:

19 Click OK. 
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Using different stock, sales and purchase units

Now set up a stock part for a Drawer Frame, with the following details:

Units of Measure:

� Stocking unit: box

� Sales unit: each: 10 each per box

� Purchasing unit: pallet: 5 box per pallet

Your screen should look like this:

Remaining details:

� Purchase Description: PN449 Dr Fr

� Sales Description: Drawer Frame

� Purchase Cost: 600.00

� Sales Price: 25.00

� Purchase/Sales VAT Codes: S

� Income Account: Sales:Retail

� On Hand: 1

� As Of: 31/03/2003
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Your screen should look like this:

Purchasing and selling using units of measure

Now that you’ve set up some stock parts with different units of measure, you can see 
the effects when they are used in transactions.

Purchasing items with different units of measure

When you set up the new stock parts, there were only a few items on hand. 
Grangeworth Kitchens Ltd needs to replenish the stock so there are about 100 each. 
The purchase order will use the purchase descriptions and purchase units, but when 
you receive the goods, they will be in the stock units.

To create a purchase order:
1 From the Suppliers menu, choose Create Purchase Orders.

QuickBooks displays the Create Purchase Orders windows.

2 Select Linden May Ltd as the supplier and press Tab.

3 For Tax Date, type 31/03/2003.

4 In the Item field, select Oak Drawer Front and press Tab.

QuickBooks completes the purchase description, cost and unit.

5 In the Qty field, type 100 and press Tab.

QuickBooks calculates the total cost.

6 Click in the Item field below Oak Drawer Front, and select Kitchen Cupboard.

7 In the Qty field, type 10.

8 On the next line, select Oak Door, with a quantity of 100.

9 On the next line, select Handle, with a quantity of 100.
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10 On the next line, select Drawer Frame, with a quantity of 2.

Your screen should look like this:

11 Click Save & Close.

To receive the order:
1 From the Suppliers menu, choose Receive Items.

QuickBooks displays the Create Item Receipts window.

2 Select Linden May Ltd as the supplier.

3 When QuickBooks asks if you want to receive against open purchase orders, click 
Yes.

QuickBooks displays the list of open purchase orders.

4 Select the purchase order, and click OK.
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QuickBooks completes the details in the receipt.

5 For Date, type 31/03/2003.

6 Click Save & Close.

QuickBooks updates the quantity on hand in the Item List. 

Note: The quantities shown in the Item List are expressed in sales units, since 
these stock parts are ready to sell.

Selling items with different units of measure

When you invoice items, QuickBooks uses the sales units.

To create an invoice:
1 From the Customers menu, choose Create Invoices.

QuickBooks displays the Create Invoices window.

2 From the Customier drop-down list, select Offa Kitchens.

3 For Tax Date, type 31/03/2003.

4 Enter the following quantities and items:

� 20 Kitchen Cupboard

� 10 Oak Door (= 10 pairs of oak doors)

� 20 Drawer Frame
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� 20 Oak Drawer Front

� 40 Handle

Your invoice should look like this:

5 Click Save & Close.

QuickBooks updates the stock on hand quantities.

Viewing reports

You can see the different units of measure being used in different reports. 

By default: 

� stock reports show quantities in stock units

� sales reports show quantities in sales units

� purchase reports show quantities in purchase units. 

However, you can modify reports to show whichever units you prefer.

In the following exercises, you’ll open reports showing each type of unit. You’ll also 
see how to modify a report to show the information expressed in a different unit of 
measure.

To view the stock status:
1 From the Reports menu, choose Stock, then Stock Status by Item.

QuickBooks displays the Stock Status by Item report. 
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2 Change the dates to: From 01/03/2003 To 31/03/2003 and click Refresh.

On this report, the quantities are shown in stock units.

If you prefer, you can change the units on this report.

3 Click Modify Report.

QuickBooks displays the Modify Report dialog box.

4 Select Purchasing unit, then click OK.

QuickBooks changes the report to show the quantities expressed in purchase 
units.
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To view the purchased quantities:
1 From the Reports menu, choose Purchases, then Purchases by Supplier Detail.

QuickBooks displays the Purchases by Supplier Detail report.

2 Change the dates to: From 01/03/2003 To 31/03/2003 and click Refresh.

3 Scroll down to Linden May. This shows the quantities you ordered, expressed in 
purchase units.

You can modify the report in a similar way to show different units of measure.

To view quantities sold:
1 From the Reports menu, choose Sales, then Sales by Customer Detail.

QuickBooks displays the Sales by Customer Detail report.

2 Change the dates to: From 01/03/2003 To 31/03/2003 and click Refresh.

3 Scroll down to Offa Kitchens. This shows the quantities you invoiced, expressed 
in sales units.

Again, you can modify the report to show different units of measure if you wish.
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Working with stock assemblies

By defining a stock assembly, you can create a type of stock item that contains 
assembled components, which can stock parts or other assemblies).

You initially create the stock assembly as an item and define how many of each 
constituent part is to be used.

When you come build the assembly, QuickBooks tells you how many you can build 
with the stock on hand of the component parts. It then automatically increases the 
quantity on hand of the assembly, and decreases the stock on hand of the component 
stock parts.

QuickBooks tracks assemblies in the same way as stock parts, for example how 
many items remain in stock after a sale, and the cost and value of the stock assembly 
items.

Note: An assembly is different from a group. You use a group for stock parts that 
you often sell together, so you can enter them quickly on an invoice. The 
individual parts are still tracked separately. The table and chair sets in the 
lesson file show an example of this. 
You use assembly items for finished items that are made up of individual 
stock parts. The finished assembly is tracked as an item in its own right. 
For further information, see the online Help.

Creating stock assemblies

Grangeworth Kitchens Ltd want to sell a range of oak cabinets, made up from the stock 
parts you created earlier in this lesson.

They will sell the finished cabinets at a higher price than the combined sales price of 
the components, in order to cover their production overheads.

First, you’ll create an oak kitchen cabinet with two doors and two corresponding 
handles.

To create a stock assembly:
1 From the Item List, click the Item menu button and choose New.

QuickBooks displays the New Item dialog box.
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2 For the Type, choose Stock Assembly.

QuickBooks changes the dialog box to display the fields associated with stock 
assemblies.

3 In the Item Name/Number field, type Oak Cabinet.

4 Click Units of Measure.

5 For the Stocking Unit, type each. Leave the sales units the same, and click OK.

6 In the Description field, type Oak Kitchen Cabinet.

7 In the Sales Price field, type 240.00. (The combined sales price of the components 
for this assembly would add up to 195.00.)

8 Set the Sales VAT Code to S, and the Income Account to Sales:Retail.

9 In the Components Needed section, click in the Item field and select Kitchen 
Cupboard, then press Tab.

10 In the Qty field, type 1.

11 On the next line, select Oak Door, with a quantity of 2. Although the sales 
description is “Pair of Oak Doors”, the stock unit is each.

12 On the next line, select Handle, with a quantity of 1. Since handles are stocked in 
pairs, this will give you one handle for each of the two doors.

13 For the As Of date, type 31/03/2003.
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Your screen should look like this:

14 Click OK. 

15 QuickBooks adds the stock assembly to the Item List.

You can also create an assembly that uses fractional values. In the next example, 
Grangeworth Kitchens Ltd stock their Drawer Frames in boxes of 10, but they need to 
create an oak drawer unit that uses only one drawer frame.

To create an assembly with different units of measure:
1 From the Item List, click the Item menu button and choose New.

QuickBooks displays the New Item dialog box.

2 For the Type, choose Stock Assembly.

3 In the Item Name/Number field, type Oak Drawer.

4 Click Units of Measure.

5 For the Stocking Unit, type each. Leave the sales units the same, and click OK.

6 In the Description field, type Oak Drawer.

7 In the Sales Price field, type 75.00.

8 Set the Sales VAT Code to S, and the Income Account to Sales:Retail.

9 In the first line of the Components Needed section, select Drawer Frame, with a 
quantity of 0.1. (A box contains 10 drawer frames.)

10 On the next line, select Oak Drawer Front, with a quantity of 1.

11 On the next line, select Handle, with a quantity of 0.5 (that is, half of a pair of 
handles, since you need just one handle).
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12 For the As Of date, type 31/03/2003.

Your screen should look like this:

13 Click OK. 

QuickBooks adds the stock assembly to the Item List.

Grangeworth Kitchens Ltd are going to set up an assembly for an oak cabinet with one 
door and two drawers. This will include the oak drawer assembly that you’ve just 
created.

To create an assembly with a sub-assembly:
1 From the Item List, click the Item menu button and choose New.

QuickBooks displays the New Item dialog box.

2 For the Type, choose Stock Assembly.

3 In the Item Name/Number field, type Oak Cabinet - Drawer.

4 Click Units of Measure.

5 For the Stocking Unit, type each. Leave the sales units the same, and click OK.

6 In the Description field, type Oak Kitchen Cabinet With Drawers.

7 In the Sales Price field, type 300.00.

8 Set the Sales VAT Code to S, and the Income Account to Sales:Retail.

9 In the first line of the Components Needed section, select Kitchen Cupboard, with 
a quantity of 1.

10 On the next line, select Oak Door, with a quantity of 1.

11 On the next line, select Handle, with a quantity of 0.5.

12 On the next line, select Oak Drawer, with a quantity of 2.
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13 For the As Of date, type 31/03/2003.

Your screen should look like this:

14 Click OK. 

QuickBooks adds the stock assembly to the Item List.

Grangeworth Kitchens Ltd will also sell a four-drawer kitchen cabinet, made up of 1 
kitchen cabinet and 4 oak drawers, but you don’t need to create this now.

Building stock assemblies

So far, you’ve created the stock assemblies in the Item List, but you have no stock on 
hand for these item lines.

You need to build the assemblies from the component stock parts, so that you have 
stock that you can sell.

Building an assembly

First, you’ll build the Oak Cabinet.
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To build an assembly:
1 From the Item List, click the Activities menu button and choose Build Assemblies.

QuickBooks displays the Build Assemblies dialog box.

2 From the Assembly Item drop-down list, select Oak Cabinet.

QuickBooks displays a list of the components and quantities required, and also 
indicates the maximum quantity you could build from the stock on hand of these 
components.

3 In the Quantity to Build field, type 15.

4 For the Date, type 31/03/2003.
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5 You could use the Memo field to add further information about the build. For 
now, just click Build & Close.

QuickBooks updates the stock on hand for the assembly item, and also reduces the 
stock for the components.

Using pending builds

If an assembly includes a subassembly, you must have stock of the subassembly before 
you can build the main assembly. The best way to do this is to build the assemblies in 
the correct order. 

However, you can also mark a build as pending, then update it later once you have 
built the subassembly. 

You might also want to use pending builds to keep track of builds you plan for the 
future, for example if you are setting up a number of assembly items that you don’t 
yet stock.

In this example, suppose that Grangeworth Kitchens Ltd want to build the Oak 
Cabinet with Drawers, even though they haven’t yet built the Oak Drawer assembly.

To create and update a pending build:
1 From the Suppliers menu, choose Stock Activities and then Build Assemblies.

QuickBooks displays the Build Assemblies window.

2 In the Assembly Item drop-down list, select Oak Cabinet - Drawer.
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Notice that since there is no stock on hand for the Oak Drawer, the maximum 
number you can build is shown as 0. 

3 For the Quantity to Build, type 5.

4 For the Date, type 31/03/2003.

5 Click Build & Close.

QuickBooks displays a warning message:
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6 Click Make Pending.

QuickBooks marks the build as Pending.

7 Click Build & New.

QuickBooks saves the pending build, but the stock on hand is still shown as 0 in 
the Item List because the assembly hasn’t yet been completed.

8 In the Build Assemblies window, select Oak Drawer.

9 For the Quantity to Build, type 10.

10 Click Build & Close.

Now you can complete the pending build for the Oak Cabinet - Drawer.

11 From the Reports menu, choose Stock and then Pending Builds.

QuickBooks displays the Pending Builds report. 
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12 Change the dates to: From 01/03/2003 To 31/03/2003 and click Refresh.

This report helps you keep track of builds that are not yet complete.

13 Move the cursor over the pending build until it changes to a Z, then double-click.

14 QuickBooks opens the Build Assemblies window with the pending build for the 
Oak Cabinet - Drawer. It now shows that you can build 5 of this item.

15 Click the Remove Pending Status button.

16 For the Date, type 31/03/2003.

17 Click Build & Close.

18 When QuickBooks asks you to confirm the changed transaction, click Yes.

QuickBooks updates the stock on hand.

Viewing reports

Apart from the Pending Builds report you saw in the last exercise, the various reports 
show stock assembly items in just the same way as any other stock part. For example, 
when Grangeworth Kitchens Ltd create a customer invoice that includes 5 Oak 
Cabinets, this would be reflected in the Sales by Item Detail report.
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In these examples, you’ll look at QuickReports for an assembly and one of its 
components. You’ll also see how QuickBooks tracks the cost of stock assemblies.

To view QuickReports on assemblies and components:
1 From the Item List, select the stock assembly item Oak Drawer.

2 Click the Reports menu button and choose QuickReport:Oak Drawer.

QuickBooks displays the report. 

3 Change the dates to: From 01/01/2003 To 31/03/2003 and click Refresh.

This shows the two builds that involved the oak drawer: the first when you built 
the drawer assembly, and the second when you used this assembly to build the oak 
cabinet with drawers.

4 From the Item List, select the stock part Drawer Frame.

5 Click the Reports menu button and choose QuickReport:Drawer Frame.

QuickBooks displays the report. 

6 Change the dates to: From 01/03/2003 To 31/03/2003 and click Refresh.

This shows all the transactions you’ve created using the drawer frame during this 
lesson: the stock adjustment for the initial stock on hand when you created the 
item, the purchase order and item receipt for Linden May, the invoice to Offa 
Kitchens, and the building of the oak drawers.
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To view stock assembly costs:
1 From the Reports menu, choose Stock then Stock Valuation Detail.

QuickBooks displays the Stock Valuation Detail report. 

2 Change the dates to: From 01/03/2003 To 31/03/2003 and click Refresh.

The assemblies (at the bottom of the report) show no figures in the Cost column, 
because you did not buy these items in ready-made. However, it does show the 
average cost based on the total costs and quantities of the components used in 
each assembly.
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If you were later to buy components in at a higher cost, this would not initially be 
reflected in the average cost of the assemblies that used these components. The 
figures would not be updated until next time you built these assemblies.



17–30

U s i n g  a d v a n c e d  s t o c k  f e a t u r e s



                                                                                                

 18–1

• • • • • • • • • •

LESSON 18

3

Lesson objectives 18–2

To start this lesson 18–2

Tracking finances 18–3
Cash Flow Projector 18–3

Loan Manager 18–8

Using Loan Manager 18–11
Running “what-if” scenarios 18–15

Tracking finance



18–2 

T r a c k i n g  f i n a n c e

Lesson objectives
� To use Cash Flow Projector to show cash flow for the next six weeks.

� To understand how Loan Manager is used to set up and track loans.

� To see how Loan Manager can show “what-if” scenarios for potential loans.

To start this lesson

Before you start the lesson, make sure you have installed the backup lesson file 
(qblesson.qbb) on your hard disk. See “Installing the lesson file” in the Introduction 
to this guide if you haven’t installed it.

Follow these steps to restore the lesson file to its original state so that the data in the 
file matches what you see on the screen as you proceed through the lesson.

Note: To complete this lesson, you must be using QuickBooks Pro or 
Accountant.

To restore the lesson file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Restore.

QuickBooks displays the Restore Company Backup window.

2 In the “Get Company Backup From” section of the window, click Browse and 
select your c:\qbtrain directory.

3 Select the qblesson.qbb file, and then click Open.

4 In the “Restore Company Backup To” section of the window, type lesson 18.qbw 
in the Name field.

5 Click Browse and select your c:\qbtrain directory.

6 Click Save.

7 Click Restore.
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Tracking finances

QuickBooks provides a wide range of features to help you to track and plan the 
finances of your company. 

This lesson will introduce you to just some of these features.

Cash Flow Projector

Cash Flow Projector guides you through a step-by-step process that helps you combine 
your existing QuickBooks data with any additional cash flow information, to prepare 
a six-week view of all your incoming and outgoing cash. This helps your financial 
planning, for example to anticipate any potential shortfalls, identify sources and uses 
of cash, see the financial impact of supplier payment terms, or determine whether you 
can make additional purchases based on your future cash needs.

To get an accurate picture of your cash flow, it is recommended that you make sure 
your QuickBooks data is up to date before you run the Cash Flow Projector.

To use Cash Flow Projector:
1 From the Company Navigator, click Cash Flow Projector.

The Cash Flow Projector displays the Welcome page.

2 Click Next.

The Cash Flow Projector displays the Beginning Balance page. This is where you 
select which accounts you want to use to calculate your balance, and you can also 
add an adjustment to the balance for example if you know you have additional 
cash on-hand that you have not yet entered into QuickBooks or if you want to 
reduce available cash to act as a cash reserve.

3 Click in all the account boxes to include them in your projection. The Balance 
Summary is updated to show the current balance.
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4 Click Next.

The Cash Flow Projector displays the Cash Receipts page. This shows the amount 
of cash you expect your business to receive and when. It is dated and grouped as 
a weekly total. 

In this case, there have been no cash receipts over the last six weeks so each entry 
is shown as zero.

Initially this page projects your cash receipts based on the default method ‘Use a 
weighted average of last 6 weeks’, where the most recent weeks are taken as a more 
accurate indication of future weeks. 
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Other methods include:

� Use last 6 weeks – This method assumes the same pattern of receipts will occur 
over the next six weeks as over the last six weeks. 

� Use an average of the last 6 weeks – This method gives equal weighting to each 
week when calculating the average.

For this exercise, you’ll enter adjustments, because the cash receipts are not up to 
date.

5 In the Summary boxes at the bottom, for 16/12/2007 type 2400, for 13/12/2007, 
type 2300 and for 30/12/2007 type 2500.

Your screen should resemble this one:
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6 Click Next.

The Cash Flow Projector displays the Business Expenses page.

This is where you enter cash business expenses. You can select which accounts to 
use, and either group them at a high level or use as much detail as you want. For 
this exercise, you’ll just use a few accounts, but for your business you may want to 
use all the accounts that have an impact on your cash flow.

7 In the first line, select Dues and Subscriptions, with a date of 22/12/2007, a 
frequency of Monthly, and an amount of 24.

8 In the next line, select Equipment Rental, with a date of 05/01/2008, a frequency 
of Weekly, and an amount of 175.
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9 In the third line, select Repairs: Building Repairs, with a date of 14/01/2008, a 
frequency of One Time, and an amount of 299.

Your screen should resemble this one. 

10 Click Next.

The Cash Flow Projector displays the Accounts Payable page.

This is where you select the suppliers with unpaid bills. You can choose what date 
to use for payment in your projection. For this exercise, leave the due dates as they 
are.



18–8 

T r a c k i n g  f i n a n c e

11 Click Finish Projection.

The Cash Flow Projector displays your projection for the next six weeks. You can 
scroll across and down to see more information.

If you wish, you can print and/or save the projection as a PDF.

Loan Manager

Loan Manager enables you to track loans and schedule payments. It calculates the 
principal and interest. You can easily update the information if the interest rate 
changes or you alter your payment schedule. You can also run “what-if” scenarios to 
evaluate different loans.

Before you can use the Loan Manager, you need to set up a liability account for the 
loan, and an expense account to track the loan interest. You also need to set up the 
lender as a supplier.

In this exercise, you’ll set up an account for a short-term loan using the Other Current 
Liability account type. For a long-term loan, you’d use Long Term Liability.

To set up the liability account:
1 From the Lists menu, choose Chart of Accounts.

2 Click the Account menu button, and choose New.

3 For the account type, choose Other Current Liability.

4 For the name, type Short Term Loan.

5 As a description, type Short term loan for expansion.

6 For the Bank Acct. No, type 1234 5678.
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7 Set the opening balance to 0.00.

8 Click OK.

To set up the expense account:
1 From the Chart of Accounts, click the Account menu button and choose New.

2 Enter the expense account details as follows:

� Account type – Expense

� Name – Short Term Interest

� Description – Short term loan interest

3 Click OK.

To set up the lender:
1 From the Suppliers menu, choose Suppliers List.

2 Click the Supplier menu button, and choose New.

3 For Supplier Name, type Master Bank Loan.

4 Normally, you’d enter full details for the supplier, but for now click OK.

To enter the loan:
1 From the Chart of Accounts, click the Activities menu button and choose Make 

Deposits.

QuickBooks displays the Payments to Deposit window.

2 Click Cancel, since you don’t want to use any of the customer payments.

QuickBooks displays the Make Deposit window.

3 For Account, select Master Bank Current from the drop-down list.

4 Click in the From Account column, and select Short Term Loan from the drop-
down list.
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5 In the Amount column, type 5000.00.

Your screen should resemble this:

6 Click Save & Close.
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Using Loan Manager

To enter a loan in Loan Manager:
1 From the Banking menu, choose Loan Manager.

2 Click Add a Loan.

Loan Manager displays the Add a Loan window.

3 For Account Name, select the liability account for the loan, in this case the Short 
Term Loan.

4 For Lender, select the lender, in this case Master Bank Loan.

5 For Loan Advance Date, type 15/12/2007.

6 For Original Loan Amount, type 5000.00.

7 For Term, type 12 and leave Months shown in the drop-down list.
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8 Click Next. 

Loan Manager displays the payment information page.

9 For Due Date of Next Payment, type 06/01/2008.

10 For Payment Amount, type 433.21.

11 For Payment Period, choose Monthly.

12 Click Next.

Loan Manager displays the interest information page.

13 For Interest Rate, type 7.25.

14 For Bank Account, choose Master Bank Current.
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15 For Interest Expense Account, choose Short Term Interest.

16 Click Finish.

Loan Manager displays the loan in the main window.
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17 Click on the Payment Schedule tab.

Loan Manager displays a list of payment dates showing how the payments affect 
the principal and interest amounts.

Once you’ve entered the loan, you can set up payments in Loan Manager. You can 
make regular (scheduled) payments, or one-off extra payments, and choose how to 
pay: by entering a bill or writing a cheque.
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To set up loan payments in Loan Manager:
1 Click Set Up Payment.

Loan Manager displays the Set Up Payment window.

2 Leave the settings as Regular Payment, to be paid by cheque.

3 Click OK.

QuickBooks generates a cheque, showing the split between repayment and 
interest. It is set to the current date, but you can change this to 06/01/2008 before 
saving the cheque.

Loan Manager also updates the next payment date.

Running “what-if” scenarios

You can try out different scenarios, for example to see the effect of changing payments 
or interest rates on an existing loan, or to evaluate or compare new loans.

To run a “what-if” scenario in Loan Manager:
1 Click What If Scenarios.

Because you have already set up a loan, the What If Scenarios displays the existing 
loan with the scenario ‘What if I change my payment amount?’ already selected.

2 Choose ‘How much will I pay with a new loan?’ from the drop-down list.

3 For Amount Borrowed, type 12000.00.

4 For Loan Advance Date, type 31/01/2008.

5 For Term, type 36.

6 Leave the Payment period set to Monthly.

7 For Interest Rate, type 7.10.
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8 For First Repayment Date, type 25/06/2008.

Your screen should resemble the following:.

9 Click Calculate.

Loan Manager calculates the monthly payments, total repayment and total 
interest.

10 If you wanted to compare loans, you would choose ‘Evaluate two new loans’, and 
enter both sets of details alongside each other, in the same way.
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